
Customer Release Notes
Fiery Command WorkStation Package, version 6.8

This document contains important information about this release. Be sure to provide this information to all users
before proceeding with the installation.

About this release

The following applications are included in this release:

• Fiery Command WorkStation Package v6.8.0.615

• Fiery Command WorkStation for Windows v6.8.0.54

• Fiery Command WorkStation for Mac v6.8.0.55

• Fiery Hot Folders v4.3.1.05

• Fiery Software Manager for Windows v6.8.0.11

• Fiery Software Manager for Mac v6.8.0.12

New features

What's new?

For information about new features that were added in the initial release of version 6.8, visit http://
fiery.efi.com/CWS/Whats-New.

Preview raster curve edit effects

For all external Fiery servers, when you use Job Properties to apply a raster curve edit to a job, the results are
displayed in the Fiery Preview application for processed jobs.
For embedded Fiery servers, raster curve edits to a job are displayed in the Fiery Preview application for
processed jobs only when the Fiery ColorRight Package or Fiery Productivity Package is enabled.

Spot color optimization report

In Fiery Spot Pro, you can now save the spot color optimization report as an HTML file.
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Fiery System Image backup notifications

The backup of the Fiery System Image will notify you when a backup fails and is listed under Notifications in
Fiery Command WorkStation.

• You can reschedule the backup in Manage Settings > Fiery System Restore.

• To hide the notification, click the More icon (three dots), and select Hide.

Close button for the What's New window

The What’s New window appears when you install and open the latest version of Fiery Command WorkStation
for the first time. You can now use the Close button at the bottom of the What’s New window, even if the display
resolution is less than the supported resolution.
Minimum supported display resolutions:

• 1280 x 1024 (cutsheet)

• 1600 x 900 (wide and superwide)

Issues fixed

Issues fixed in Fiery Command WorkStation Package v6.8.0.615

Fiery Command WorkStation

• Fiery Command WorkStation Package now supports Chinese fonts in compliance with the GB18030 standard.

Issues fixed in Fiery Command WorkStation Package v6.8.0.541

Fiery Command WorkStation

• When you merged two PDF files with the Merge all files if submitted as a folder option in Fiery Hot Folders, the
output PDF file did not appear as expected.

• When you selected Coated-Glossy calibration while calibrating a Fiery server, a paper weight mismatch error
message appeared.

• When you created a master document in Job Properties for a VDP job in the Held queue and clicked Preview
Master, an additional blank page was added.
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Issues fixed in Fiery Command WorkStation Package v6.8.0.514

Fiery Command WorkStation

• When you clicked Resources > Spot Pro for a Fiery server with system software FS200/200 Pro or FS300/300 Pro,
the spot colors list and spot color values did not appear.

Fiery XF

• You could not update the media profiles with the Fiery Profiles Updater when you upgraded a Fiery XF server
from v7.3 to v7.3.3.

Issues fixed in Fiery Command WorkStation Package v6.8.0.466

Fiery Command WorkStation

• On a Spanish-language system, you could not delete a selected job from the held queue by pressing the Delete
key.

• The Publish as Virtual Printer option appeared in the Job Presets tab for a Fiery embedded server on which a
virtual printer license was not installed.

• You could not create a new common calibration using an automated inline sensor for multiple printers with the
Printer Match option in Fiery Color Profiler Suite.

Issues fixed in Fiery Command WorkStation Package v6.8.0.439

Fiery Command WorkStation

• You could not save a selected paper catalog entry for a job in the Define Media for Slip Sheet window.

• On some Japanese-language systems, the number of copies of a calibration job was incorrect.

Fiery XF

• In Job Editor, the page size displayed for a PDF job with cut marks was incorrect.

Issues fixed in Fiery Command WorkStation Package v6.8.0.406

Fiery Command WorkStation

• You could not calibrate a printer with the Auto Correct Color Mismatch option.

• When you attempted to delete a curve point after modifying a processed job in ImageViewer > Color Adjust, the
selected page was deleted. The page was restored if you clicked Revert. However, you could not continue with the
editing without restarting the editing process.

Fiery XF

• You could not save some print options for media in Server Manager for VUTEk h5 printers.

• When you selected any Media Wedge in Job Editor > Verify > Control Bars, the target tolerance preset changed to
Custom.
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Issues fixed in Fiery Command WorkStation Package v6.8.0.385

Fiery XF

• When you tiled a job, the glue and overlapping areas were not considered in the calculation of job size for an
individual tile.

Issues fixed in Fiery Command WorkStation Package v6.8.0.366

Fiery Command WorkStation

• In Fiery Spot Pro, the in-gamut and out-of-gamut ∆E indications were not consistent for spot colors, even when
you defined the tolerance in the Preferences dialog box.

• When you defined a specialty color and re-opened Fiery Spot Pro, the specialty color separation values were not
retained.

• You could not define cover page settings for a new hot folder when you selected an Impose template in Job
Properties.

Fiery XF

• In Color Tools, an error message was displayed when you attempted to create a base linearization file for the
Seiko M64s printer.

• In Color Tools, when you selected different Media options from the list and clicked Print during recalibration, the
measurement chart dimension reduced unexpectedly.

Issues fixed in Fiery Command WorkStation Package v6.8.0.333

Fiery Command WorkStation

• In Fiery ImageViewer, when you selected the Current print option for a subsequent page while the first page of
the job was in the Printing queue, an error message appeared.

• When you used different paper catalog entries to define the booklet media in Fiery Impose and the cover page
media in Command WorkStation, the first sheet of the job was printed with incorrect cover page settings.
However, the rest of the sheets were printed with the booklet media settings.

• You could not specify the unit of measurement in the image shift option beyond 0.29 millimeters or its
equivalent value in inches and points.

• In Command WorkStation with the display language as German, you could not recalibrate a calibration set if the
job used either of the following:

• custom paper size

• custom paper size and APPE enabled

Fiery XF

• If you attempted to calibrate from Command WorkStation on macOS 13 (Color Tools > Create Calibration), the
left panel controls were not visible, so calibration could not be used.

• When you defined custom media size in Job Editor > Printer > Format, the printer hardware margins were not
displayed in the job preview.
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Issues fixed in Fiery Command WorkStation Package v6.8.0.277

Fiery Command WorkStation

• On macOS 13 with Command WorkStation and Fiery Hot Folders, when you selected Job Properties > Layout >
Impose > Edit Impose Template, the changes could not be saved because the window closed unexpectedly.

• On macOS 13, you could not start Fiery Software Manager from Apps and Resources if Fiery Software Manager
was already running.

• On macOS 13, when you saved the spot color optimization report as an HTML file, the EFI and Fiery logos were
not present if you opened the report in Safari.

• When you saved a User Defined finish size template with double-byte characters in Fiery Impose and applied it
to a job from Job Properties, the values defined for Based on Crop Box finish size were selected instead of the
User Defined finish size values.

• In Fiery Preview, the cover and body pages displayed the same media settings even if you had specified different
media settings for cover and body pages in Fiery Impose.

• When you clicked the Media tab in Job Properties and scrolled down to Mixed media, some media options were
not displayed for the job.

Fiery XF

• When you set up a Zund finishing device in Server Manager and Job Editor, the only available cut method was
DumDum.

• When you selected the Top And Bottom barcode position for a nested multi-page job in the Finishing tab, part of
the barcode at the bottom appeared outside the media layout, and the file did not print.

Issues fixed in Fiery Command WorkStation Package v6.8.0.217

Fiery Command WorkStation

• When you clicked Next in the Patch Layout window during recalibration of a Fiery server, Fiery Calibrator
displayed the same Patch Layout again and did not print the measurement chart. This issue occurred when you
set the Fiery server and the Fiery Command WorkStation language to French.

• In Fiery ImageViewer, when you edited the curve in the Color Adjust pane for a monochrome job and attempted
to save it as a preset, an error message appeared.

Fiery XF

• When you deleted a custom cut method in the Contour Cutting window, all the custom cut methods were
deleted from the list.

• You could not define a custom cut method, when you selected an Esko cutting table.

• You could not perform borderless printing for Canon PRO series printers when you defined a custom media size.
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Issues fixed in Fiery Command WorkStation Package v6.8.0.184

Fiery Command WorkStation

• In Calibrator, after the recalibration was completed, the Generate ACD Data after calibration option was checked
for supported printers.

Fiery XF

• When you created a spot color library using Color Editor connected to a Fiery XF server, the color values were
not saved. Additionally, if you imported the same library again, the values were not retained for CMYKRB,
CMYKOB, and CMYKRV custom spot colors.

Issues fixed in Fiery Command WorkStation Package v6.8.0.165

Fiery Command WorkStation

• When you created a calibration for a Fiery server for which the ACD option was not enabled, Fiery Calibrator
still opened WebTools for the ACD data generation.

• When you created a new Fiery Hot Folder and selected Define to specify job settings, the Job Properties window
did not open.

• It took more than the usual time to display the preview in the Sheet View pane of Fiery Preview for some
imposed PDF jobs.

• On a Windows computer, a message about discontinued support appeared in the Fiery Impose Demo window
instead of the Manage Fiery Options window.

• In Job Properties > Finishing, for a 1000-page job, if you enabled the Slip Sheet print option for every 100 copies,
the slip sheet was inserted before every single copy.

• When you attempted to open Fiery Command WorkStation and connect to Fiery servers while the EFI updates
server was offline, the job queues took a few minutes to load.

Fiery XF

• When you selected the Target tolerance preset as Custom in Server Manager, the Delta E format value appeared
as dE 2000 which was incorrect. However, in Job Editor the Delta E format value was correctly displayed as dE
CIE76.

Upgrading

This installer will upgrade any existing Fiery Command WorkStation Package to the latest package containing Fiery
Command WorkStation and Fiery Hot Folders. Optionally, you can install Fiery Remote Scan by using Fiery Software
Manager.
For more information on technical specifications, refer to www.efi.com/cws.
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Updates to system requirements

Supported versions

Fiery Command WorkStation version 6.8 supports Fiery system software FS150/FS150 Pro and later installed on the
Fiery server.
Fiery Command WorkStation supports these operating systems for your computer:

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11, 64-bit

• Windows 10, 64-bit

• Windows Server 2022, 64-bit

• Windows Server 2019, 64-bit

• Windows Server 2016, 64-bit

Note: Fiery Command WorkStation offers Rosetta support for macOS computers with the M1 chip. For more
information, visit https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-sur-
compatibility/.

Known issues

macOS 13

Adobe Acrobat on macOS 13

Because Adobe does not yet offer full support for Adobe Acrobat on macOS 13, you will experience these issues:

• You cannot start Adobe Acrobat from macOS 13 on M1 and M2 processors.

• On Intel processors, Adobe Acrobat shows the sign-in window, even if you are already signed in. Dismiss the
sign-in window, and Acrobat functions normally.

Calibration not available on Fiery XF server

If you attempt to calibrate from Command WorkStation on macOS 13, (Color Tools > Create Calibration), the left
panel controls are not visible, so calibration cannot be used.
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macOS 10.15 and later

Full Disk Access

Because of changes in how macOS 10.15 or later manages security, there are now additional steps required to
allow Fiery applications to function properly.
You need to make changes to the Full Disk Access security feature in macOS in order for Fiery applications to
manage updates and access files such as Impose templates and hot folders. Enable Full Disk Access for Fiery
applications such as Fiery Command WorkStation.

1 Close all Fiery applications.

2 Go to System Preferences > Security & Privacy > Privacy > Full Disk Access.

3 Click the Lock icon in the bottom-left corner and enter your password.

4 In the list of apps, select the checkbox next to com.efi.InstallerHelperTool.

5 Click the + button.

6 In the Applications folder, select Fiery Software Manager and Fiery Software Uninstaller and click Open.
These applications require full disk access in order to maintain and update Fiery applications on your
computer.

7 In the Applications folder, select the Fiery Command WorkStation application and click Open.

8 If you use Fiery Hot Folders or Fiery Remote Scan, select each application and click Open.
When Fiery Hot Folders detects that the Documents, Desktop, and Downloads folders are being used, it
issues a message requesting full disk access. This message is still displayed even after access has been granted.
You can dismiss this message and continue working.

PS to PDF conversion

When you use macOS 10.14.5 and later with Fiery Impose, Fiery Compose, or Fiery JobMaster, you may be
prompted to allow Fiery Command WorkStation to have access to Acrobat Distiller. This permission is necessary for
the conversion of PS files to PDF. If you do not grant permission, the conversions will not be successful and you will
need to change the Automation security feature in macOS.

1 Close all Fiery applications.

2 Close Acrobat Distiller.

3 Go to System Preferences > Security & Privacy > Privacy > Automation.

4 Click the Lock icon in the bottom-left corner and enter your password.

5 In the Apps list, locate Fiery Command WorkStation.app.

6 Select the Acrobat Distiller.app option.
This allows Fiery Command WorkStation to have access to Acrobat Distiller.
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Setting Preferences in Adobe Acrobat Distiller for PostScript to PDF conversion

Fiery Impose, Fiery Compose, and Fiery JobMaster require Acrobat Distiller to convert PostScript (PS) files to PDF
on a client computer.
Due to enhanced security settings in Acrobat Distiller, you must confirm that the PS file to be converted is from a
trustworthy source in: Acrobat Distiller > File > Preferences > Preferences - Acrobat Distiller, select Trust all files
opened via Acrobat Distiller under Security.

Note: If Trust all files opened via Acrobat Distiller is not selected, you are prompted to confirm that the file is from a
trustworthy source for every PS file to be converted to PDF. This also applies to Hot Folders when the Microsoft
Office filter is selected, Output file type is specified as PDF, and a joboptions file is selected as a Distiller profile.

Spot Pro

Specialty colors

Specialty colors are not profiled and the Apply To feature is limited to device CMYK values only.

Spot color value rounding

After you define a spot color and restart Spot Pro, values for some colors may differ slightly from the original
values that you entered. This is because of numeric rounding that Spot Pro has performed, and there should be
no noticeable visible change in the color.

M3 measurement mode

M3 mode is not supported for single-measurement devices.
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Notes de mise à jour client :
Fiery Command WorkStation Package, version 6.8

Le présent document contient des informations importantes concernant cette version. Distribuez-le à tous les
utilisateurs avant de procéder à l’installation.

À propos de cette version

Cette version comprend les applications suivantes :

• Fiery Command WorkStation Package V6.8.0.615

• Fiery Command WorkStation pour Windows version 6.8.0.54

• Fiery Command WorkStation pour Mac version 6.8.0.55

• Fiery Hot Folders version 4.3.1.05

• Fiery Software Manager pour Windows version 6.8.0.11

• Fiery Software Manager pour Mac version 6.8.0.12

Nouvelles fonctionnalités

Nouveautés

Pour plus d’informations sur les nouvelles fonctionnalités ajoutées à la publication initiale de la version 6.8, visitez 
http://fiery.efi.com/CWS/Whats-New.

Prévisualisation des effets de modification de la courbe raster

Pour toutes les instances des Fiery servers, lorsque vous utilisez la fenêtre Propriétés de la tâche pour appliquer
une modification de la courbe raster à une tâche, les résultats s’affichent dans l’application Fiery Preview pour les
tâches traitées.
Pour les Fiery servers intégrés, les modifications de la courbe raster appliquées à une tâche s’affichent dans
l’application Fiery Preview pour les tâches traitées uniquement lorsque le Fiery ColorRight Package ou le Fiery
Productivity Package est activé.

http://fiery.efi.com/CWS/Whats-New


Rapport d’optimisation des tons directs

Dans Fiery Spot Pro, vous pouvez maintenant enregistrer le rapport d’optimisation des tons directs sous la
forme d’un fichier HTML.

Notifications de sauvegarde de l'image du système Fiery

La sauvegarde de l'image du système Fiery vous avertit lorsqu’une sauvegarde échoue et est répertoriée sous
Notifications dans Fiery Command WorkStation.

• Vous pouvez reprogrammer la sauvegarde dans Gérer les paramètres > Restauration système Fiery.

• Pour masquer la notification, cliquez sur l’icône Plus (trois points) et sélectionnez Masquer.

Bouton Fermer de la fenêtre Nouveautés

La fenêtre Nouveautés apparaît lorsque vous installez et ouvrez la dernière version de Fiery Command
WorkStation pour la première fois. Vous pouvez dorénavant utiliser le bouton Fermer situé dans le bas de la
fenêtre Nouveautés, même si la résolution d'écran est inférieure à la résolution prise en charge.
Résolutions d'écran minimales prises en charge :

• 1 280 x 1 024 (feuille)

• 1 600 x 900 (grand et très grand format)

Problèmes résolus

Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.615

Fiery Command WorkStation

• Fiery Command WorkStation Package prend désormais en charge les polices chinoises conformément à la
norme GB18030.

Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.541

Fiery Command WorkStation

• Lors de la fusion de deux fichiers PDF avec l’option Fusionner tous les fichiers s’ils sont soumis en un dossier dans
Fiery Hot Folders, le fichier PDF de sortie n’apparaissait pas comme prévu.

• Lorsque vous sélectionniez le calibrage Couché - Brillant lors du calibrage d’un Fiery server, un message d’erreur
signalant une incompatibilité de grammage papier apparaissait.

• Lorsque vous créiez un document de maquette dans les Propriétés de la tâche pour une tâche d’impression de
données variables dans la queue Attente et que vous cliquiez sur Prévisualiser la maquette, une page vierge
supplémentaire était ajoutée.
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Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.514

Fiery Command WorkStation

• Lorsque vous cliquiez sur Ressources > Spot Pro pour un Fiery server avec un logiciel système FS200/200 Pro ou
FS300/300 Pro, la liste et les valeurs des tons directs n’apparaissaient pas.

Fiery XF

• Vous ne pouviez pas mettre à jour les profils de supports avec Fiery Profiles Updater lorsque vous mettiez à
niveau un serveur Fiery XF depuis la version 7.3 vers la version 7.3.3.

Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.466

Fiery Command WorkStation

• Sur un système en langue espagnole, il n'était pas possible de supprimer une tâche sélectionnée dans la queue
Attente en appuyant sur la touche Supprimer.

• L'option Publier comme imprimante virtuelle apparaissait dans l'onglet Préréglages de la tâche d'un serveur Fiery
intégré sur lequel une licence d'imprimante virtuelle n'était pas installée.

• Vous ne pouviez pas créer de nouveau calibrage commun au moyen d'un capteur automatique intégré pour
plusieurs imprimantes avec l'option Printer Matcher dans Fiery Color Profiler Suite.

Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.439

Fiery Command WorkStation

• Vous ne pouviez pas enregistrer une entrée du catalogue papier sélectionnée pour une tâche dans la fenêtre
Définir un support pour l'intercalaire.

• Sur certains systèmes en langue japonaise, le nombre de copies d'une tâche de calibrage était incorrect.

Fiery XF

• Dans Job Editor, le format de page affiché pour une tâche PDF avec des repères de coupe était incorrect.

Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.406

Fiery Command WorkStation

• Vous ne pouviez pas calibrer une imprimante avec l'option Correction auto écart couleur.

• Lorsque vous essayiez de supprimer un point sur une courbe après avoir modifié une tâche traitée dans
ImageViewer > Ajustement couleur, la page sélectionnée était supprimée. La page était restaurée si vous cliquiez
sur Rétablir. Toutefois, vous ne pouviez pas poursuivre la modification sans redémarrer le processus d’édition.
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Fiery XF

• Vous ne pouviez pas enregistrer certaines options d'impression dans Server Manager pour les imprimantes
VUTEk h5.

• Lorsque vous sélectionniez une gamme de contrôle média dans Job Editor > Vérifier > Barres de contrôle, le
préréglage des tolérances cibles était défini sur Personnalisé.

Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.385

Fiery XF

• Lorsque vous morceliez une tâche, les zones de collage et de chevauchement n'étaient pas prises en compte dans
le calcul de la taille de la tâche pour une mosaïque individuelle.

Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.366

Fiery Command WorkStation

• Dans Fiery Spot Pro, les indications ∆E situées dans la gamme et hors gamut n'étaient pas cohérentes pour les
tons directs, même lorsque vous définissiez la tolérance dans la boîte de dialogue Préférences.

• Lorsque vous définissiez une couleur spéciale et que vous rouvriez Fiery Spot Pro, les valeurs de séparation des
couleurs spéciales n'étaient pas conservées.

• Vous ne pouviez pas définir les paramètres de la page de couverture pour un nouveau Hot Folder lorsque vous
sélectionniez un modèle Impose dans les Propriétés de la tâche.

Fiery XF

• Dans Color Tools, un message d'erreur s'affichait lorsque vous essayiez de créer un fichier de linéarisation de base
pour l'imprimante Seiko M64s.

• Dans Color Tools, lorsque vous sélectionniez différentes options Support dans la liste et que vous cliquiez sur
Imprimer pendant le recalibrage, les dimensions du tableau de mesures diminuaient de façon inattendue.

Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.333

Fiery Command WorkStation

• Dans Fiery ImageViewer, lorsque vous sélectionniez l'option d'impression En cours pour une page suivante tandis
que la première page de la tâche se trouvait dans la file d'attente d'impression, un message d'erreur apparaissait.

• Lorsque vous utilisiez différentes entrées du catalogue papier pour définir le support de la brochure dans Fiery
Impose et le support de la page de couverture dans Command WorkStation, la première feuille de la tâche était
imprimée avec des paramètres de page de couverture incorrects. Toutefois, les feuilles restantes étaient
imprimées avec les paramètres de support de la brochure.

• Vous ne pouviez pas spécifier l'unité de mesure dans l'option de décalage de l'image au-delà de 0,29 millimètres
ou sa valeur équivalente en pouces et en points.
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• Dans Command WorkStation, lorsque la langue d'affichage était l'allemand, vous ne pouviez pas recalibrer un jeu
de calibrage si la tâche utilisait l'une des options suivantes :

• format papier personnalisé

• format papier personnalisé et APPE activés

Fiery XF

• Si vous essayiez d'effectuer un calibrage à partir de Command WorkStation sous macOS 13, (Color Tools > Créer
un calibrage), les commandes du panneau gauche n'étaient pas visibles, de telle sorte que le calibrage ne pouvait
pas être utilisé.

• Lorsque vous définissiez un format de support personnalisé dans Job Editor > Imprimante > Format, les marges
matérielles de l'imprimante ne s'affichaient pas dans l'aperçu de la tâche.

Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.277

Fiery Command WorkStation

• Sous macOS 13 avec Command WorkStation et Fiery Hot Folders, lorsque vous sélectionniez Propriétés de la
tâche > Mise en page > Impose > Modifier modèle Impose, les modifications ne pouvaient pas être enregistrées
en raison de la fermeture inattendue de la fenêtre.

• Sous macOS 13, vous ne pouviez pas démarrer Fiery Software Manager à partir d'Applications et ressources si
Fiery Software Manager était déjà en cours d'exécution.

• Sous macOS 13, une fois que vous aviez enregistré le rapport d'optimisation des tons directs sous la forme d'un
fichier HTML, les logos EFI et Fiery n'étaient pas présents lorsque vous ouvriez le rapport dans Safari.

• Lorsque vous enregistriez un modèle de format de finition défini par l'utilisateur avec des caractères codés sur
deux octets dans Fiery Impose et que vous l'appliquiez à une tâche à partir des Propriétés de la tâche, les valeurs
définies pour le format de finition En fonction de la zone de rognage étaient sélectionnées au lieu des valeurs de
format de finition définies par l'utilisateur.

• Dans Fiery Preview, la couverture et les pages de corps affichaient les mêmes paramètres du support, même si
vous aviez spécifié des paramètres du support différents pour la couverture et les pages de corps dans Fiery
Impose.

• Lorsque vous cliquiez sur l'onglet Support dans les Propriétés de la tâche et que vous faisiez défiler l'affichage
vers le bas pour accéder à Supports mixtes, certaines options du support ne s'affichaient pas pour la tâche.

Fiery XF

• Lorsque vous configuriez un périphérique de finition Zund dans Server Manager et Job Editor, la seule méthode
de découpe disponible était DumDum.

• Lorsque vous sélectionniez la position du code-barres Haut et bas pour une tâche d'imbrication comportant
plusieurs pages dans l'onglet Finition, une partie du code-barres dans le bas apparaissait en dehors de la mise en
page du support et le fichier ne s'imprimait pas.

Notes de mise à jour client :
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Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.217

Fiery Command WorkStation

• Lorsque vous cliquez sur Suivant dans la fenêtre Agencement des échantillons lors du recalibrage d’un Fiery
server, Fiery Calibrator affiche à nouveau le même Agencement des échantillons et n’imprime pas le tableau de
mesures. Ce problème se produisait lorsque vous définissiez le français comme langue du Fiery server et de Fiery
Command WorkStation.

• Dans Fiery ImageViewer, lorsque vous modifiez la courbe dans le volet Ajustement couleur pour une tâche
monochrome et que vous essayiez de l’enregistrer sous forme de préréglages, un message d’erreur apparaissait.

Fiery XF

• Lorsque vous supprimiez une méthode de coupe personnalisée dans la fenêtre Découpe de contour, toutes les
méthodes de découpe personnalisées étaient supprimées de la liste.

• Vous ne pouviez pas définir de méthode de coupe personnalisée lorsque vous sélectionniez une table de découpe
Esko.

• Vous ne pouviez pas effectuer d’impression sans bordure sur les imprimantes de la gamme Canon PRO lorsque
vous définissiez un format de support personnalisé.

Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.184

Fiery Command WorkStation

• Dans Calibrator, une fois le recalibrage terminé, l'option Générer des données ACD après le calibrage était
sélectionnée pour les imprimantes prises en charge.

Fiery XF

• Lors de la création d'une bibliothèque de tons directs à l’aide de Color Editor connecté à un serveur Fiery XF, les
valeurs de couleurs n’ont pas été enregistrées. Par ailleurs, si vous avez importez à nouveau la même
bibliothèque, les valeurs n’ont pas été conservées pour les tons directs personnalisés CMYKRB, CMYKOB et
CMYKRV.

Problèmes résolus dans Fiery Command WorkStation Package version 6.8.0.165

Fiery Command WorkStation

• Lorsque vous créiez un calibrage pour un Fiery server pour lequel l’option ACD n’était pas activée, Fiery
Calibrator ouvrait tout de même les WebTools pour la génération des données ACD.

• Lorsque vous créiez un nouveau Fiery Hot Folder et que vous sélectionniez Définir pour définir les paramètres de
la tâche, la fenêtre des Propriétés de la tâche ne s’ouvrait pas.

• L’affichage de la prévisualisation dans le volet Affichage feuille de la Prévisualisation Fiery prenait plus de temps
que d’habitude pour certaines tâches PDF imposées.

• Sur un ordinateur Windows, un message relatif à l’arrêt de la prise en charge apparaissait dans la fenêtre Démo
Fiery Impose au lieu de la fenêtre Gérer les options Fiery.

Notes de mise à jour client :
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• Dans Propriétés de la tâche > Finition, pour une tâche de 1 000 pages, si vous activiez l’option d’impression
Intercalaire pour 100 copies, l’intercalaire était inséré avant chaque copie.

• Lorsque vous essayiez d’ouvrir la Fiery Command WorkStation et de vous connecter aux Fiery servers lorsque le
serveur des mises à jour d’EFI était hors ligne, le chargement des files d’attente de tâches prenait quelques
minutes.

Fiery XF

• Lorsque vous sélectionniez le Préréglage des tolérances cibles Personnalisé dans Server Manager, la valeur du
format de delta E s’affichait en tant que dE 2000, ce qui était incorrect. Toutefois, dans Job Editor, la valeur du
format de delta E était correctement affichée en tant que dE CIE76.

Mise à niveau

Cet installateur met à niveau tout Fiery Command WorkStation Package existant vers le dernier package contenant
Fiery Command WorkStation et des Fiery Hot Folders. Vous pouvez également installer Fiery Remote Scan avec
Fiery Software Manager.
Pour plus d’informations sur les spécifications techniques, consultez le site www.efi.com/cws.

Configuration système requise :

Versions prises en charge

Fiery Command WorkStation version 6.8 prend en charge le logiciel système Fiery FS150/FS150 Pro ainsi que les
versions ultérieures installées sur le Fiery server.
Fiery Command WorkStation prend en charge les systèmes d’exploitation suivants sur votre ordinateur :

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11, 64 bits

• Windows 10, 64 bits

• Windows Server 2022, 64 bits

• Windows Server 2019, 64 bits

• Windows Server 2016, 64 bits

Remarque : Fiery Command WorkStation offre la prise en charge de Rosetta pour les ordinateurs macOS avec la
puce M1. Pour plus d’informations, visitez https://www.efi.com/marketing/fiery-servers-and-software/campaigns/
macos-big-sur-compatibility/.

Notes de mise à jour client :
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Problèmes identifiés

macOS 13

Adobe Acrobat sur macOS 13

Dans la mesure où Adobe n'offre pas encore la prise en charge complète d'Adobe Acrobat sur macOS 13, vous
rencontrerez les problèmes suivants :

• Il n'est pas possible de démarrer Adobe Acrobat à partir de macOS 13 sur des processeurs M1 et M2.

• Sur les processeurs Intel, Adobe Acrobat affiche la fenêtre de connexion, même si vous êtes déjà connecté.
Ignorez la fenêtre de connexion et Acrobat fonctionne normalement.

Calibrage non disponible sur le serveur Fiery XF

Si vous essayez d'effectuer un calibrage à partir de Command WorkStation sous macOS 13, (Color Tools > Créer
un calibrage), les commandes du panneau gauche ne sont pas visibles, de telle sorte que le calibrage ne peut pas
être utilisé.

macOS 10.15 et versions ultérieures

Accès complet au disque

En raison des améliorations apportées dans la façon dont macOS 10.15 ou version ultérieure gère la protection,
des opérations supplémentaires sont désormais nécessaires pour que les applications Fiery fonctionnent
correctement.
Il est nécessaire de modifier les options de protection d'Accès complet au disque dans macOS afin que les
applications Fiery puissent gérer les mises à jour et accéder aux fichiers tels que les modèles Impose et les Hot
Folders. Activer l’Accès complet au disque pour les applications Fiery telles que Fiery Command WorkStation.

1 Fermer toutes les applications Fiery.

2 Accédez à Préférences Système > Sécurité et confidentialité > Confidentialité > Accès complet au disque.

3 Cliquer sur l'icône du verrou dans le coin inférieur gauche et saisir le mot de passe.

4 Dans la liste des applications, sélectionnez la case située à côté de com.efi.InstallerHelperTool.

5 Cliquer sur le bouton +.

6 Dans le dossier Applications, sélectionner Fiery Software Manager et Fiery Software Uninstaller et cliquer
sur Ouvrir.
Ces applications nécessitent un accès complet au disque pour pouvoir conserver et mettre à jour les
applications Fiery sur votre ordinateur.

7 Ouvrir le dossier Applications, sélectionner l'application Fiery Command WorkStation et cliquer sur Ouvrir.

Notes de mise à jour client :
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8 Si vous utilisez Fiery Hot Folders ou Fiery Remote Scan, sélectionnez chaque application, puis cliquez sur
Ouvrir.
Fiery Hot Folders génère un message demandant un accès complet au disque lorsqu'il détecte que les dossiers
Documents, Bureau et Téléchargements sont en cours d'utilisation. Ce message continue à s’afficher même
après l’autorisation d’accès. Vous pouvez supprimer ce message et continuer à travailler.

Conversion PS en PDF

Lorsque vous utilisez macOS 10.14.5 et ses versions ultérieures avec Fiery Impose, Fiery Compose, ou Fiery
JobMaster, vous pouvez être invité à autoriser l'accès d'Acrobat Distiller à la Fiery Command WorkStation. Cette
autorisation est nécessaire pour la conversion des fichiers PS au format PDF. Les conversions ne sont pas effectuées
correctement lorsque la permission n'est pas accordée. Vous devrez modifier la fonction de sécurité automatique
dans macOS.

1 Fermer toutes les applications Fiery.

2 Fermez Acrobat Distiller.

3 Atteindre Préférences du système > Sécurité et confidentialité > Confidentialité > Automatisation.

4 Cliquez sur l'icône du verrou dans le coin inférieur gauche et saisissez le mot de passe.

5 Dans la liste des applications, localisez Fiery Command WorkStation. app.

6 Sélectionnez l’option Acrobat Distiller. app.
Cela permet à la Fiery Command WorkStation d’accéder à Acrobat Distiller.

Définition des préférences dans Adobe Acrobat Distiller pour la conversion de PostScript en
PDF

Fiery Impose, Fiery Compose et Fiery JobMaster nécessitent Acrobat Distiller pour convertir les fichiers PostScript
(PS) en PDF sur un ordinateur client.
En raison des paramètres de sécurité améliorée dans Acrobat Distiller, vous devez vérifier que le fichier PS à
convertir provient d’une source fiable dans : Acrobat Distiller > Fichier > Préférences > Préférences - Acrobat Distiller,
sélectionnez Approuver tous les fichiers ouverts via Acrobat Distiller sous Sécurité.

Remarque : Si vous ne sélectionnez pas Approuver tous les fichiers ouverts via Acrobat Distiller, vous êtes invité à
confirmer que le fichier provient d’une source fiable pour chaque fichier PS à convertir en PDF. Cela s’applique
également aux Hot Folders lorsque le filtre Microsoft Office est sélectionné, que le Type de fichier de sortie spécifié
est PDF et qu’un fichier joboptions est sélectionné en tant que Profil Distiller.

Spot Pro

Couleurs spéciales

Les couleurs spéciales ne possèdent pas de profil et la fonctionnalité Appliquer à se limite aux valeurs CMYK du
périphérique uniquement.

Notes de mise à jour client :
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Arrondi des valeurs de ton direct

Si vous avez défini un ton direct et redémarré Spot Pro, les valeurs de certaines couleurs peuvent être
légèrement différentes des valeurs d’origine que vous avez saisies. Cela est dû à l’arrondi numérique effectué par
Spot Pro, mais il ne devrait pas y avoir de changement visible dans la couleur.

Mode de mesure M3

Le mode M3 n’est pas pris en charge pour les appareils de mesure uniques.

Notes de mise à jour client :
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Note di release per l'utente
Fiery Command WorkStation Package, versione 6.8

Questo documento contiene importanti informazioni su questa release. Distribuire una copia di questo documento a
tutti gli utenti prima di procedere con l'installazione.

Informazioni su questa release

Questa release comprende le seguenti applicazioni:

• Fiery Command WorkStation Package v6.8.0.615

• Fiery Command WorkStation per Windows v6.8.0.54

• Fiery Command WorkStation per Mac v6.8.0.55

• Fiery Hot Folders v4.3.1.05

• Fiery Software Manager per Windows v6.8.0.11

• Fiery Software Manager per Mac v6.8.0.12

Nuove funzioni

Novità

Per informazioni sulle nuove funzioni aggiunte alla release iniziale della versione 6.8, visitare http://
fiery.efi.com/CWS/Whats-New.

Anteprima effetti di modifica della curva raster

Per tutti i Fiery servers esterni, quando si usa Proprietà del lavoro per applicare una modifica della curva di
raster a un lavoro, i risultati vengono visualizzati nell'applicazione Fiery Preview per i lavori elaborati.
Per i Fiery servers integrati, le modifiche della curva raster a un lavoro vengono visualizzate nell'applicazione
Fiery Preview per i lavori elaborati solo quando l'opzione Fiery ColorRight Package o Fiery Productivity Package
è abilitata.

Report di ottimizzazione tinte piatte

In Fiery Spot Pro, è ora possibile salvare il report di ottimizzazione tinte piatte come file HTML.

http://fiery.efi.com/CWS/Whats-New
http://fiery.efi.com/CWS/Whats-New


Notifiche di backup dell'Immagine di Fiery System

Il backup dell'Immagine di Fiery System invia una notifica quando un backup non riesce e viene elencato sotto la
voce Notifiche in Fiery Command WorkStation.

• È possibile riprogrammare il backup in Gestione impostazioni > Ripristino sistema Fiery.

• Per nascondere la notifica, fare clic sull'icona Altro (tre puntini) e selezionare Nascondi.

Pulsante Chiudi per la finestra Novità

La finestra Novità viene visualizzata quando si installa e si apre per la prima volta la versione più recente di Fiery
Command WorkStation. Ora è possibile utilizzare il pulsante Chiudi nella parte inferiore della finestra Novità,
anche se la risoluzione dello schermo è inferiore a quella supportata.
Risoluzioni minime dello schermo supportate:

• 1280 x 1024 (foglio singolo)

• 1600 x 900 (wide e superwide)

Problemi risolti

Problemi risolti in Fiery Command WorkStation Package v6.8.0.615

Fiery Command WorkStation

• Fiery Command WorkStation Package ora supporta i font cinesi in conformità con lo standard GB18030.

Problemi risolti in Fiery Command WorkStation Package v 6.8.0.541

Fiery Command WorkStation

• Quando si univano due file PDF con l'opzione Unisci tutti i file se inoltrati come una cartella in Fiery Hot Folders,
il file PDF di destinazione non veniva visualizzato come previsto.

• Quando si selezionava una calibrazione Patinata - Lucida durante la calibrazione di un Fiery server, appariva un
messaggio di errore relativo alla grammatura.

• Quando si creava un documento master in Proprietà del lavoro per un lavoro VDP nella coda di attesa e si faceva
clic su Master anteprima, veniva aggiunta un'ulteriore pagina vuota.

Note di release per l'utente

Fiery Command WorkStation Package, versione 6.8

21



Problemi risolti in Fiery Command WorkStation Package v 6.8.0.514

Fiery Command WorkStation

• Dopo il clic su Risorse > Spot Pro per un Fiery server con software di sistema FS200/200 Pro o FS300/300 Pro,
l'elenco delle tinte piatte e i valori delle tinte piatte non comparivano.

Fiery XF

• Non era possibile aggiornare i profili supporto con il Programma di aggiornamento profili Fiery quando è stato
aggiornato un server Fiery XF dalla v7.3 alla v7.3.3.

Problemi risolti in Fiery Command WorkStation Package v 6.8.0.466

Fiery Command WorkStation

• Su un sistema in lingua spagnola, non era possibile eliminare un lavoro selezionato dalla coda di attesa premendo
il tasto Elimina.

• L'opzione Pubblica come stampante virtuale appariva nella scheda Preimpostazioni lavoro per un server Fiery
integrato su cui non era installata una licenza di stampante virtuale.

• Non era possibile creare una nuova calibrazione comune utilizzando un sensore in linea automatizzato per più
stampanti con l'opzione Printer Match in Fiery Color Profiler Suite.

Problemi risolti in Fiery Command WorkStation Package v 6.8.0.439

Fiery Command WorkStation

• Non era possibile salvare una voce selezionata del catalogo carta di un lavoro nella finestra Definisci supporto per
foglio di separazione.

• Su alcuni sistemi in lingua giapponese, il numero di copie di un lavoro di calibrazione non era corretto.

Fiery XF

• In Job Editor, il formato pagina visualizzato per un lavoro PDF con segni di taglio non era corretto.

Problemi risolti in Fiery Command WorkStation Package v 6.8.0.406

Fiery Command WorkStation

• Non era possibile calibrare una stampante con l'opzione Correzione automatica registrazione colore.

• Quando si tentava di eliminare un punto della curva dopo aver modificato un lavoro elaborato in ImageViewer >
Regolazione colore, la pagina selezionata era eliminata. La pagina era ripristinata se si era fatto clic su Ripristina.
Tuttavia, non era possibile continuare con la modifica senza riavviarne il processo.

Fiery XF

• Non era possibile salvare alcune opzioni di stampa per i supporti in Server Manager per le stampanti VUTEk h5.

• Quando si selezionava una scala di controllo in Job Editor > Verifica > Barre di controllo, la preimpostazione della
tolleranza di destinazione si modificava in Personalizzata.
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Problemi risolti in Fiery Command WorkStation Package v 6.8.0.385

Fiery XF

• Quando si segmentava un lavoro, nel calcolo delle dimensioni del lavoro per singolo segmento non venivano
considerate le aree colla e di sovrapposizione.

Problemi risolti in Fiery Command WorkStation Package v 6.8.0.366

Fiery Command WorkStation

• In Fiery Spot Pro, le indicazioni ∆E che rientrano nel gamut e fuori gamut non erano coerenti per le tinte piatte,
anche quando veniva definita la tolleranza nella finestra di dialogo Preferenze.

• Quando si definiva un colore specializzato e si riapriva Fiery Spot Pro, i valori di separazione del colore
specializzato non venivano mantenuti.

• Non era possibile definire le impostazioni di copertina per una nuova cartella automatica quando veniva
selezionato un modello Impose in Proprietà del lavoro.

Fiery XF

• In Color Tools, veniva visualizzato un messaggio di errore quando si tentava di creare un file di calibrazione di
base per la stampante Seiko M64s.

• In Color Tools, quando si selezionavano diverse opzioni di Supporti dall'elenco e si faceva clic su Stampa durante
la ricalibrazione, la dimensione della tabella delle misure si riduceva in modo imprevisto.

Problemi risolti in Fiery Command WorkStation Package v 6.8.0.333

Fiery Command WorkStation

• In Fiery ImageViewer, quando si selezionava l'opzione di stampa Corrente per una pagina successiva, mentre la
prima pagina del lavoro si trovava nella coda di stampa, appariva un messaggio di errore.

• Quando si utilizzavano diverse voci di catalogo carta per definire il supporto booklet in Fiery Impose e il
supporto copertina in Command WorkStation, il primo foglio del lavoro veniva stampato con alcune
impostazioni non corrette per la copertina. Tuttavia, il resto dei fogli veniva stampato con le impostazioni
supporti booklet.

• Non è stato possibile specificare l'unità di misura nell'opzione spostamento immagine oltre 0,29 millimetri o il
valore equivalente in pollici e punti.

• Se si sceglieva di usare Command WorkStation in lingua tedesca, non era possibile ricalibrare un set di
calibrazione se il lavoro utilizzava una delle seguenti opzioni:

• formato carta personalizzato

• Formato pagina personalizzato e APPE abilitati
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Fiery XF

• Se si tentava di eseguire la calibrazione da Command WorkStation su macOS 13 (Color Tools > Crea
calibrazione), i controlli del pannello sinistro non erano visibili, quindi non era possibile utilizzare la
calibrazione.

• Quando si definiva il formato supporto personalizzato in Stampante  > Job Editor > Formato , i margini hardware
stampante non venivano visualizzati nell'anteprima lavoro.

Problemi risolti in Fiery Command WorkStation Package v 6.8.0.277

Fiery Command WorkStation

• Su macOS 13 con Command WorkStation e Fiery Hot Folders, quando si selezionava Proprietà del lavoro >
Layout > Esegui imposizione > Modifica modello Impose, le modifiche non potevano essere salvate perché la
finestra si chiudeva improvvisamente.

• Su macOS 13, non era possibile avviare Fiery Software Manager da App e risorse se Fiery Software Manager era
già in esecuzione.

• Su macOS 13, quando si salvava il report di ottimizzazione tinte piatte come file HTML, i loghi di EFI e Fiery
non erano presenti se si apriva il report con Safari.

• Quando si salvava un modello di formato di finitura Definito dall'utente con caratteri a doppio byte su Fiery
Impose e lo si applicava a un lavoro dalle Proprietà del lavoro, venivano selezionati i valori definiti per il formato
di finitura In base al riquadro ritaglio anziché i valori di formato di finitura Definito dall'utente.

• In Fiery Preview, la copertina e le pagine del corpo mostravano le stesse impostazioni supporti anche se in Fiery
Impose erano state specificate impostazioni supporti diverse per la copertina e le pagine del corpo.

• Quando si faceva clic sulla scheda Supporti in Proprietà del lavoro e si scorreva verso Supporti misti, alcune
opzioni supporto non venivano visualizzate per il lavoro.

Fiery XF

• Quando si impostava un finitura dispositivo Zund in Server Manager e Job Editor, l'unico metodo di taglio
disponibile era DumDum.

• Quando si selezionava la posizione del codice a barre In alto e in basso per un lavoro multipagina raggruppato
nella scheda Finitura, una parte del codice a barre in basso appariva all'esterno del layout del supporto e il file non
veniva stampato.

Problemi risolti in Fiery Command WorkStation Package v 6.8.0.217

Fiery Command WorkStation

• Quando è stato fatto clic su Avanti nella finestra Layout del campione durante la ricalibrazione di un Fiery server,
Fiery Calibrator ha visualizzato di nuovo lo stesso Layout del campione e non ha stampato la tabella delle misure.
Questo problema si è verificato quando è stata impostata la lingua francese per Fiery server e Fiery Command
WorkStation.

• In Fiery ImageViewer, quando è stata modificata la curva nel riquadro Regolazione colore per un lavoro
monocromatico e si è tentato di salvarla come preimpostazione, è stato visualizzato un messaggio di errore.
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Fiery XF

• Quando è stato eliminato un metodo di taglio personalizzato nella finestra Taglio del contorno, tutti i metodi di
taglio personalizzati sono stati eliminati dall'elenco.

• Non è stato possibile definire un metodo di taglio personalizzato quando è stato selezionato un piano di taglio
Esko.

• Non è stato possibile eseguire la stampa senza bordi per le stampanti Canon PRO series quando è stato definito
un formato supporto personalizzato.

Problemi risolti in Fiery Command WorkStation Package v6.8.0.184

Fiery Command WorkStation

• In Calibrazione, al termine della ricalibrazione, l'opzione Genera dati ACD dopo calibrazione veniva selezionata
per le stampanti supportate.

Fiery XF

• Quando veniva creata una libreria tinte piatte utilizzando Color Editor collegato a un server Fiery XF, i valori
cromatici non venivano salvati. Inoltre, se si importava nuovamente la stessa libreria, i valori non venivano
mantenuti per le tinte piatte personalizzate CMYKRB, CMYKOB e CMYKRV.

Problemi risolti in Fiery Command WorkStation Package v 6.8.0.165

Fiery Command WorkStation

• Quando si creava una calibrazione per un Fiery server per cui l'opzione ACD non era abilitata, Fiery Calibrator
apriva comunque WebTools per la generazione dei dati ACD.

• Quando si creava una nuova Fiery Hot Folder e si selezionava Definisci per specificare le impostazioni del lavoro,
la finestra Proprietà del lavoro non si apriva.

• Era necessario più tempo del solito per visualizzare l'anteprima nell'area Vista foglio dell'Anteprima Fiery per
alcuni lavori PDF sottoposti a imposizione.

• Su un computer Windows, compariva un messaggio circa il supporto non più in produzione nella finestra Demo
Fiery Impose anziché nella finestra Gestione opzioni Fiery .

• In Proprietà del lavoro > Finitura, per un lavoro di 1000 pagine, se era stata abilitata l'opzione di stampa Foglio di
separazione per ogni 100 copie, il foglio di separazione veniva inserito prima di ogni singola copia.

• Quando si tentava di aprire Fiery Command WorkStation e a collegarsi a Fiery servers mentre il server degli
aggiornamenti EFI era offline, le code dei lavori impiegavano qualche minuto per il caricamento.

Fiery XF

• Quando si selezionava la Preimpostazione tolleranze target come Personalizzata in Server Manager, il valore del
formato Delta E appariva come dE 2000, il che non era corretto. Tuttavia, in Job Editor il valore del formato Delta
E appariva correttamente come dE CIE76.
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Aggiornamento

Questo programma di installazione aggiornerà qualsiasi Fiery Command WorkStation Package esistente all'ultima
versione del pacchetto contenente Fiery Command WorkStation e Fiery Hot Folders. Facoltativamente, è possibile
installare Fiery Remote Scan utilizzando Fiery Software Manager.
Per ulteriori informazioni sulle specifiche tecniche, vedere www.efi.com/cws.

Aggiornamenti ai requisiti di sistema

Versioni supportate

Fiery Command WorkStation versione 6.8 supporta il software di sistema Fiery FS150/FS150 Pro e versioni
successive installate su Fiery server.
Fiery Command WorkStation supporta i seguenti sistemi operativi dei computer:

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11 (64 bit)

• Windows 10 (64 bit)

• Windows Server 2022 (64 bit)

• Windows Server 2019 (64 bit)

• Windows Server 2016 (64 bit)

Nota: Fiery Command WorkStation offre supporto per Rosetta per computer macOS con chip M1. Per ulteriori
informazioni, visitare https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-sur-
compatibility/.

Problemi noti

macOS 13
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Adobe Acrobat su macOS 13

Poiché Adobe non offre ancora il supporto completo per Adobe Acrobat su macOS 13, si verificheranno questi
problemi:

• non è possibile avviare Adobe Acrobat da macOS 13 su processori M1 e M2;

• sui processori Intel, Adobe Acrobat mostra la finestra di accesso anche se si è già effettuato l'accesso.
Ignorare la finestra di accesso e le funzioni di Acrobat normalmente.

Calibrazione non disponibile su server Fiery XF

Se si tenta di eseguire la calibrazione da Command WorkStation su macOS 13, (Color Tools > Crea calibrazione),
i controlli del pannello sinistro non sono visibili, quindi non è possibile utilizzare la calibrazione.

macOS 10.15 e versioni successive

Accesso completo al disco

A causa delle modifiche apportate alla modalità in cui macOS 10.15 o versioni successive gestisce la sicurezza,
sono necessari altri passaggi per consentire il corretto funzionamento delle applicazioni Fiery.
È necessario apportare modifiche alla funzionalità di sicurezza dell'Accesso completo al disco in macOS per
consentire alle applicazioni Fiery di gestire gli aggiornamenti e accedere ai file come i modelli Impose e le
cartelle automatiche. Abilitare l'Accesso completo al disco per le applicazioni Fiery quali Fiery Command
WorkStation.

1 Chiudere tutte le applicazioni Fiery.

2 Andare in Preferenze di sistema > Sicurezza e privacy > Privacy > Accesso completo al disco.

3 Fare clic sul lucchetto nell'angolo in basso a sinistra e immettere la propria password.

4 Nell'elenco delle app, selezionare la casella di controllo accanto a com.efi.InstallerHelperTool.

5 Fare clic sul pulsante +.

6 Aprire la cartella Applicazioni, selezionare Fiery Software Manager e Fiery Software Uninstaller e fare clic su
Apri.
Queste applicazioni richiedono l'accesso completo al disco per poter mantenere e aggiornare le applicazioni
Fiery sul computer.

7 Selezionare l'applicazione Fiery Command WorkStation nella cartella Applicazioni e fare clic su Apri.

8 Se si usa Fiery Hot Folders o Fiery Remote Scan, selezionare ogni applicazione e fare clic su Apri.
Quando Fiery Hot Folders rileva che vengono utilizzate le cartelle Documenti, Desktop e Download, invia un
messaggio con la richiesta di accesso completo al disco. Questo messaggio viene ancora visualizzato anche
dopo che è stato concesso l'accesso. È possibile ignorare questo messaggio e continuare a lavorare.

Conversione da PS a PDF

Quando si utilizza macOS 10.14.5 e versioni successive con Fiery Impose, Fiery Compose o Fiery JobMaster, è
possibile che venga richiesto di consentire a Fiery Command WorkStation di accedere ad Acrobat Distiller. Questa
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autorizzazione è necessaria per la conversione dei file PS in PDF. Se non si concede l'autorizzazione, le conversioni
non avranno esito positivo e sarà necessario modificare la funzionalità di sicurezza di automazione in macOS.

1 Chiudere tutte le applicazioni Fiery.

2 Chiudere Acrobat Distiller.

3 Vai a Preferenze di sistema > Sicurezza e Privacy > Privacy > Automazione.

4 Fare clic sul lucchetto nell'angolo in basso a sinistra e immettere la propria password.

5 Nell'elenco App, individuare Fiery Command WorkStation.app.

6 Selezionare l'opzione Acrobat Distiller.app.
Ciò consente a Fiery Command WorkStation di accedere ad Acrobat Distiller.

Impostazioni delle preferenze in Adobe Acrobat Distiller per la conversione da PostScript a
PDF

Fiery Impose, Fiery Compose e Fiery JobMaster richiedono ad Acrobat Distiller di convertire i file PostScript (PS) in
formato PDF su un computer client.
A causa delle impostazioni di sicurezza ottimizzate in Acrobat Distiller, è necessario confermare che il file PS da
convertire abbia un'origine attendibile in: Acrobat Distiller. > File > Preferenze > Preferenze - Acrobat Distiller,
selezionare Considera attendibili tutti i file aperti tramite Acrobat Distiller in Sicurezza.

Nota: Se l'opzione Considera attendibili tutti i file aperti tramite Acrobat Distiller non è selezionata, sarà necessari
confermare che il file abbia un'origine attendibile per ogni file PS da convertire in PDF. Ciò è valido anche per le
cartelle automatiche quando si seleziona il filtro Microsoft Office, il Tipo di file di output viene specificato come PDF
e viene selezionato un file joboptions come Profilo Distiller.

Spot Pro

Colori specializzati

I colori speciali non hanno un profilo e la funzione Applica a è limitata solo ai valori CMYK del dispositivo.

Arrotondamento valore tinta piatta

Dopo aver definito un tinta piatta e riavviato Spot Pro, i valori per alcuni colori potrebbero differire leggermente
dai valori originali immessi. Ciò è dovuto all'arrotondamento numerico effettuato da Spot Pro e non dovrebbe
esserci alcun cambiamento visibile nel colore.

Modo di misurazione M3

Il modo M3 non è supportato per i dispositivi di misurazione singola.
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Release-Informationen für Kunden
Fiery Command WorkStation Package, Version 6.8

Dieses Dokument enthält wichtige Informationen zu diesem Release. Stellen Sie diese Informationen allen
Benutzern zur Verfügung, bevor Sie mit der Installation fortfahren.

Informationen zum Release

Diese Release-Version umfasst die folgenden Anwendungen:

• Fiery Command WorkStation Package v6.8.0.615

• Fiery Command WorkStation für Windows v6.8.0.54

• Fiery Command WorkStation für Mac v6.8.0.55

• Fiery Hot Folders v4.3.1.05

• Fiery Software Manager für Windows v6.8.0.11

• Fiery Software Manager für Mac v6.8.0.12

Neue Funktionen

Neuerungen

Weitere Informationen zu den neuen Funktionen, die nach dem ersten Release der Version 6.8 hinzugefügt wurden,
finden Sie unter http://fiery.efi.com/CWS/Whats-New.

Vorschau von Effekten der Rasterkurvenbearbeitung

Bei allen externen Fiery servers werden die Ergebnisse in der Fiery Preview Anwendung für bearbeitete Aufträge
angezeigt, wenn Sie die Auftragseigenschaften verwenden, um eine Rasterkurvenbearbeitung auf einen Auftrag
anzuwenden.
Bei integrierten Fiery servers werden die Rasterkurvenbearbeitungen eines Auftrags in der Fiery Preview
Anwendung für verarbeitete Aufträge nur angezeigt, wenn Fiery ColorRight Package oder Fiery Productivity
Package aktiviert ist.

http://fiery.efi.com/CWS/Whats-New


Bericht zur Spot-Farboptimierung

In Fiery Spot Pro können Sie den Bericht zur Spot-Farboptimierung jetzt als HTML-Datei speichern.

Benachrichtigungen zur Sicherung von Fiery Systemabbild

Die Sicherung des Fiery Systemabbilds wird Sie benachrichtigen, wenn eine Sicherung fehlschlägt und unter
Benachrichtigungen unter Fiery Command WorkStationaufgelistet wird.

• Sie können die Sicherung unter Einstellungen verwalten > Fiery Systemwiederherstellung neu einplanen.

• Um die Benachrichtigung auszublenden, klicken Sie auf das Symbol „Mehr“ (drei Punkte) und wählen Sie
Ausblenden.

Schaltfläche „Schließen“ für das Fenster Neuerungen

Das Fenster Neuerungen wird angezeigt, wenn Sie zum ersten Mal die neueste Version von Fiery Command
WorkStation installieren und öffnen. Sie können nun die Schaltfläche Schließen am unteren Rand des Fensters
Neuerungen verwenden, selbst wenn die Anzeigeauflösung kleiner als die unterstützte Auflösung ist.
Unterstützte Anzeigeauflösungen:

• 1280 x 1024 (Bogen)

• 1600 x 900 (Groß- und Supergroßformat)

Behobene Probleme

Behobene Probleme in Fiery Command WorkStation Package v6.8.0.615

Fiery Command WorkStation

• Fiery Command WorkStation Package unterstützt jetzt chinesische Schriften gemäß dem GB18030-Standard.

Behobene Probleme in Fiery Command WorkStation Package v6.8.0.541

Fiery Command WorkStation

• Wenn Sie zwei PDF-Dateien mit der Option Bei Übergabe als Ordner alle Dateien mischen in Fiery Hot Folders
zusammenführen, wurde die PDF-Datei nicht wie erwartet angezeigt.

• Wenn Sie beim Kalibrieren eines Fiery server die Kalibrierungsoption Beschicht. - Glanz ausgewählt haben,
wurde eine Fehlermeldung bezüglich des Papiergewichts angezeigt.

• Wenn Sie in den Auftragseigenschaften ein Master-Dokument für einen VDP-Auftrag in der Warteschlange
„Angehalten“ erstellt und auf Master-Vorschau geklickt haben, wurde eine zusätzliche Leerseite hinzugefügt.
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Behobene Probleme in Fiery Command WorkStation Package v6.8.0.514

Fiery Command WorkStation

• Wenn Sie auf Ressourcen > Spot Pro für einen Fiery server mit der Systemsoftware FS200/200 Pro oder
FS300/300 Pro geklickt haben, wurden die Liste der Spot-Farben und deren Werte nicht angezeigt.

Fiery XF

• Die Medienprofile konnten nicht mit der Fiery Profilaktualisierungsfunktion aktualisiert werden, wenn Sie ein
Upgrade für einen Fiery XF Server von v7.3 auf v7.3.3 durchgeführt haben.

Behobene Probleme in Fiery Command WorkStation Package v6.8.0.466

Fiery Command WorkStation

• Bei einem spanischen System konnten Sie keine ausgewählten Auftrag durch Drücken der Entf-Taste aus der
Warteschlange „Halten“ löschen.

• Die Option Als virtuellen Drucker freigeben wurde auf der Registerkarte Auftragsvorgaben für einen integrierten
Fiery Server angezeigt, auf dem keine Lizenz für einen virtuellen Drucker installiert war.

• Es konnte keine neue gemeinsame Kalibrierung mit einem automatisierten Inline-Sensor für mehrere Drucker
mit der Option Druckerabstimmung in Fiery Color Profiler Suite erstellt werden.

Behobene Probleme in Fiery Command WorkStation Package v6.8.0.439

Fiery Command WorkStation

• Im Fenster Medium definieren für Trennblatt konnte ein ausgewählter Papierkatalog-Eintrag für einen Auftrag
nicht gespeichert werden.

• Bei einigen Systemen in japanischer Sprache war die Anzahl der Kopien eines Kalibrierungsauftrags falsch.

Fiery XF

• In Job Editor war die für einen PDF-Auftrag mit Schneidemarken angezeigte Seitengröße falsch.

Behobene Probleme in Fiery Command WorkStation Package v6.8.0.406

Fiery Command WorkStation

• Drucker konnten nicht mit der Option Farbverzerrung automatisch korrigieren kalibriert werden.

• Beim Versuch, einen Kurvenpunkt nach dem Ändern eines verarbeiteten Auftrags in ImageViewer >
Farbanpassungzu löschen, wurde die ausgewählte Seite gelöscht. Beim Klicken auf Zurücksetzen wurde die Seite
wiederhergestellt. Sie konnten die Bearbeitung jedoch nicht fortsetzen, ohne den Bearbeitungsvorgang neu zu
starten.
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Fiery XF

• Für VUTEk h5 Drucker konnten einige Druckoptionen für Medien nicht im Server Manager gespeichert werden.

• Wenn Sie einen Medienkeil unter Job Editor > Überprüfen > Kontrollstreifenausgewählt hatten, wurde die
Voreinstellung für die Solltoleranz auf Eigen geändert.

Behobene Probleme in Fiery Command WorkStation Package v6.8.0.385

Fiery XF

• Beim Kacheln eines Auftrags wurden Klebstoff- und Überlappungsbereiche bei der Berechnung der
Auftragsgröße für eine einzelne Kachel nicht berücksichtigt.

Behobene Probleme in Fiery Command WorkStation Package v6.8.0.366

Fiery Command WorkStation

• In Fiery Spot Pro waren die ∆E-Angaben innerhalb und außerhalb des Gamuts für Spot-Farben nicht konsistent,
selbst wenn Sie die Toleranz im Dialogfeld Voreinstellungen definierten.

• Beim Definieren einer Spezialfarbe und erneutem Öffnen von Fiery Spot Pro wurden die Separationswerte der
Spezialfarben nicht beibehalten.

• Bei der Auswahl einer Impose-Schablone in den Auftragseigenschaften konnten Sie keine Einstellungen für die
Druckinfo für einen neuen überwachten Ordner festlegen.

Fiery XF

• In Color Tools wurde eine Fehlermeldung angezeigt, wenn Sie versuchten, eine Basislinearisierungsdatei für den
Seiko M64s-Drucker zu erstellen.

• Wenn Sie in Color Tools verschiedene Optionen für Medien aus der Liste auswählten und während der
Nachkalibrierung auf Drucken klickten, verringerte sich die Größe der Messwertetabelle unerwartet.

Behobene Probleme in Fiery Command WorkStation Package v6.8.0.333

Fiery Command WorkStation

• Wenn in Fiery ImageViewer die Druckoption Aktuell für eine weitere Seite ausgewählt war, während sich die
erste Seite des Auftrags in der Druckwarteschlange befand, wurde eine Fehlermeldung angezeigt.

• Wenn verschiedene Papierkatalogeinträge zum Definieren der Broschüre in Fiery Impose und des Deckblatts in
Command WorkStation definiert waren, wurde der erste Bogen des Auftrags mit falschen Druckinfo-
Einstellungen gedruckt. Die restlichen Bogen wurden jedoch mit den Medieneinstellungen für Broschüren
gedruckt.

• Sie konnten die Maßeinheit in der Bildversatzoption nicht über 0,29 Millimeter oder einen entsprechenden Wert
in Zoll und Punkten hinaus festlegen.

• In Command WorkStation war bei Verwendung der Anzeigesprache Deutsch das Nachkalibrieren von
Kalibrierungssets nicht möglich, wenn der Auftrag eine der folgenden Optionen verwendete:

• Eigene Papiergröße

• Aktivierte APPE für eigene Papiergröße
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Fiery XF

• Wenn Sie unter macOS 13 versucht haben, eine Kalibrierung von der Command WorkStation durchzuführen
(Color Tools > – Kalibrierung erstellen), waren die Steuerelemente auf der linken Seite nicht sichtbar, sodass die
Kalibrierung nicht verwendet werden konnte.

• Wenn Sie eine eigene Mediengröße unter Job Editor > Drucker > Format definiert haben, wurden die Ränder der
Drucker-Hardware in der Auftragsvorschau nicht angezeigt.

Behobene Probleme in Fiery Command WorkStation Package v6.8.0.277

Fiery Command WorkStation

• Unter macOS 13 mit Command WorkStation und Fiery Hot Folders konnten die Änderungen nicht gespeichert
werden, weil das Fenster unerwartet geschlossen wurde, wenn Sie Auftragseigenschaften > Layout > Impose >
Impose Schablone bearbeitenausgewählt haben.

• Unter macOS 13 konnten Sie Fiery Software Manager nicht über Anwendungen und Ressourcen starten, wenn
Fiery Software Manager bereits ausgeführt wurde.

• Unter macOS 13 wurden beim Speichern des Berichts zur Spot-Farboptimierung als HTML-Datei die EFI und
Fiery Logos nicht angezeigt, wenn Sie den Bericht in Safari geöffnet haben.

• Wenn Sie eine eigene Endgrößenvorlage mit Doppelbyte-Zeichen in Fiery Impose gespeichert und auf einen
Auftrag aus Auftragseigenschaften angewendet haben, wurden anstelle der Endgrößenwerte, die für die
Endgröße auf Basis des Maskenrahmens definierten Werte anstelle der eigenen Endgrößenwerte ausgewählt.

• In Fiery Preview werden für den Einband und den Hauptteil dieselben Medieneinstellungen angezeigt, auch
wenn Sie in Fiery Impose unterschiedliche Medieneinstellungen für den Einband und den Hauptteil festgelegt
haben.

• Wenn Sie in den Auftragseigenschaften auf die Registerkarte Medium geklickt und nach unten zum Bereich
Gemischte Medien geblättert haben, wurden einige Medienoptionen für den Auftrag nicht angezeigt.

Fiery XF

• Beim Einrichten eines Zund-Weiterverarbeitungsgeräts in Server Manager und Job Editor war DumDum die
einzige verfügbare Schneidemethode.

• Wenn Sie die Barcode-Position Oben und unten für einen verschachtelten mehrseitigen Auftrag auf der
Registerkarte Finishing ausgewählt haben, wurde ein Teil des Barcodes am unteren Rand außerhalb des
Medienlayouts angezeigt, und die Datei wurde nicht gedruckt.

Behobene Probleme in Fiery Command WorkStation Package v6.8.0.217

Fiery Command WorkStation

• Wenn Sie während der Fiery server Neukalibrierung auf Weiter im Fenster Messfeldlayout geklickt haben, zeigte
Fiery Calibrator erneut dasselbe Messfeldlayout an und druckte die Messwerttabelle nicht. Dieses Problem trat
auf, wenn Sie die Fiery server Sprache sowie die Fiery Command WorkStation Sprache zuvor auf Französisch
eingestellt hatten.

• Wenn Sie in Fiery ImageViewer die Kurve im Fenster Farbanpassung für einen Monochromdruckauftrag
bearbeitet und versucht haben, diese als Vorgabe zu speichern, wurde eine Fehlermeldung angezeigt.
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Fiery XF

• Wenn Sie eine eigene Schnittmethode im Fenster Konturschnitt gelöscht haben, wurden alle eigenen
Schnittmethoden aus der Liste gelöscht.

• Sie konnten keine benutzerdefinierte Schnittmethode definieren, wenn Sie zuvor einen Esko Schneidetisch
ausgewählt hatten.

• Für Drucker der Serie CANON PRO konnten Sie keinen Randlosdruck durchführen, wenn Sie zuvor eine eigene
Mediengröße definiert hatten.

Behobene Probleme in Fiery Command WorkStation Package v6.8.0.184

Fiery Command WorkStation

• Wenn in Kalibrator eine Kalibrierung abgeschlossen wurde, war die Option ACD-Daten nach Kalibrierung
generieren für unterstützte Drucker aktiviert.

Fiery XF

• Wenn Sie eine Spot-Farbbibliothek mit Color Editor erstellt haben, das mit einem Fiery XF Server verbunden ist,
wurden die Farbwerte nicht gespeichert. Wenn Sie außerdem erneut die gleiche Bibliothek importiert haben,
wurden die Werte für angepasste CMYKRB-, CMYKOB- und CMYKRV-Spot-Farben nicht beibehalten.

Behobene Probleme in Fiery Command WorkStation Package v6.8.0.165

Fiery Command WorkStation

• Wenn Sie eine Kalibrierung für einen Fiery server erstellt haben, für den die ACD-Option nicht aktiviert wurde,
öffnete Fiery Calibrator WebTools dennoch für die ACD-Datengenerierung.

• Wenn Sie einen neuen Fiery Hot Folder erstellt und die Option Definieren zum Festlegen von
Auftragseinstellungen gewählt haben, wurde das Fenster Auftragseigenschaften nicht geöffnet.

• Bei einigen ausgeschossenen PDF-Aufträgen dauerte es länger als gewöhnlich, bis die Vorschau im Bereich
Bogenansicht von Fiery Vorschau angezeigt wurde.

• Auf einem Windows-Computer wurde im Fenster Fiery Impose (Demo) anstelle des Fensters Fiery Optionen
verwalten eine Meldung über die Einstellung der Unterstützung angezeigt.

• Wenn Sie bei einem 1000-seitigen Auftrag unter Auftragseigenschaften > Finishingdie Druckoption Trennblatt
für alle 100 Kopien aktiviert haben, wurde das Trennblatt vor jeder einzelnen Kopie eingefügt.

• Wenn Sie versuchten, Fiery Command WorkStation zu öffnen und eine Verbindung zu Fiery servers
herzustellen, während der EFI Updateserver offline war, dauerte es einige Minuten, bis die
Auftragswarteschlangen geladen wurden.

Fiery XF

• Wenn Sie in Server Manager unter Vorgabe für Solltoleranzen die Option Eigen ausgewählt haben, wurde der
Wert des Delta E-Formats inkorrekt als „dE 2000“ angezeigt. In Job Editor wurde der Wert des Delta E-Formats
jedoch korrekt als „dE CIE76“ angezeigt.

Release-Informationen für Kunden

Fiery Command WorkStation Package, Version 6.8

34



Aktualisieren

Dieses Installationsprogramm aktualisiert jedes vorhandene Fiery Command WorkStation Package auf die aktuelle
Version, die Fiery Command WorkStation und Fiery Hot Folders beinhaltet. Mithilfe von Fiery Software Manager
können Sie optional Fiery Remote Scan installieren.
Weitere Informationen zu den technischen Spezifikationen finden Sie unter www.efi.com/cws.

Updates zu Systemvoraussetzungen

Unterstützte Versionen

Fiery Command WorkStation Version 6.8 unterstützt Fiery Systemsoftware FS150/FS150 Pro und spätere Versionen,
die auf dem Fiery server installiert sind.
Fiery Command WorkStation unterstützt folgende Betriebssysteme auf Ihrem Computer:

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11, 64 Bit

• Windows 10, 64 Bit

• Windows Server 2022, 64 Bit

• Windows Server 2019, 64 Bit

• Windows Server 2016, 64 Bit

Hinweis:  Fiery Command WorkStation bietet Rosetta-Unterstützung für macOS-Computer mit dem M1-Chip.
Weitere Informationen finden Sie hier: https://www.efi.com/marketing/fiery-servers-and-software/campaigns/
macos-big-sur-compatibility/

Bekannte Problemsituationen

macOS 13
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Adobe Acrobat unter macOS 13

Da Adobe unter macOS 13 noch keine vollständige Unterstützung für Adobe Acrobat bietet, treten folgende
Probleme auf:

• Sie können Adobe Acrobat nicht mit macOS 13 auf M1- und M2-Prozessoren starten.

• Auf Intel-Prozessoren zeigt Adobe Acrobat das Anmeldefenster an, auch wenn Sie bereits angemeldet sind.
Schließen Sie das Anmeldefenster und die Acrobat-Funktionen normal.

Kalibrierung auf Fiery XF Server nicht verfügbar

Wenn Sie unter macOS 13 versuchen, eine Kalibrierung von der Command WorkStation durchzuführen (Color
Tools > – Kalibrierung erstellen), sind die Steuerelemente auf der linken Seite nicht sichtbar, sodass die
Kalibrierung nicht verwendet werden kann.

macOS 10.15 und höher

Festplattenvollzugriff

Aufgrund von Änderungen in der Art und Weise, wie macOS 10.15 und höher die Sicherheit verwaltet, sind
jetzt zusätzliche Schritte erforderlich, um die ordnungsgemäße Funktion von Fiery Anwendungen zu
gewährleisten.
Sie müssen Änderungen an der Sicherheitsfunktion Festplattenvollzugriff in macOS vornehmen, damit Fiery
Anwendungen Updates verwalten und auf Dateien wie Impose Schablonen und Hot Folders zugreifen können.
Aktivieren Sie den Festplattenvollzugriff für Fiery Anwendungen wie Fiery Command WorkStation.

1 Schließen Sie alle Fiery Anwendungen.

2 Gehen Sie zu Systemeinstellungen > Sicherheit und Datenschutz > Datenschutz > Festplattenvollzugriff.

3 Klicken Sie in der unteren linken Ecke auf das Schloss-Symbol und geben Sie Ihr Kennwort ein.

4 Markieren Sie in der Liste der Anwendungen das Kontrollkästchen neben com.efi.InstallerHelperTool.

5 Klicken Sie auf die Schaltfläche +.

6 Wählen Sie im Ordner Anwendungen Fiery Software Manager und Fiery Software Uninstaller und klicken
Sie auf Öffnen.
Diese Anwendungen benötigen Festplattenvollzugriff, um Fiery Anwendungen auf Ihrem Computer zu
verwalten und zu aktualisieren.

7 Wählen Sie im Ordner Anwendungen die Anwendung Fiery Command WorkStation und klicken Sie auf
Öffnen.

8 Wenn Sie Fiery Hot Folders oder Fiery Remote Scan verwenden, wählen Sie jede Anwendung aus und
klicken Sie auf Öffnen.
Wenn Fiery Hot Folders erkennt, dass die Ordner „Dokumente“, „Desktop“ und „Downloads“ verwendet
werden, wird eine Meldung ausgegeben, in der der Festplattenvollzugriff angefordert wird. Diese Meldung
wird weiterhin angezeigt, auch nachdem der Zugriff erteilt wurde. Sie können diese Meldung schließen und
weiterarbeiten.
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Konvertierung von PS in PDF

Wenn Sie macOS 10.14.5 und später mit Fiery Impose, Fiery Compose oder Fiery JobMaster verwenden, werden Sie
möglicherweise aufgefordert, den Zugriff des Fiery Command WorkStation auf Acrobat Distiller zu ermöglichen.
Dieses Zugriffsrecht ist für die Konvertierung von PS-Dateien in PDF erforderlich. Wenn Sie keine Berechtigung
erteilen, werden die Konvertierungen nicht ausgeführt und Sie müssen die Funktion für die
Automatisierungssicherheit in macOS ändern.

1 Schließen Sie alle Fiery Anwendungen.

2 Schließen Sie Acrobat Distiller.

3 Gehe zu Systemeinstellungen > Sicherheit und Datenschutz > Datenschutz > Automatisierung.

4 Klicken Sie in der unteren linken Ecke auf das Schloss-Symbol und geben Sie Ihr Kennwort ein.

5 Suchen Sie in der Liste „AppsFiery Command WorkStation.app.

6 Wählen Sie die Option Acrobat Distiller.app aus.
Dadurch kann Fiery Command WorkStation auf Acrobat Distiller zugreifen.

Festlegen von Voreinstellungen in Adobe Acrobat Distiller für das Konvertieren von
PostScript in PDF

Für Fiery Impose, Fiery Compose und Fiery JobMaster ist Acrobat Distiller erforderlich, um auf einem Client-
Computer PostScript (PS)-Dateien in PDF zu konvertieren.
Aufgrund der verbesserten Sicherheitseinstellungen in Acrobat Distiller müssen Sie bestätigen, dass die zu
konvertierende PS-Datei aus einer vertrauenswürdigen Quelle stammt, und zwar unter: Acrobat Distiller > Datei >
Voreinstellungen > Voreinstellungen: Acrobat Distiller, wählen Sie Allen mittels Acrobat Distiller geöffneten Dateien
vertrauen unter Sicherheit.

Hinweis:  Wenn Allen mittels Acrobat Distiller geöffneten Dateien vertrauen nicht ausgewählt wurde, werden Sie
aufgefordert, für jede in PDF zu konvertierende PS-Datei zu bestätigen, dass sie aus einer vertrauenswürdigen Quelle
stammt. Dies gilt auch für Hot Folders, wenn der Filter Microsoft Office ausgewählt, PDF als Ausgabedateityp
angegeben und eine Joboptions-Datei als Distiller-Profil ausgewählt wurde.

Spot Pro

Spezialfarben

Spezialfarben werden nicht profiliert und die Funktion Anwenden auf beschränkt sich nur auf Geräte-CMYK-
Werte.

Rundung des Werts für Spot-Farben

Nachdem Sie eine Spot-Farbe definiert und Spot Pro neu gestartet haben, können die Werte für einige Farben
leicht von den ursprünglich eingegebenen Werten abweichen. Dies ist auf numerische Rundung
zurückzuführen, die Spot Pro ausgeführt hat, und es sollte keine spürbare sichtbare Änderung in der Farbe
geben.

Release-Informationen für Kunden

Fiery Command WorkStation Package, Version 6.8

37



Messmodus M3

Der Modus M3 wird für Geräte mit Einzelmessung nicht unterstützt.
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Notas de la versión para el cliente
Fiery Command WorkStation Package, versión 6.8

Este documento contiene información importante acerca de esta versión. Asegúrese de proporcionar esta
información a todos los usuarios antes de continuar con la instalación.

Acerca de esta versión

En esta versión se incluyen las siguientes aplicaciones:

• Fiery Command WorkStation Package 6.8.0.615

• Fiery Command WorkStation para Windows v6.8.0.54

• Fiery Command WorkStation para Mac 6.8.0.55

• Fiery Hot Folders 4.3.1.05

• Fiery Software Manager para Windows 6.8.0.11

• Fiery Software Manager para Mac 6.8.0.12

Nuevas funciones

Novedades

Para obtener información acerca de las nuevas funciones añadidas en la publicación inicial de la versión 6.8, visite 
http://fiery.efi.com/CWS/Whats-New.

Presentación preliminar de los efectos de edición de curva de datos de trama

Para todos los Fiery servers externos, al utilizar Propiedades del trabajo para aplicar una edición de curva de
datos de trama a un trabajo, los resultados se muestran en la aplicación de Fiery Preview para los trabajos
procesados.
Para los Fiery servers integrados, las ediciones de curva de datos de trama en un trabajo se muestran en la
aplicación de Fiery Preview solo para trabajos procesados cuando Fiery ColorRight Package o Fiery Productivity
Package están habilitados.

http://fiery.efi.com/CWS/Whats-New


Informe de optimización de colores planos

En Fiery Spot Pro, ahora se puede guardar el informe de optimización de colores planos como un archivo
HTML.

Notificaciones de copia de seguridad de la Imagen del sistema Fiery

La copia de seguridad de la Imagen del sistema Fiery le enviará una notificación cuando falle el proceso de copia
de seguridad, que aparecerá en la lista de Notificaciones en Fiery Command WorkStation.

• Puede reprogramar la copia de seguridad en Administrar configuración > Restauración del sistema Fiery.

• Para ocultar la notificación, haga clic en el icono más (tres puntos) y seleccione Ocultar.

Botón Cerrar de la ventana Novedades

La ventana Novedades aparece al instalar y abrir la última versión de Fiery Command WorkStation por primera
vez. Ahora puede utilizar el botón Cerrar de la parte inferior de la ventana Novedades aunque la resolución de la
pantalla sea inferior a la resolución admitida.
Resoluciones de pantalla mínimas admitidas:

• 1280 x 1024 (hojas sueltas)

• 1600 x 900 (formato ancho y superancho)

Problemas solucionados

Problemas solucionados en Fiery Command WorkStation Package 6.8.0.615

Fiery Command WorkStation

• Fiery Command WorkStation Package ahora admite tipos chinos que cumplan el estándar GB18030.

Problemas solucionados en Fiery Command WorkStation Package 6.8.0.541

Fiery Command WorkStation

• Al combinar dos archivos PDF con la opción Combinar todos los archivos si se envían como una carpeta en Fiery
Hot Folders, el archivo PDF de salida no aparecía como se esperaba.

• Al seleccionar la calibración Satin. - Brill. durante la calibración de un Fiery server, aparecía un mensaje de error
de no coincidencia del gramaje del papel.

• Al crear un documento maestro en Propiedades del trabajo para un trabajo de VDP en la cola En espera y hacer
clic en Presentación preliminar del archivo maestro, se agregaba una página vacía adicional.

Notas de la versión para el cliente
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Problemas solucionados en Fiery Command WorkStation Package 6.8.0.514

Fiery Command WorkStation

• Al hacer clic en Recursos > Spot Pro para un Fiery server con el software del sistema FS200/200 Pro o FS300/300
Pro, la lista de colores planos y los valores de colores planos no aparecían.

Fiery XF

• No se podían actualizar los perfiles de papel con el Actualizador de perfiles de Fiery cuando se actualizaba un
servidor Fiery XF de la versión 7.3 a la versión 7.3.3.

Problemas solucionados en Fiery Command WorkStation Package 6.8.0.466

Fiery Command WorkStation

• En un sistema en español, no se podían eliminar trabajos seleccionados de la cola En Espera al pulsar la tecla
Eliminar.

• La opción Publicar como impresora virtual aparecía en la pestaña Valores predefinidos del trabajo para un
servidor Fiery integrado en la que no había ninguna licencia de impresora virtual instalada.

• No se podían crear nuevas calibraciones comunes mediante un sensor en línea automatizado para varias
impresoras con la opción Printer Match en Fiery Color Profiler Suite.

Problemas solucionados en Fiery Command WorkStation Package 6.8.0.439

Fiery Command WorkStation

• No pudo guardar una entrada de catálogo de papel seleccionada para una trabajo en la ventana Definir papel para
hoja intercalada.

• En algunos sistemas en japonés, el número de copias de un trabajo de calibración era incorrecto.

Fiery XF

• En Job Editor, el tamaño de página que se mostraba en una trabajo PDF con marcas de corte era incorrecto.

Problemas solucionados en Fiery Command WorkStation Package 6.8.0.406

Fiery Command WorkStation

• No se puede calibrar un impresora con la opción Corrección automática de diferencia de colores.

• Al intentar eliminar un punto de curva después de modificar un trabajo procesado en ImageViewer > Ajuste de
colores, se eliminó la página seleccionada. La página se restauró si hizo clic en Revertir. Sin embargo, no podía
continuar con la edición sin reiniciar el proceso de edición.

Fiery XF

• No pudo guardar algunas opciones de impresión para soportes en Server Manager para impresoras VUTEk h5.

• Al seleccionar un Media Wedge en Job Editor > Verificar > Barras de control, el valor predefinido de tolerancias
de destino cambió a Personalizado.
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Problemas solucionados en Fiery Command WorkStation Package 6.8.0.385

Fiery XF

• Al dividir un trabajo en sectores, las áreas de pegado y superposición no se tuvieron en cuenta en el cálculo del
tamaño del trabajo de un pieza individual.

Problemas solucionados en Fiery Command WorkStation Package 6.8.0.366

Fiery Command WorkStation

• En Fiery Spot Pro, las indicaciones en gama y fuera de gama ∆E no eran uniformes para los colores planos,
incluso cuando se definió la tolerancia en el cuadro de diálogo Preferencias.

• Al definir un color de especialidad y volver a abrir Fiery Spot Pro, los valores de separación de color de
especialidad no se conservaron.

• No se podía definir la configuración de las portadas para una nueva carpeta de proceso al seleccionar una
plantilla Impose en Propiedades del trabajo.

Fiery XF

• En Color Tools, aparece un mensaje de error al intentar crear un archivo de linearización base para la impresora
Seiko M64s.

• En Color Tools, al seleccionar diferentes opciones de Papel de la lista y hacer clic en Imprimir durante la
recalibración, el tamaño del diagrama de colores se redujo de forma inesperada.

Problemas solucionados en Fiery Command WorkStation Package 6.8.0.333

Fiery Command WorkStation

• En Fiery ImageViewer, cuando se seleccionaba la opción de impresión Actual para una página siguiente mientras
la primera página de la trabajo estaba en la cola Impresión, aparecía un mensaje de error.

• Al utilizar diferentes entradas de Paper Catalog para definir el soporte del cuadernillo en Fiery Impose y el
soporte de la portada en Command WorkStation, la primera hoja del trabajo se imprimió con una configuración
de portada incorrecta. Sin embargo, el resto de las hojas se imprimió con la configuración del papel de
cuadernillo.

• No se podía especificar la unidad de medida en la opción Desplazamiento de imagen más allá de 0,29 milímetros
o su valor equivalente en pulgadas y puntos.

• En Command WorkStation con el idioma de visualización en alemán, no se podía volver a calibrar una conjunto
de calibración si el trabajo utilizaba alguna de las siguientes opciones:

• tamaño de papel personalizado

• tamaño de papel personalizado y APPE habilitados

Notas de la versión para el cliente
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Fiery XF

• Si intentó realizar la calibración desde Command WorkStation en macOS 13, (Color Tools > Crear calibración),
los controles del panel izquierdo no estaban visibles, por lo que la calibración no se podía utilizar.

• Al definir tamaño del papel personalizado en Job Editor > Formato > de impresora, los márgenes de hardware de
la impresora no se mostraban en la presentación preliminar de trabajo.

Problemas solucionados en Fiery Command WorkStation Package 6.8.0.277

Fiery Command WorkStation

• En macOS 13 con Command WorkStation y Fiery Hot Folders, al seleccionar Propiedades del trabajo > Diseño >
Impose > Editar plantilla de Impose, los cambios no se podían guardar porque la ventana se cerraba de forma
inesperada.

• En macOS 13, no se podía iniciar Fiery Software Manager desde Aplicaciones y recursos si Fiery Software
Manager ya se estaba ejecutando.

• En macOS 13, cuando se guardaba el informe de optimización de colores planos como un archivo HTML, los
logotipos de EFI y Fiery no aparecían si abrió el informe en Safari.

• Al guardar una plantilla de tamaño de terminación definida por el usuario con caracteres de doble byte en Fiery
Impose y aplicarla a un trabajo desde Propiedades del trabajo, se seleccionaban los valores definidos para el
tamaño de terminación Basado en cuadro de recorte en lugar de los valores de tamaño de terminación definidos
por el usuario.

• En Fiery Preview, la portada y las páginas de cuerpo mostraban la misma configuración de papel aunque hubiera
especificado ajustes diferentes de soportes para la portada y las páginas de cuerpo en Fiery Impose.

• Al hacer clic en la pestaña Papel en Propiedades del trabajo y desplazarse hasta Papeles mezclados, algunas
opciones de soportes no se mostraban para el trabajo.

Fiery XF

• Cuando se configuraba un dispositivo de terminación Zund en Server Manager y en Job Editor, el único método
de cortado disponible era DumDum.

• Al seleccionar la posición de código de barras Superior e inferior para una trabajo de varias páginas anidadas en
la pestaña Terminación, parte del código de barras de la parte inferior aparecía fuera del diseño de soportes y el
archivo no se imprimió.

Problemas solucionados en Fiery Command WorkStation Package 6.8.0.217

Fiery Command WorkStation

• Al hacer clic en Siguiente en la ventana Diseño de muestras durante la recalibración de un Fiery server, Fiery
Calibrator ha mostrado el mismo Diseño de muestras y no ha imprimido el diagrama de colores. Este problema
se producía al definir el Fiery server y el idioma de Fiery Command WorkStation como francés.

• En Fiery ImageViewer, al editar la curva en el panel Ajuste de colores para un trabajo monocromo e intentar
guardarla como un valor predefinido, ha aparecido un mensaje de error.
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Fiery XF

• Al eliminar un método de corte personalizado en la ventana Corte de contorno, se eliminaron todos los métodos
de corte personalizados de la lista.

• No se podía definir un método de corte personalizado cuando se seleccionaba una tabla de corte Esko.

• No se ha podido realizar la impresión sin bordes en las impresoras de la serie Canon PRO cuando ha definido un
tamaño de papel personalizado.

Problemas solucionados en Fiery Command WorkStation Package 6.8.0.184

Fiery Command WorkStation

• En Calibrator, una vez finalizada la recalibración, la opción Generar datos ACD tras la calibración aparecía
marcada en las impresoras compatibles.

Fiery XF

• Al crear una biblioteca de colores planos con Color Editor con conexión a un servidor de Fiery XF, los valores de
color no se guardaron. Además, si importó de nuevo la misma biblioteca, los valores de los colores planos
personalizados CMYKRB, CMYKOB y CMYKRV no se conservaron.

Problemas solucionados en Fiery Command WorkStation Package 6.8.0.165

Fiery Command WorkStation

• Al crear una calibración para un Fiery server para el que la opción ACD no estaba habilitada, Fiery Calibrator
todavía abría WebTools para la generación de datos ACD.

• Al crear una nueva carpeta de proceso de Fiery y seleccionar Definir para especificar la configuración del trabajo,
no se abrió la ventana Propiedades del trabajo.

• Se ha tardado más del tiempo habitual en Mostrar la presentación preliminar en el panel Vista de hojas de la
Presentación preliminar de Fiery para algunos trabajos PDF con imposición.

• En un equipo Windows, apareció un mensaje sobre la asistencia discontinuada en la ventana Demo de Fiery
Impose en lugar de la ventana Administrar opciones del Fiery.

• En Propiedades del trabajo > Acabado, para un trabajo de 1000 páginas, si se habilitaba la opción de impresión
Hoja intercalada por cada 100 copias, la hoja intercalada se insertaba antes de cada copia.

• Al intentar abrir Fiery Command WorkStation y conectarse a Fiery servers mientras el servidor de
actualizaciones EFI estaba fuera de línea, las colas de trabajos tardaban unos minutos en cargarse.

Fiery XF

• Al seleccionar el Valor predefinido de tolerancias de destino como Personalizado en Server Manager, el valor de
Formato Delta E aparecía como dE 2000 que era incorrecto. Sin embargo, en Job Editor el valor de Formato Delta
E se mostraba correctamente como dE CIE76.

Actualizaciones

El instalador actualizará cualquier Fiery Command WorkStation Package existente al último paquete que contenga
Fiery Command WorkStation y Fiery Hot Folders. Opcionalmente, puede instalar Fiery Remote Scan mediante Fiery
Software Manager.
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Para obtener más información acerca de las especificaciones técnicas, consulte www.efi.com/cws.

Requisitos de las actualizaciones del sistema

Versiones compatibles

Fiery Command WorkStation 6.8 es compatible con el software del sistema Fiery FS150/FS150 Pro y posterior
instalado en el Fiery server.
Fiery Command WorkStation es compatible con estos sistemas operativos en su ordenador:

• macOS 14

• macOS 1311

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11, 64 bits

• Windows 10, 64 bits

• Windows Server 2022, 64 bits

• Windows Server 2019, 64 bits

• Windows Server 2016, 64 bits

Nota: Fiery Command WorkStation ofrece compatibilidad con Rosetta para equipos macOS con el chip M1. Para
obtener más información, visite https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-
sur-compatibility/.

Problemas conocidos

macOS 13

Adobe Acrobat en macOS 13

Como Adobe todavía no ofrece compatibilidad completa para Adobe Acrobat en macOS 13, se producirán estos
problemas:

• No puede iniciar Adobe Acrobat desde macOS 13 en procesadores M1 y M2.

• En los procesadores Intel, Adobe Acrobat muestra la ventana de inicio de sesión aunque ya haya iniciado
sesión. Descarte la ventana de inicio de sesión; Acrobat funcionará con normalidad.

Calibración no disponible en el servidor Fiery XF

Si intentó realizar la calibración desde Command WorkStation en macOS 13, (Color Tools > Crear calibración),
los controles del panel izquierdo no estaban visibles, por lo que la calibración no se podía utilizar.
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macOS 10.15 y versiones posteriores

Acceso al disco completo

Debido a los cambios en la forma en que macOS 10.15 o posterior gestiona la seguridad, ahora se necesitan más
pasos para permitir que las aplicaciones de Fiery funcionen correctamente.
Es necesario realizar cambios en la función de seguridad de Acceso al disco completo en macOS para que las
aplicaciones Fiery administren las actualizaciones y los archivos de acceso, como las plantillas de Impose y las
carpetas de proceso. Habilite la opción Acceso al disco completo para las aplicaciones Fiery, como, por ejemplo,
Fiery Command WorkStation.

1 Cierre todas las aplicaciones Fiery.

2 Vaya a Preferencias del sistema > Seguridad y privacidad > Privacidad > Acceso completo al disco.

3 Haga clic en el icono de candado de la esquina inferior izquierda y escriba su contraseña.

4 En la lista de aplicaciones, seleccione la casilla junto a com.efi.InstallerHelperTool.

5 Haga clic en el botón +.

6 En la carpeta Aplicaciones, seleccione Fiery Software Manager y Fiery Software Uninstaller y haga clic en
Abrir.
Estas aplicaciones requieren acceso al disco completo para poder mantener y actualizar las aplicaciones Fiery
de su equipo.

7 En la carpeta Aplicaciones, seleccione la aplicación Fiery Command WorkStation y haga clic en Abrir.

8 Si utiliza Fiery Hot Folders o Fiery Remote Scan, seleccione cada aplicación y haga clic en Abrir.
Cuando Fiery Hot Folders detecta que se utilizan las carpetas Documentos, Escritorio y Descargas, envía un
mensaje en el que solicita el acceso completo al disco. Este mensaje se sigue mostrando después de que se
haya concedido el acceso. Puede descartar este mensaje y seguir trabajando.

Conversión de PS a PDF

Al utilizar macOS 10.14.5 y posterior con Fiery Impose, Fiery Compose o Fiery JobMaster, es posible que se le pida
que permita el acceso de Fiery Command WorkStation a Acrobat Distiller. Este permiso es necesario para la
conversión de archivos PS a PDF. Si no otorga este permiso, las conversiones no serán correctas y deberá cambiar la
función de seguridad de Automatización en macOS.

1 Cierre todas las aplicaciones Fiery.

2 Cierre Acrobat Distiller.

3 Ir a Preferencias del sistema > Seguridad y privacidad > Privacidad > Automatización.

4 Haga clic en el icono de candado de la esquina inferior izquierda y escriba su contraseña.

5 En la lista aplicaciones, busque Fiery Command WorkStation.app.

6 Seleccione la opción Acrobat Distiller.app.
Esto permite a Fiery Command WorkStation acceder a Acrobat Distiller.
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Configuración de las preferencias de Adobe Acrobat Distiller para la conversión de
PostScript a PDF

Fiery Impose, Fiery Compose y Fiery JobMaster requieren que Acrobat Distiller convierta los archivos PostScript
(PS) a PDF en un equipo cliente.
Debido a la configuración de seguridad mejorada de Acrobat Distiller, debe confirmar que el archivo PS que se va a
convertir tiene un origen fiable en: Adobe Acrobat Distiller > Archivo > Preferencias > Preferencias: Acrobat Distiller,
seleccione Confiar en todos los archivos abiertos a través de Acrobat Distiller en Seguridad.

Nota: Si no selecciona Confiar en todos los archivos abiertos a través de Acrobat Distiller, se le solicitará que
confirme que el archivo tiene un origen fiable para que todos los archivos PS se conviertan en PDF. También se aplica
a Hot Folders cuando el filtro de Microsoft Office está seleccionado, cuando el Tipo de archivo de salida se especifica
como PDF y se selecciona un archivo joboptions como Perfil de Distiller.

Spot Pro

Colores de especialidad

No se crean perfiles de los colores de especialidad y la función Aplicar a se limita solo a valores CMYK del
dispositivo.

Redondeo del valor de color plano

Después de definir un color plano y reiniciar Spot Pro, los valores de algunos colores pueden diferir ligeramente
de los valores originales que introdujo. Esto se debe a un redondeo numérico que Spot Pro realizó y no debe
haber ningún cambio visible en el color.

Modo de medición M3

El modo M3 no es compatible con dispositivos de medición individual.
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Notas de versão do cliente
Fiery Command WorkStation Package, versão 6.8

Este documento contém informações importantes sobre esta versão. Verifique se todos os usuários receberam essas
informações antes de realizar a instalação.

Sobre esta versão

Os aplicativos a seguir estão incluídos nesta versão:

• Fiery Command WorkStation Package v6.8.0.615

• Fiery Command WorkStation para Windows v6.8.0.54

• Fiery Command WorkStation para Mac v6.8.0.55

• Fiery Hot Folders v4.3.1.05

• Fiery Software Manager para Windows v6.8.0.11

• Fiery Software Manager para Mac v6.8.0.12

Novos recursos

O que há de novo?

Para obter informações sobre os novos recursos adicionados na versão inicial da 6.8, acesse http://
fiery.efi.com/CWS/Whats-New.

Visualizar efeitos de edição da curva de rasterização

Para todos os Fiery servers externos, ao usar propriedades de tarefa para aplicar uma edição de curva de
rasterização a uma tarefa, os resultados são exibidos no Fiery Preview do aplicativo para tarefas processadas.
Para Fiery servers incorporados, as edições de curva de rasterização de uma tarefa são exibidas no Fiery Preview
do aplicativo para tarefas processadas somente quando Fiery ColorRight Package ou Fiery Productivity Package
está ativado.

Relatório de otimização da cor especial

Em Fiery Spot Pro, agora é possível salvar o relatório de otimização de cor especial como um arquivo HTML.

http://fiery.efi.com/CWS/Whats-New
http://fiery.efi.com/CWS/Whats-New


Notificações de backup da Imagem do sistema Fiery

O backup da Imagem do sistema Fiery enviará uma notificação quando um backup falhar e estiver listado em
Notificações no Fiery Command WorkStation.

• Você pode reagendar o backup em Gerenciar configurações > Restauração do sistema Fiery.

• Para ocultar a notificação, clique no ícone Mais (três pontos) e selecione Ocultar.

Fechar botão da janela Novidades

A janela Novidades é exibida quando você instala e abre a versão mais recente da Fiery Command WorkStation
pela primeira vez. Agora você pode usar o botão Fechar na parte inferior da janela Novidades, mesmo se a
resolução de exibição for menor do que a resolução compatível.
Resoluções mínimas de exibição compatíveis:

• 1280 x 1024 (folha solta)

• 1600 x 900 (grandes e supergrandes)

Problemas corrigidos

Problemas corrigidos na Fiery Command WorkStation Package v6.8.0.615

Fiery Command WorkStation

• O Fiery Command WorkStation Package agora é compatível com fontes chinesas em conformidade com o
padrão GB18030.

Problemas corrigidos no Fiery Command WorkStation Package v6.8.0.541

Fiery Command WorkStation

• Ao mesclar dois arquivos PDF com a opção Mesclar todos os arquivos se enviados como uma pasta no Fiery Hot
Folders, o arquivo PDF de saída não aparecia conforme esperado.

• Ao selecionar a calibragem Cuchê-Brilhante ao calibrar um Fiery server, aparecia uma mensagem de erro de
incompatibilidade de gramatura de papel.

• Ao criar um documento mestre nas Propriedade da tarefa para uma tarefa VDP na fila Em espera e clicar em
Visualizar mestre, uma outra página em branco era adicionada.
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Problemas corrigidos no Fiery Command WorkStation Package v6.8.0.514

Fiery Command WorkStation

• Ao clicar na opção Recursos > Spot Pro de um Fiery server com um software de sistema FS200/200 Pro ou
FS300/300 Pro, a lista e os valores de cores especiais não eram exibidas.

Fiery XF

• Não era possível atualizar os perfis de mídia com o Fiery Profiles Updater ao atualizar um servidor Fiery XF da
v7.3 para a v7.3.3.

Problemas corrigidos no Fiery Command WorkStation Package v6.8.0.466

Fiery Command WorkStation

• Em um sistema em espanhol, não era possível excluir uma tarefa selecionada da fila em espera pressionando a
tecla Delete.

• A opção Publicar como impressora virtual aparecia na guia Predefinições de tarefa em um servidor Fiery
integrado no qual uma licença de impressora virtual não estava instalada.

• Não era possível criar uma nova calibragem comum usando um sensor automatizado em linha para várias
impressoras com a opção Printer Match no Fiery Color Profiler Suite.

Problemas corrigidos no Fiery Command WorkStation Package v6.8.0.439

Fiery Command WorkStation

• Não era possível salvar uma entrada selecionada do catálogo de papéis para uma tarefa na janela Definir mídia
para folha de separação.

• Em alguns sistemas em idioma japonês, o número de cópias de uma tarefa de calibração estava incorreto.

Fiery XF

• No Job Editor, o tamanho da página exibido para uma tarefa em PDF com marcas de corte estava incorreto.

Problemas corrigidos no Fiery Command WorkStation Package v6.8.0.406

Fiery Command WorkStation

• Não era possível calibrar uma impressora com a opção Correção automática de correspondência de cores.

• Ao tentar excluir um ponto de curva após modificar uma tarefa processada em ImageViewer > Ajuste de cores, a
página selecionada era excluída. A página era restaurada se você clicasse em Reverter. Não era possível continuar
com a edição sem reiniciar o processo de edição.
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Fiery XF

• Não era possível salvar algumas opções de impressão para mídia em Server Manager para impressoras VUTEk
h5.

• Ao selecionar qualquer cunha de mídia em Job Editor > Verificar > Barras de controle, a predefinição de
tolerância de destino era alterada para Personalizada.

Problemas corrigidos no Fiery Command WorkStation Package v6.8.0.385

Fiery XF

• Ao colocar uma tarefa em mosaico, as áreas de colagem e sobreposição não eram consideradas no cálculo do
tamanho da tarefa de uma mosaico individual.

Problemas corrigidos no Fiery Command WorkStation Package v6.8.0.366

Fiery Command WorkStation

• No Fiery Spot Pro, os indicadores ∆E de "dentro da gama de cores" e "fora da gama de cores" não eram
consistentes para cores especiais, mesmo quando a tolerância era definida na caixa de diálogo Preferências.

• Ao definir uma cor de especialidades e reabrir o Fiery Spot Pro, os valores de separação das cores de
especialidades não eram mantidos.

• Não era possível definir configurações de página de capa para uma nova pasta ativa ao selecionar um modelo do
Impose nas Propriedades da tarefa.

Fiery XF

• No Color Tools, uma mensagem de erro era exibida ao tentar criar um arquivo de linearização base para a
impressora Seiko M64s.

• No Color Tools, ao selecionar diferentes opções de Mídia na lista e clicar em Imprimir durante a recalibragem, a
dimensão da tabela de medidas era reduzida inesperadamente.

Problemas corrigidos no Fiery Command WorkStation Package v6.8.0.333

Fiery Command WorkStation

• No Fiery ImageViewer, ao selecionar a opção de impressão Atual para uma página subsequente enquanto a
primeira página da tarefa estava na fila de impressão, uma mensagem de erro era exibida.

• Ao usar entradas diferentes do catálogo de papéis para definir a mídia de livreto no Fiery Impose e a mídia de
página de capa na Command WorkStation, a primeira folha da tarefa era impressa com configurações incorretas
da página de capa. No entanto, o restante das folhas era impresso com as configurações da mídia de livreto.

• Não era possível especificar a unidade de medida na opção de deslocamento da imagem além de 0,29 milímetro
ou seu valor equivalente em polegadas e pontos.

• Na Command WorkStation com o idioma de exibição em alemão, não era possível recalibrar um conjunto de
calibragem se a tarefa usasse um dos seguintes procedimentos:

• tamanho de papel personalizado

• tamanho do papel personalizado e APPE ativados

Notas de versão do cliente
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Fiery XF

• Se você tentasse calibrar com a Command WorkStation no macOS 13, (Color Tools > Criar calibragem), os
controles do painel esquerdo não ficavam visíveis, portanto a calibragem não podia ser usada.

• Ao definir o tamanho da mídia personalizada em Job Editor > Impressora > Formato, as margens de hardware da
impressora não eram exibidas na visualização da tarefa.

Problemas corrigidos no Fiery Command WorkStation Package v6.8.0.277

Fiery Command WorkStation

• No macOS 13 com a Command WorkStation e o Fiery Hot Folders, ao selecionar Propriedades da tarefa >
Layout > Imposição > Editar modelo de imposição, as alterações não eram salvas porque a janela fechava
inesperadamente.

• No macOS 13, não era possível iniciar o Fiery Software Manager em Apps e Recursos se o Fiery Software
Manager já estivesse sendo executado.

• No macOS 13, ao salvar o relatório de otimização de cores especiais como um arquivo HTML, os logotipos EFI e
Fiery não estavam presentes se você abrisse o relatório no Safari.

• Ao salvar um modelo de tamanho de acabamento Definido pelo usuário com caracteres de byte duplo no Fiery
Impose e aplicá-lo a uma tarefa em Propriedades da tarefa, os valores definidos para tamanho de acabamento
Baseado na caixa de corte era selecionado em vez dos valores de tamanho de acabamento Definidos pelo usuário.

• No Fiery Preview, as páginas de capa e do corpo exibiam as mesmas configurações de mídia, mesmo se você
tivesse especificado configurações diferentes de mídia para as páginas de capa e do corpo no Fiery Impose.

• Ao clicar na guia Mídia em Propriedades da tarefa e rolar a tela para baixo até Mídia mista, algumas opções de
mídia não eram exibidas para a tarefa.

Fiery XF

• Ao configurar um dispositivo de acabamento da Zund em Server Manager e Job Editor, o único método de corte
disponível era DumDum.

• Ao selecionar a posição do código de barras Superior e inferior para uma tarefa de várias páginas encaixada na
guia Acabamento, parte do código de barras na parte inferior aparecia fora do layout da mídia e o arquivo não
era impresso.

Problemas corrigidos no Fiery Command WorkStation Package v6.8.0.217

Fiery Command WorkStation

• Ao clicar em Avançar na janela Layout da amostra durante a recalibragem de um Fiery server, o Fiery Calibrator
exibia o mesmo layout de amostra novamente e não imprimia a tabela de medidas. Este problema ocorria ao
definir o idioma do Fiery server e da Fiery Command WorkStation como francês.

• Em Fiery ImageViewer, ao editar a curva no painel Ajuste de cores para uma tarefa monocromática e tentar
salvá-la como uma predefinição, uma mensagem de erro era exibida.
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Fiery XF

• Ao excluir um método de corte personalizado na janela Corte de contorno, todos os métodos de corte
personalizados eram excluídos da lista.

• Não era possível definir um método de corte personalizado ao selecionar uma tabela de corte Esko.

• Não era possível executar uma impressão sem bordas em impressoras da série Canon PRO após definir um
tamanho de mídia personalizado.

Problemas corrigidos no Fiery Command WorkStation Package v6.8.0.184

Fiery Command WorkStation

• No Calibrator, após a conclusão da calibragem, a opção Gerar dados de ACD após a calibragem não estava
disponível para impressoras compatíveis.

Fiery XF

• Ao criar uma biblioteca de cores especiais usando o Color Editor conectado a um servidor Fiery XF, os valores de
cor não eram salvos. Além disso, se você importasse a mesma biblioteca novamente, os valores não eram
mantidos para cores especiais personalizadas CMYKRB, CMYKOB e CMYKRV.

Problemas corrigidos no Fiery Command WorkStation Package v6.8.0.165

Fiery Command WorkStation

• Ao criar uma calibragem para um Fiery server para o qual a opção ACD não estava ativada, o Fiery Calibrator
ainda abria o WebTools para a geração de dados do ACD.

• Ao criar um novo Fiery Hot Folder e selecionar Definir para especificar configurações da tarefa, a janela
Propriedade de tarefa não abria.

• Levava mais do que o tempo normal para exibir a visualização no painel Visualização da folha do Fiery Preview
para algumas tarefas de PDF impostas.

• Em um computador Windows, uma mensagem sobre o suporte descontinuado aparecia na janela Fiery Impose
Demo em vez da janela Gerenciar opções do Fiery.

• Em Propriedade da tarefa > Acabamento, para uma tarefa de 1000 páginas, se você ativasse a opção de impressão
Folha de separação para cada 100 cópias, a folha de separação era inserida antes de cada cópia.

• Ao tentar abrir o Fiery Command WorkStation e conectar-se ao Fiery servers enquanto o servidor de
atualizações da EFI estava off-line, as filas de tarefa levavam alguns minutos para serem carregadas.

Fiery XF

• Ao selecionar a Predefinição de tolerância de destino como Personalizada no Server Manager, o valor do formato
Delta E aparecia como dE 2000, o que estava incorreto. No entanto, no Job Editor o valor do formato Delta E era
exibido corretamente como dE CIE76.

Upgrade

Esse instalador fará o upgrade de qualquer Fiery Command WorkStation Package existente para o pacote mais
recente contendo a Fiery Command WorkStation e o Fiery Hot Folders. Opcionalmente, você pode instalar o Fiery
Remote Scan usando o Fiery Software Manager.
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Para obter mais informações sobre as especificações técnicas, consulte www.efi.com/cws.

Atualizações nos requisitos do sistema

Versões compatíveis

A Fiery Command WorkStation versão 6.8 é compatível com o software de sistema Fiery FS150/FS150 Pro e
posterior instalado no Fiery server.
A Fiery Command WorkStation é compatível com estes sistemas operacionais em seu computador:

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11, 64 bits

• Windows 10, 64 bits

• Windows Server 2022, 64 bits

• Windows Server 2019 (64 bits)

• Windows Server 2016 (64 bits)

Nota: A Fiery Command WorkStation oferece suporte à Rosetta para computadores macOS com o chip M1. Para
obter mais informações, acesse https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-
sur-compatibility/.

Problemas conhecidos

macOS 13

Adobe Acrobat no macOS 13

Como a Adobe ainda não oferece suporte total ao Adobe Acrobat no macOS 13, você poderá enfrentar estes
problemas:

• Não é possível iniciar o Adobe Acrobat com os processadores M1 e M2 do macOS 13.

• Nos processadores Intel, o Adobe Acrobat mostra a janela de logon, mesmo que você já tenha feito login.
Ignore a janela de logon e o Acrobat funcionará normalmente.

A calibragem não está disponível no servidor Fiery XF

Se você tentou calibrar com a Command WorkStation no macOS 13, (Color Tools > Criar calibragem), os
controles do painel esquerdo não eram visíveis, portanto a calibragem não podia ser usada.

Notas de versão do cliente
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macOS 10.15 e posterior

Acesso total ao disco

Devido a alterações no modo como o macOS 10.15 ou posterior gerencia a segurança, agora há etapas adicionais
necessárias para permitir que os aplicativos do Fiery funcionem corretamente.
Você precisa fazer alterações no recurso de segurança Acesso total ao disco no MacOS para que os aplicativos
do Fiery gerenciem atualizações e acessem arquivos, como modelos do Impose e Hot Folders. Ative o Acesso
total ao disco para abrir aplicativos do Fiery como o Fiery Command WorkStation.

1 Feche todos os aplicativos do Fiery.

2 Acesse Preferências do sistema > Segurança e privacidade > Privacidade > Acess total ao disco.

3 Clique no ícone do cadeado no canto inferior esquerdo e digite sua senha.

4 Na lista de aplicativos, marque a caixa de seleção ao lado de com.efi.InstallerHelperTool.

5 Clique no botão +.

6 Na pasta Aplicativos, selecione Fiery Software Manager e o Fiery Software Uninstaller e clique em Abrir.
Esses aplicativos exigem acesso total ao disco para manter e atualizar os aplicativos do Fiery no seu
computador.

7 Na pasta Aplicativos, selecione o aplicativo Fiery Command WorkStation e clique em Abrir.

8 Se você usar o Fiery Hot Folders ou Fiery Remote Scan, selecione cada aplicativo e clique em Abrir.
Quando o Fiery Hot Folders detecta que as pastas Documentos, Desktop e Downloads estão sendo usadas,
ele envia uma mensagem solicitando acesso total ao disco. Essa mensagem é exibida mesmo após o acesso ter
sido concedido. Você pode descartar essa mensagem e continuar trabalhando.

Conversão de PS em PDF

Quando você usa o macOS 10.14.5 e posterior com o Fiery Impose, Fiery Compose ou Fiery JobMaster você pode
precisar permitir que a Fiery Command WorkStation tenha acesso ao Acrobat Distiller. Esta permissão é necessária
para a conversão de arquivos PS para PDF. Se você não conceder permissão, as conversões não serão bem sucedidas
e você precisará alterar o recurso de segurança de automação no macOS.

1 Feche todos os aplicativos do Fiery.

2 Feche o Acrobat Distiller.

3 Vá para Preferências do sistema > Segurança e privacidade > Privacidade > Automação.

4 Clique no ícone do cadeado no canto inferior esquerdo e digite sua senha.

5 Na lista de Aplicativos, localize Fiery Command WorkStation.app.

6 Selecione a opção Acrobat Distiller.app.
Isso permite que o Fiery Command WorkStation tenha acesso ao Acrobat Distiller.
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Configuração de preferências no Adobe Acrobat Distiller para PostScript para conversão
em PDF

O Fiery Impose, Fiery Compose e Fiery JobMaster exigem que o Acrobat Distiller converta arquivos PostScript (PS)
em PDF em um computador cliente.
Devido às configurações de segurança aprimoradas no Acrobat Distiller, você deve confirmar que o arquivo PS que
será convertido é proveniente de uma fonte confiável em: Acrobat Distiller. > Arquivo > Preferências > Preferências -
Acrobat Distiller, selecione a opção Confiar em todos os arquivos abertos pelo Acrobat Distiller em Segurança.

Nota: Se a opção Confiar em todos os arquivos abertos pelo Acrobat Distiller não estiver selecionada, você deve
confirmar que o arquivo é de uma fonte confiável para todo arquivo PS que deve ser convertido em PDF. Isso
também se aplica a Hot Folders quando o filtro do Microsoft Office estiver selecionado, o Tipo de arquivo de Saída
estiver especificado como PDF e um arquivo joboptions for selecionado como um Perfil do Distiller.

Spot Pro

Cores de especialidades

As cores de especialidade não têm o perfil determinado e o recurso Aplicar a é limitado somente aos valores
CMYK do dispositivo.

Arredondamento de valor de cor especial

Após definir uma cor especial e reiniciar Spot Pro, os valores para algumas cores podem ser ligeiramente
diferentes dos valores originais inseridos. Isso ocorre devido ao arredondamento numérico que o Spot Pro fez, e
não deve haver nenhuma mudança visível perceptível na cor.

Modo de medição M3

O modo M3 não é compatível com dispositivos de medição única.

Notas de versão do cliente
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Versienotities voor de klant
Fiery Command WorkStation Package, versie 6.8

Dit document bevat belangrijke informatie over deze release. Zorg dat deze informatie bij alle gebruikers bekend is
voordat u doorgaat met de installatie.

Over deze release

Deze release bestaat uit de volgende toepassingen:

• Fiery Command WorkStation Package v6.8.0.615

• Fiery Command WorkStation voor Windows v6.8.0.54

• Fiery Command WorkStation voor Mac v6.8.0.55

• Fiery Hot Folders v4.3.1.05

• Fiery Software Manager voor Windows v6.8.0.11

• Fiery Software Manager voor Mac v6.8.0.12

Nieuwe functies

Wat is nieuw?

Voor informatie over nieuwe functies die zijn toegevoegd in de eerste release van versie 6.8, gaat u naar http://
fiery.efi.com/CWS/Whats-New.

Voorbeeld weergeven van rastercurvebewerkingseffecten

Wanneer u voor alle externe Fiery servers Taakeigenschappen gebruikt om een rastercurvebewerking op een
taak toe te passen, worden de resultaten weergegeven in de Fiery Preview-toepassing voor verwerkte taken.
Voor ingesloten Fiery servers worden rastercurvebewerkingen op een taak alleen weergegeven in de Fiery
Preview-toepassing voor verwerkte taken wanneer het Fiery ColorRight Package of Fiery Productivity Package is
ingeschakeld.

Optimalisatierapport voor steunkleuren

In Fiery Spot Pro kunt u het optimalisatierapport voor steunkleuren nu opslaan als een HTML-bestand.

http://fiery.efi.com/CWS/Whats-New
http://fiery.efi.com/CWS/Whats-New


Meldingen van Fiery-systeemkopie-back-up

U ontvangt een melding wanneer een back-up van de Fiery-systeemkopie mislukt. Deze wordt weergegeven
onder Meldingen in Fiery Command WorkStation.

• U kunt de back-up opnieuw plannen in Instellingen beheren > Fiery-systeem herstellen.

• Als u de melding wilt verbergen, klikt u op het pictogram Meer (drie puntjes) en selecteert u Verbergen.

Knop Sluiten voor het venster Wat is er nieuw?

Het venster Wat is er nieuw? verschijnt wanneer u de nieuwste versie van Fiery Command WorkStation
installeert en voor het eerst opent. U kunt nu de knop Sluiten onder aan het venster Wat is er nieuw? gebruiken,
zelfs als de beeldschermresolutie lager is dan de ondersteunde resolutie.
Minimaal ondersteunde beeldschermresoluties:

• 1280 x 1024 (cut-sheet)

• 1600 x 900 (groot- en supergrootformaat)

Opgeloste problemen

Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.615

Fiery Command WorkStation

• Fiery Command WorkStation Package ondersteunt nu Chinese lettertypen die voldoen aan de GB18030-
standaard.

Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.541

Fiery Command WorkStation

• Wanneer u twee PDF-bestanden samenvoegde met de optie Alle bestanden samenvoegen indien ingediend als
map in Fiery Hot Folders, werd het PDF-uitvoerbestand niet zoals verwacht weergegeven.

• Wanneer u de kalibratie gecoat-glanzend selecteerde tijdens het kalibreren van een Fiery server, werd een
foutbericht voor een verkeerd papiergewicht weergegeven.

• Wanneer u een masterdocument maakte in Taakeigenschappen voor een VDP-taak in de wachtrij Geblokkeerd
en op Voorbeeldweergave master klikte, werd er een extra blanco pagina toegevoegd.
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Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.514

Fiery Command WorkStation

• Wanneer u op Hulpbronnen > Spot Pro voor een Fiery server met systeemsoftware FS200/200 Pro of FS300/300
Pro klikte, werden de lijst met steunkleuren en steunkleurwaarden niet weergegeven.

Fiery XF

• U kon de mediaprofielen niet bijwerken met de Updatefunctie voor Fiery-profielen bij het upgraden van een
Fiery XF-server van v7.3 naar v7.3.3.

Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.466

Fiery Command WorkStation

• Op een Spaanstalig systeem kon u een geselecteerd taak niet verwijderen uit de blokkeringswachtrij door op de
Delete-toets te drukken.

• De optie Publiceren als virtuele printer werd weergegeven in het tabblad Taakvoorkeuzen voor een interne Fiery-
server waarop geen virtuele printerlicentie was geïnstalleerd.

• U kon geen nieuwe gemeenschappelijke kalibratie maken met een geautomatiseerde inlinesensor voor meerdere
printers met de optie Printer Match in Fiery Color Profiler Suite.

Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.439

Fiery Command WorkStation

• U kon een geselecteerde papiercatalogusvermelding niet opslaan voor een taak in het venster Media definiëren
voor Achtervel.

• Op sommige Japanstalige systemen was het aantal exemplaren van een kalibratietaak onjuist.

Fiery XF

• In Job Editor was het paginaformaat dat werd weergegeven voor een PDF-taak met snijmarkeringen onjuist.

Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.406

Fiery Command WorkStation

• U kon geen printer kalibreren met de optie Automatische correctie van verkeerde kleurcombinatie.

• Wanneer u probeerde een curvepunt te verwijderen nadat u een verwerkte taak had gewijzigd in ImageViewer >
Kleurafstelling, werd de geselecteerde pagina verwijderd. De pagina werd teruggezet als u op Herstellen klikte. U
kon echter niet doorgaan met de bewerking zonder het bewerkingsproces opnieuw te starten.

Fiery XF

• U kon bepaalde afdrukopties voor media niet opslaan in Server Manager voor VUTEk h5-printers.

• Wanneer u een mediawig selecteerde in Job Editor > Verifiëren > Bedieningsbalken, veranderde de voorkeuze
voor doeltoleranties in Aangepast.
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Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.385

Fiery XF

• Wanneer u een taak naast een andere taak plaatste, werden de lijm en overlappende gebieden niet in aanmerking
genomen bij de berekening van het taakformaat voor een afzonderlijke tegel.

Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.366

Fiery Command WorkStation

• In de Fiery Spot Pro waren de in-gamma en out-of-gamma ∆E-indicaties niet consistent voor steunkleuren, zelfs
wanneer u de tolerantie definieerde in het dialoogvenster Voorkeuren.

• Wanneer u een speciale kleur definieerde en Fiery Spot Pro opnieuw opende, werden de scheidingswaarden van
de speciale kleur niet behouden.

• U kon geen omslaginstellingen voor een nieuwe overdrachtmap definiëren wanneer u een Impose-sjabloon in
Taakeigenschappen selecteerde.

Fiery XF

• In Color Tools werd een foutbericht weergegeven wanneer u probeerde een basislinearisatiebestand te maken
voor de Seiko M64s-printer.

• Wanneer u in Color Tools verschillende Media-opties in de lijst selecteerde en op Afdrukken klikte tijdens de
herkalibratie, werden de afmetingen van de meetgrafiek onverwacht kleiner.

Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.333

Fiery Command WorkStation

• Wanneer u in Fiery ImageViewer de Huidig-afdrukoptie voor een volgende pagina selecteerde terwijl de eerste
pagina van de taak in de afdrukwachtrij stond, werd een foutbericht weergegeven.

• Wanneer u verschillende papiercatalogusvermeldingen gebruikte om de boekje-media in Fiery Impose en de
omslagpagina-media in Command WorkStation te definiëren, werd het eerste vel van het taak afgedrukt met
onjuiste omslagpagina-instellingen. De overige vellen werden echter afgedrukt met de instellingen voor boekje-
media.

• U kon de maateenheid in de beeldverschuivingsoptie boven de 0,29 millimeter of de equivalente waarde daarvan
in inches en punten niet opgeven.

• In Command WorkStation, met Duits als schermtaal, was het niet mogelijk een kalibratieset opnieuw te
kalibreren als de taak gebruikmaakte van een van de volgende opties:

• aangepast papierformaat

• aangepast papierformaat en APPE ingeschakeld
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Fiery XF

• Als u probeerde te kalibreren vanuit Command WorkStation op macOS 13 (Color Tools > Kalibratie maken),
waren de bedieningselementen van het linkerpaneel niet zichtbaar, waardoor kalibratie niet kon worden
gebruikt.

• Wanneer u aangepast mediaformaat definieerde in Job Editor > Printer > Indeling, werden de
printerhardwaremarges niet weergegeven in het taakvoorbeeld.

Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.277

Fiery Command WorkStation

• Wanneer u op macOS 13 met Command WorkStation en Fiery Hot Folders Taakeigenschappen > Opmaak >
Impose > Impose-sjabloon bewerken selecteerde, konden de wijzigingen niet worden opgeslagen omdat het
venster onverwacht werd afgesloten.

• Op macOS 13 kon u Fiery Software Manager niet starten vanuit Toepassingen en hulpbronnen als Fiery Software
Manager al werd uitgevoerd.

• Bij het opslaan van het steunkleur-optimalisatierapport als een HTML-bestand op macOS 13, waren de EFI- en
Fiery-logo's niet aanwezig als u het rapport in Safari opende.

• Wanneer u een Door gebruiker gedefinieerd afwerkformaatsjabloon met double-byte tekens in Fiery Impose had
opgeslagen en deze toepaste op een taak vanuit Taakeigenschappen, werden de waarden gedefinieerd voor het
afwerkformaat Op basis van bijsnijkader geselecteerd, in plaats van de Door gebruiker gedefinieerde
afwerkformaatwaarden.

• In Fiery Preview werden dezelfde media-instellingen weergegeven voor de omslag- en binnenpagina's, zelfs als u
verschillende media-instellingen voor omslag- en binnenpagina's had opgegeven in Fiery Impose.

• Wanneer u op het tabblad Media in Taakeigenschappen klikte en naar Gemengde media bladerde, werden
sommige mediaopties niet weergegeven voor de taak.

Fiery XF

• Wanneer u een Zund-afwerkeenheid in Server Manager en Job Editor instelde, was de enige beschikbare
snijmethode DumDum.

• Wanneer u de streepjescodepositie Boven en Onder selecteerde voor een geneste taak met meerdere pagina's in
het tabblad Afwerking, werd een deel van de streepjescode aan de onderkant buiten de mediaopmaak
weergegeven en werd het bestand niet afgedrukt.

Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.217

Fiery Command WorkStation

• Wanneer u tijdens het opnieuw kalibreren van een Fiery server op Volgende klikte in het venster Opmaak
kleurvlak, gaf Fiery Calibrator dezelfde Opmaak kleurvlak opnieuw weer en werd de metingengrafiek niet
afgedrukt. Dit probleem trad op wanneer u de taal van de Fiery server en Fiery Command WorkStation instelde
op Frans.

• Bij het bewerken van de curve in het deelvenster Kleuraanpassing in Fiery ImageViewer voor een monochrome
taak waarbij u probeerde deze als een voorkeuze op te slaan, werd een foutbericht weergegeven.
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Fiery XF

• Wanneer u een aangepaste snijmethode in het venster Contoursnijden verwijderde, werden alle aangepaste
snijmethoden uit de lijst verwijderd.

• U kon geen aangepaste snijmethode definiëren wanneer u een Esko-snijtafel selecteerde.

• U kon geen randloos afdrukken uitvoeren voor printers uit de Canon PRO-serie wanneer u een aangepast
mediaformaat definieerde.

Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.184

Fiery Command WorkStation

• In Calibrator was na voltooiing van de herkalibratie de optie ACD-gegevens genereren na kalibratie aangevinkt
voor ondersteunde printers.

Fiery XF

• Wanneer u een steunkleurbibliotheek maakte met Color Editor die is verbonden met een Fiery XF-server, werden
de kleurwaarden niet opgeslagen. Bovendien werden de waarden niet behouden voor aangepaste CMYKRB-,
CMYKOB- en CMYKRV-steunkleuren wanneer u dezelfde bibliotheek opnieuw importeerde.

Opgeloste problemen in Fiery Command WorkStation Package v6.8.0.165

Fiery Command WorkStation

• Wanneer u een kalibratie maakte voor een Fiery server waarvoor de ACD-optie niet was ingeschakeld, opende
Fiery Calibrator WebTools nog steeds voor het genereren van ACD-gegevens.

• Wanneer u een nieuwe Fiery Hot Folder maakte en Definiëren selecteerde om taakinstellingen op te geven, werd
het venster Taakeigenschappen niet geopend.

• Het duurde bij bepaalde ingeslagen PDF-taken langer dan normaal om het voorbeeld in het deelvenster
Velweergave van Fiery-voorbeeld weer te geven.

• Op een Windows-computer verscheen een bericht over beëindigde ondersteuning in het venster Fiery Impose
demo in plaats van het venster Fiery-opties beheren.

• Toen u bij een afdruktaak van 1000 pagina's onder Taakeigenschappen > Afwerking de afdrukoptie Achtervel
voor elke 100 exemplaren had ingeschakeld, werd het achtervel vóór elk afzonderlijk exemplaar ingevoegd.

• Wanneer u Fiery Command WorkStation probeerde te openen en verbinding met Fiery servers wilde maken
terwijl de EFI-updateserver offline was, duurde het enkele minuten voordat de taakwachtrijen waren geladen.

Fiery XF

• Wanneer u bij Voorkeuze voor doeltoleranties Aangepast selecteerde in Server Manager, werd de waarde voor
het Delta E-formaat weergegeven als dE 2000, wat onjuist was. In Job Editor werd de waarde voor het Delta E-
formaat echter correct weergegeven als dE CIE76.

Bezig met upgraden

Dit installatieprogramma zal een bestaand Fiery Command WorkStation Package upgraden naar het meest recente
pakket met Fiery Command WorkStation en Fiery Hot Folders. U kunt Fiery Remote Scan ook installeren met
behulp van Fiery Software Manager.
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Ga voor meer informatie over de technische specificaties naar www.efi.com/cws.

Bijgewerkte systeemvereisten

Ondersteunde versies

Fiery Command WorkStation versie 6.8 ondersteunt Fiery-systeemsoftware FS150/FS150 Pro en hoger geïnstalleerd
op de Fiery server.
Fiery Command WorkStation ondersteunt de volgende besturingssystemen voor uw computer:

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11, 64-bits

• Windows 10, 64-bits

• Windows Server 2022, 64-bits

• Windows Server 2019, 64-bits

• Windows Server 2016, 64-bits

Opmerking: Fiery Command WorkStation biedt Rosetta-ondersteuning voor macOS-computers met de M1-chip.
Ga voor meer informatie naar https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-
sur-compatibility/.

Bekende problemen

macOS 13

Adobe Acrobat op macOS 13

Omdat Adobe nog geen volledige ondersteuning voor Adobe Acrobat op macOS 13 biedt, zult u de volgende
problemen ondervinden:

• U kunt Adobe Acrobat niet starten vanuit macOS 13 op M1- en M2-processors.

• Op Intel-processors geeft Adobe Acrobat het aanmeldvenster weer, zelfs als u al bent aangemeld. Sluit het
aanmeldvenster en Acrobat werkt normaal.

Kalibratie niet beschikbaar op Fiery XF-server

Als u probeert te kalibreren vanuit Command WorkStation op macOS 13 (Color Tools > Kalibratie maken), zijn
de bedieningselementen van het linkerpaneel niet zichtbaar, waardoor kalibratie niet kan worden gebruikt.
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macOS 10.15 en hoger

Volledige schijftoegang

Als gevolg van wijzigingen in de manier waarop macOS 10.15 of hoger de beveiliging beheert, zijn er nu extra
stappen nodig om Fiery-toepassingen goed te laten werken.
U moet wijzigingen aanbrengen in de beveiligingsfunctie Volledige schijftoegang in macOS, zodat Fiery-
toepassingen updates kunnen beheren en toegang hebben tot bestanden zoals Impose-sjablonen en
overdrachtmappen. Volledige schijftoegang inschakelen voor Fiery-toepassingen zoals Fiery Command
WorkStation.

1 Sluit alle Fiery-toepassingen.

2 Ga naar Systeemvoorkeuren > Beveiliging & privacy > Privacy > Volledige schijftoegang.

3 Klik op het slotje linksonder in de hoek en voer uw wachtwoord in.

4 Schakel in de lijst met apps het selectievakje naast com.efi.InstallerHelperTool in.

5 Klik op de +-knop.

6 Selecteer Fiery Software Manager en de Fiery Software Uninstaller in de map Toepassingen en klik
vervolgens op Openen.
Voor deze toepassingen hebt u volledige schijftoegang nodig om Fiery-toepassingen op uw computer te
kunnen onderhouden en bijwerken.

7 Selecteer de Fiery Command WorkStation-toepassing in de map Toepassingen en klik op Openen.

8 Als u Fiery Hot Folders of Fiery Remote Scan gebruikt, selecteert u elke toepassing en klikt u op Openen.
Wanneer Fiery Hot Folders detecteert dat de mappen Documenten, Bureaublad en Downloads in gebruik
zijn, wordt er een bericht weergegeven waarin volledige schijftoegang wordt gevraagd. Zelfs nadat toegang is
verleend, wordt dit bericht nog steeds weergegeven. U kunt dit bericht negeren en doorgaan met werken.

Conversie van PS naar PDF

Wanneer u macOS 10.14.5 en hoger met Fiery Impose, Fiery Compose of Fiery JobMaster gebruikt, wordt u mogelijk
gevraagd om Fiery Command WorkStation toegang te verlenen tot Acrobat Distiller. Deze toestemming is nodig
voor de conversie van PS-bestanden naar PDF. Als u geen toestemming verleent, zijn de conversies niet succesvol en
moet u de beveiligingsfunctie Automation in macOS wijzigen.

1 Sluit alle Fiery-toepassingen.

2 Sluit Acrobat Distiller.

3 Ga naar Systeemvoorkeuren > Beveiliging en privacy > Privacy > Automation.

4 Klik op het slotje linksonder in de hoek en voer uw wachtwoord in.

5 Zoek Fiery Command WorkStation.app in de Apps-lijst.

6 Selecteer de optie Acrobat Distiller.app.
Dit geeft Fiery Command WorkStation toegang tot Acrobat Distiller.
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Voorkeuren instellen in Adobe Acrobat Distiller voor conversie van PostScript naar PDF

Fiery Impose, Fiery Compose en Fiery JobMaster vereisen dat Acrobat Distiller PostScript-bestanden (PS-
bestanden) naar PDF converteert op een clientcomputer.
Vanwege verbeterde beveiligingsinstellingen in Acrobat Distiller moet u bevestigen dat het te converteren PS-
bestand afkomstig is van een betrouwbare bron in: Acrobat Distiller > Bestand > Voorkeuren > Voorkeuren - Acrobat
Distiller, selecteer Alle bestanden vertrouwen die via Acrobat Distiller zijn geopend onder Beveiliging.

Opmerking: Als Alle bestanden vertrouwen die via Acrobat Distiller zijn geopend niet is geselecteerd, wordt u
gevraagd te bevestigen dat het bestand afkomstig is van een betrouwbare bron voor alle naar PDF te converteren PS-
bestanden. Dit geldt ook voor Overdrachtsmappen wanneer het filter voor Microsoft Office is geselecteerd, het
Uitvoerbestandstype is opgegeven als PDF en een joboptions-bestand wordt geselecteerd als Distiller-profiel.

Spot Pro

Speciale kleuren

Speciale kleuren worden niet geprofileerd en de functie Toepassen op is beperkt tot alleen CMYK-waarden voor
het apparaat.

Afronding steunkleurwaarde

Nadat u een steunkleur hebt gedefinieerd en Spot Pro opnieuw hebt gestart, kunnen de waarden voor bepaalde
kleuren enigszins afwijken van de oorspronkelijke waarden die u hebt ingevoerd. Dit komt door de numerieke
afronding die Spot Pro heeft uitgevoerd, maar er mag geen zichtbare kleurverandering zijn.

Meetmodus M3

De modus M3 wordt niet ondersteund voor apparaten die één meting uitvoeren.
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客户发布说明
Fiery Command WorkStation Package，版本 6.8

本文档包含有关此版本的重要信息。请确保为所有用户提供这些信息，然后再继续安装。

关于此版本

此版本包含以下应用：

• Fiery Command WorkStation Package v6.8.0.615

• 适用于 Windows 的 Fiery Command WorkStation v6.8.0.54

• 适用于 Mac 的 Fiery Command WorkStation v6.8.0.55

• Fiery Hot Folders v4.3.1.05

• Fiery Software Manager 适用于 Windows 的 v6.8.0.11

• 适用于 Mac 的 Fiery Software Manager v6.8.0.12

新功能

新功能

有关在 6.8 初始版本中新增功能的信息，请访问 http://fiery.efi.com/CWS/Whats-New。

预览光栅曲线编辑效果

对于所有外部 Fiery servers，当您使用作业属性在作业上应用光栅曲线编辑时，已处理作业的结果会显
示在 Fiery Preview 应用程序中。

对于嵌入式 Fiery servers，只有在当 Fiery ColorRight Package 或 Fiery Productivity Package 启
用时，已处理作业的光栅曲线编辑才会显示在 Fiery Preview 应用程序中。

专色优化报告

您现在可在 Fiery Spot Pro 中将专色优化报告保存为 HTML 文件。

http://fiery.efi.com/CWS/Whats-New


Fiery 系统镜像备份通知

当 Fiery 系统镜像备份失败时将通知您，并在 Fiery Command WorkStation 中的通知下列出。

• 您可以在管理设定 > Fiery 系统还原中重新安排备份。

• 要隐藏通知，请单击“更多”图标（三个点），然后选择隐藏。

新功能窗口的“关闭”按钮

首次安装并打开最新版本的 Fiery Command WorkStation 时，将显示新功能窗口。即使显示分辨率小于受
支持的分辨率，您现在也可以使用新功能窗口底部的关闭按钮。

受支持的最小显示分辨率：

• 1280 x 1024（单页纸）

• 1600 x 900（宽幅和超宽幅）

已修复的问题

Fiery Command WorkStation Package v6.8.0.615 版本中修复的错误

Fiery Command WorkStation

• Fiery Command WorkStation Package 现在支持符合 GB18030 标准的中文字体。

修复了 Fiery Command WorkStation Packagev6.8.0.541 版本中的错误

Fiery Command WorkStation

• 使用 Fiery Hot Folders 中的如果以同一文件夹进行提交，则合并所有文件选项合并两个 PDF 文件时，输
出 PDF 文件的显示效果会不如预期。

• 如果在校准 Fiery server 时选择铜版纸 - 光滑校准，将出现纸张重量不匹配错误消息。

• 在作业属性中为保留队列中的 VDP 作业创建主文页文档并单击 预览主文页时，会添加额外的空白页。
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修复了 Fiery Command WorkStation Packagev6.8.0.514 版本中的错误

Fiery Command WorkStation

• 当针对安装有系统软件 FS200/200 Pro 或 FS300/300 Pro 的 Fiery server 单击资源 > Spot Pro时，不
会显示专色列表和专色值。

Fiery XF

• 将 Fiery XF 服务器从 v7.3 升级到 v7.3.3 后，无法使用 Fiery 特性档更新程序更新纸张特性档。

修复了 Fiery Command WorkStation Packagev6.8.0.466 版本中的错误

Fiery Command WorkStation

• 在西班牙语系统上，无法通过按删除键从保留队列中删除所选的作业。

• 针对未安装虚拟打印机许可证的 Fiery 嵌入式服务器，作为虚拟打印机发布选项会出现在作业预设标签
中。

• 您无法使用适用于多个打印机的自动内联传感器与 Fiery Color Profiler Suite 中的打印机匹配选项创建
新的常用校准。

修复了 Fiery Command WorkStation Packagev6.8.0.439 版本中的错误

Fiery Command WorkStation

• 您无法在定义分隔纸的纸张窗口中保存作业的所选纸张目录条目。

• 在某些日语系统中，校准作业的份数不正确。

Fiery XF

• 在 Job Editor 中，显示的有关带有剪切标记的 PDF 作业的页面大小不正确。

修复了 Fiery Command WorkStation Packagev6.8.0.406 版本中的错误

Fiery Command WorkStation

• 无法使用自动纠正颜色不匹配选项校准打印机。

• 在 ImageViewer > 颜色调整 中修改已处理的作业后，如果试图删除曲线点，所选页面会被删除。如果单击
恢复，页面将还原。但是，如果不重新启动编辑过程，则无法继续编辑。

Fiery XF

• 无法在 VUTEk h5 打印机的 Server Manager 中保存某些用于承印材料的打印选项。

• 在 Job Editor > 验证 > 控制栏中选择任意介质楔入时，目标公差预设会更改为自定义。
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修复了 Fiery Command WorkStation Package v6.8.0.385 版本中的错误

Fiery XF

• 平铺作业时，在计算单个图素的作业大小时不会考虑粘合和重叠区域。

修复了 Fiery Command WorkStation Packagev6.8.0.366 版本中的错误

Fiery Command WorkStation

• 在 Fiery Spot Pro 中，即使您在预置对话框中定义了公差，专色的色域内和超出色域 ∆E 指示并不一致。

• 定义专用颜色并重新打开 Fiery Spot Pro 时，不会保留专用颜色分色值。

• 在作业属性中选择 Impose 模板时，无法为新的热文件夹定义封页设定。

Fiery XF

• 在 Color Tools 中，当您尝试创建 Seiko M64s 打印机的基本线性化文件时，会显示一条错误消息。

• 在 Color Tools 中，当您从列表中选择不同的纸张选项，并在重新校准期间单击打印 时，测量表尺寸会意
外缩小。

Fiery Command WorkStation Package v6.8.0.333 中修复的错误

Fiery Command WorkStation

• 在 Fiery ImageViewer 中，当作业第一页在打印队列中时为后续页面选择了当前打印选项，则会出现一条
错误消息。

• 当使用不同的纸张目录条目定义 Fiery Impose 中的小册子纸张和 Command WorkStation 中的封页纸张
时，作业的第一印张会使用不正确的封页设定打印。然而，其余印张均使用小册子纸张设定打印。

• 无法在图像偏移选项中指定超过 0.29 毫米或其同等值（以英寸和点为单位）的测量单位。

• 当 Command WorkStation 显示语言为德语时，且作业使用以下选项之一，则无法重新校准校准集：

• 自定义纸张大小

• 自定义纸张大小且 APPE 已启用

Fiery XF

• 如果尝试在 macOS 13 上的 Command WorkStation 中进行校准（Color Tools > 创建校准），左面板控件
不可见，因此无法使用校准。

• 当在 Job Editor > 打印机 > 格式中定义自定义纸张大小时，打印机硬件边距不会显示在作业预览中。
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Fiery Command WorkStation Package v6.8.0.277 修复了以下错误

Fiery Command WorkStation

• 在 macOS 13 上使用 Command WorkStation 和 Fiery Hot Folders，当您选择作业属性 > 版面 > Impose
> 编辑 Impose 模板时，更改无法保存，因为窗口意外关闭。

• 在 macOS 13 上，如果 Fiery Software Manager 在运行中，则无法从应用程序和资源启动 Fiery
Software Manager。

• 在 macOS 13 上，当您将专色优化报告保存为 HTML 文件并在 Safari 中打开报告时，EFI 和 Fiery 徽标
不会显示。

• 当您在 Fiery Impose 中保存带有双字节字符的用户定义输出处理大小模板，并在作业属性中将其应用到作
业时，会选定基于裁切框的输出处理大小定义值，而不是用户定义输出处理大小值。

• 即使已在 Fiery Impose 中为封面和正文页指定了不同的纸张设定，Fiery Preview 中的封面和正文页仍显
示相同的纸张设定。

• 单击作业属性中的纸张标签并向下滚动到混合纸张时，作业的某些纸张选项没有显示。

Fiery XF

• 在 Server Manager 和 Job Editor 中设置 Zund 输出处理设备时，唯一可用的裁切方法是 DumDum。

• 在输出处理标签中选择拼版多页作业的顶部和底部条形码位置时，底部的部分条形码显示在纸张版面之外，
且文件无法打印。

Fiery Command WorkStation Package v6.8.0.217 修复了以下错误

Fiery Command WorkStation

• 在重新校准 Fiery server 期间单击色块布局窗口中的下一个后，Fiery Calibrator 会再次显示相同的色
块布局，且不会打印测量图表。在将 Fiery server 和 Fiery Command WorkStation 的语言切换为法语后
会出现此问题。

• 在 Fiery ImageViewer 中，当在颜色调整窗格中编辑单色作业的曲线并尝试将其另存为预设时，会出现一
条错误消息。

Fiery XF

• 在轮廓裁切窗口中删除某个自定义裁切方法时，所有自定义裁切方法都被从列表中删除。

• 当您选择 Esko 裁切表时，无法定义自定义裁切方法。

• 在对自定义纸张大小进行定义后，无法在 Canon PRO 系列打印机上执行无边框打印操作。

客户发布说明
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Fiery Command WorkStation Package v6.8.0.184 修复了以下错误

Fiery Command WorkStation

• 在 Calibrator 中完成重新校准后，对于受支持的打印机，会选中在校准后生成 ACD 数据选项。

Fiery XF

• 使用连接到 Fiery XF 服务器的 Color Editor 创建专色库后，没有保存颜色值。此外在您再次导入同一个
库时，CMYKRB、CMYKOB 和 CMYKRV 自定义专色的颜色值也没有保留。

修复了 Fiery Command WorkStation Packagev6.8.0.165 版本中的错误

Fiery Command WorkStation

• 当您为未启用 ACD 选项的 Fiery server 创建校准时，Fiery Calibrator 仍会为 ACD 数据生成打开
WebTools 。

• 当您创建新的 Fiery Hot Folder 并选择定义以指定作业设定时，作业属性窗口不会打开。

• 对于一些拼版 PDF 作业，在 Fiery Preview 的印张视图窗格中显示预览的时间比平时多。

• 在 Windows 计算机上，一条关于停止支持的消息将出现在 Fiery Impose 演示窗口中，而不是管理 Fiery
选件窗口中。

• 在作业属性 > 输出处理中，对于一个 1000 页的作业，如果您为每 100 份副本启用分隔纸打印选项，则分
隔纸将在每份副本之前插入。

• 当您尝试在 EFI 更新服务器脱机时打开 Fiery Command WorkStation 和连接 Fiery servers 时，作业队
列需要几分钟来加载。

Fiery XF

• 当您在 Server Manager 中将目标公差预设选为自定义时，Delta E 格式值显示为 dE 2000，这是不正确
的。但是，在 Job Editor 中，Delta E 格式值正确显示为 dE CIE76。

正在升级

此安装程序将任何现有 Fiery Command WorkStation Package 升级至包含 Fiery Command WorkStation 和
Fiery Hot Folders 的最新软件包。您也可以选择使用 Fiery Software Manager 安装 Fiery Remote Scan。

有关技术规格方面的更多信息，请参见 www.efi.com/cws。

系统要求更新呢

支持的版本

Fiery Command WorkStation 6.8 版本支持 Fiery server 上安装的 Fiery 系统软件 FS150/FS150 Pro 及更
高版本。

客户发布说明
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Fiery Command WorkStation 支持以下计算机操作系统：

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11，64 位

• Windows 10，64 位

• Windows Server 2022，64 位

• Windows Server 2019，64 位

• Windows Server 2016，64 位

注释：Fiery Command WorkStation 为使用 M1 芯片的 macOS 计算机提供 Rosetta 支持。有关更多信息，请
访问 https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-sur-
compatibility/。

已知问题

macOS 13

macOS 13 上的 Adobe Acrobat

由于 Adobe 尚未为 macOS 13 上的 Adobe Acrobat 提供完整支持，您将遇到以下问题：

• 您无法在运行 M1 和 M2 处理器的 macOS 13 上启动 Adobe Acrobat。

• 使用 Intel 处理器时，即使您已经登录，Adobe Acrobat 还是会显示登录窗口。关闭登录窗口，即可
正常使用 Acrobat。

Fiery XF 服务器上校准不可用

如果您尝试在 macOS 13 上的 Command WorkStation 中进行校准（Color Tools > 创建校准），左面板控
件不可见，因此无法使用校准。

macOS 10.15 及更高版本

完全磁盘访问权限

由于 macOS 10.15 及更高版本的安全管理方式改变，现在还需要额外的步骤才能让 Fiery 应用程序正常
运行。
您需要更改 macOS 中的完全磁盘访问权限安全功能，Fiery 应用程序才能够管理更新和访问文件，如
Impose 模板和热文件夹。为 Fiery Command WorkStation 等 Fiery 应用程序启用完全磁盘访问权限。

客户发布说明
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1 关闭所有 Fiery 应用程序。

2 转至系统偏好设置 > 安全性与隐私 > 隐私 > 完全磁盘访问权限。

3 单击左下角的“按锁”图标并输入密码。

4 在应用程序列表中，选择 com.efi.InstallerHelperTool 旁边的复选框。

5 单击 + 按钮。

6 在应用程序文件夹中，选择 Fiery Software Manager 和 Fiery Software Uninstaller 并单击打开。

这些应用程序需要完全磁盘访问权限才能维护并更新计算机上的 Fiery 应用程序。

7 在应用程序文件夹中，选择 Fiery Command WorkStation 应用程序并单击打开。

8 如果您还使用 Fiery Hot Folders 或 Fiery Remote Scan，选择每个应用程序并单击打开。

当 Fiery Hot Folders 检测到“文稿”、“桌面”和“下载”文件夹正在使用时，会发出消息请求获
得完全磁盘访问权限。授予访问权限后，此消息仍会继续显示。您可以关闭此消息并继续工作。

PS 到 PDF 转换

当您使用 macOS 10.14.5 及更高版本上使用 Fiery Impose、Fiery Compose 或 Fiery JobMaster 时，可能会
提示您允许 Fiery Command WorkStation 访问 Acrobat Distiller。此权限是 PS 文件转换为 PDF 所必需
的。如果不授予权限，转换将不会成功，您需要更改 macOS 中的自动化安全功能。

1 关闭所有 Fiery 应用程序。

2 关闭 Acrobat Distiller。

3 转至 系统偏好设置 > 安全与隐私 > 隐私 > 自动化.

4 单击左下角的“锁定”图标并输入密码。

5 在“应用”列表中，找到 Fiery Command WorkStation.app。

6 选择 Acrobat Distiller.app 选项。
这允许 Fiery Command WorkStation 访问 Acrobat Distiller。

在 Adobe Acrobat Distiller 中设置 PDF 转换的 PostScript 首选项

Fiery Impose、Fiery Compose 和 Fiery JobMaster 要求 Acrobat Distiller 将 PostScript (PS) 文件转换
为客户端计算机上的 PDF。

由于 Acrobat Distiller 中增强的安全设定，您必须确认要转换的 PS 文件来自以下可信来源： Acrobat
Distiller > 文件 > 首选项 > 首选项 - Acrobat Distiller，请在安全下选择信任所有通过 Acrobat
Distiller 打开的文件。

注释：如果不选择信任所有通过 Acrobat Distiller 打开的文件，系统会提示您确认每个要转换为 PDF 的 PS
文件来自可信来源。选择 Microsoft Office 筛选器，输出文件类型指定为 PDF 并选择 joboptions 文件作为
Distiller 特性档时，这也适用于 Hot Folders。

Spot Pro
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专用颜色

专用颜色没有创建特性档，且应用到功能仅限于设备 CMYK 值。

专色值四舍五入

定义专色和重新启动 Spot Pro 之后，某些颜色的值可能与输入的原始值略有不同。这是因为 Spot Pro
执行了数字四舍五入，但颜色不应该有明显的变化。

M3 测量模式

单测量设备不支持 M3 模式。

客户发布说明
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使用上の注意
Fiery Command WorkStation Package、バージョン 6.8

本書には、このリリースに関する重要な情報が記載されています。インストールを進める前に、すべてのユー
ザーにこの情報を伝えるようにしてください。

今回のリリースについて
今回のリリースには、次のアプリケーションが含まれています。

• Fiery Command WorkStation Package v6.8.0.615

• Windows v6.8.0.54 用 Fiery Command WorkStation

• Mac v6.8.0.55 用 Fiery Command WorkStation

• Fiery Hot Folders v4.3.1.05

• Windows 用 Fiery Software Manager v6.8.0.11

• Mac v6.8.0.12 用 Fiery Software Manager

新機能

新機能

6.8 バージョンの初期リリースに追加された新しい機能の詳細については、http://fiery.efi.com/CWS/Whats-New
を参照してください。

ラスター曲線編集効果のプレビュー

すべての外部 Fiery servers では、ジョブのプロパティを使用してジョブにラスター曲線編集を適用すると、
結果が Fiery Preview アプリケーションの処理済みジョブに表示されます。

埋め込み Fiery servers のときのジョブに対するラスター曲線編集は、Fiery ColorRight Package または Fiery
Productivity Package が有効になっている場合にのみ、Fiery Preview アプリケーションの処理済みジョブに
表示されます。

スポットカラー最適化レポート

Fiery Spot Pro で、スポットカラー最適化レポートを HTML ファイルで保存できるようになりました。

http://fiery.efi.com/CWS/Whats-New


Fiery システムイメージ のバックアップ通知

Fiery システムイメージイメージのバックアップに失敗した場合は通知が送信され、Fiery Command
WorkStation Fiery Command WorkStation の通知に一覧表示されます。

• バックアップのスケジュールは 設定を管理 > Fiery システム 復元で設定できます。

• 通知を非表示にするには、詳細アイコン（3 つのドット）をクリックし、 隠すを選択します。

新着情報ウィンドウの閉じるボタン

Fiery Command WorkStation の最新バージョンをインストールした後に初めて開くと、新着情報ウィンドウ
が表示されます。サポートされている解像度より小さい場合でも、新着情報ウィンドウの下部にある閉じ
るボタンを使用できるようになりました。

サポートされている最小表示解像度:

• 1280 x 1024（カット紙）

• 1600 x 900（ワイドおよびスーパーワイド）

修正された問題

Fiery Command WorkStation Package v6.8.0.615 で修正される問題

Fiery Command WorkStation

• Fiery Command WorkStation Package では、GB18030 標準に準拠した中国語フォントに対応できるようにな
りました。

Fiery Command WorkStation Package v6.8.0.541 で修正される問題

Fiery Command WorkStation

• Fiery Hot Folders で 2 つの PDF ファイルを フォルダーの場合全ファイルをマージするのオプションを使用
してマージすると、出力される PDF ファイルが期待どおりに表示されませんでした。

• Fiery server をキャリブレーションするときに コート紙：グロスを選択すると、坪量ミスマッチのエラーメ
ッセージが表示されていました。

• 待機キューにある VDP ジョブのジョブプロパティでマスタードキュメントを作成してマスターをプレビ
ューをクリックすると、余分なブランクページが追加されていました。

使用上の注意
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Fiery Command WorkStation Package v6.8.0.514 で修正される問題

Fiery Command WorkStation

• システムソフトウェア FS200/200 Pro または FS300/300 Pro を搭載した Fiery server で、リソース > Spot Pro
をクリックした場合に、スポットカラーリストとスポットカラーの値が表示されていませんでした。

Fiery XF

• Fiery XF サーバーを v7.3 から v7.3.3 にアップグレードすると、Fiery プロファイルアップデーターでメデ
ィアプロファイルをアップデートできませんでした。

Fiery Command WorkStation Package v6.8.0.466 で修正される問題

Fiery Command WorkStation

• スペイン語のシステムでは、 待機キューで選択したジョブを Delete キーを押しても削除できませんでし
た。

• 仮想プリンターのライセンスがインストールされていない Fiery 組み込みサーバーのジョブプリセットタ
ブに、仮想プリンターとして公開のオプションが表示されていました。

• Fiery Color Profiler Suite のプリンターマッチオプションで、複数のプリンター用の自動インラインセンサー
を使用して新規の共通キャリブレーションを作成することができませんでした。

Fiery Command WorkStation Package v6.8.0.439 で修正される問題

Fiery Command WorkStation

• スリップシートの用紙定義ウィンドウで、ジョブに選択した用紙カタログエントリを保存できませんでし
た。

• 日本語システムのいくつかで、キャリブレーションジョブの部数が正しくないものがありました。

Fiery XF

• Job Editor でカットマーク付き PDF ジョブのページサイズ表示が正しくありませんでした。

Fiery Command WorkStation Package v6.8.0.406 で修正される問題

Fiery Command WorkStation

• 自動カラーミスマッチ補正のオプションでプリンターをキャリブレートできませんでした。

• ImageViewer > Color Adjust で処理したジョブを修正した後に曲線ポイントを削除しようとすると、選択
したページが削除されていました。そのページを復元するには、復帰をクリックしていました。ただし、
編集を続けるには編集処理を再起動しなければなりませんでした。

Fiery XF

• VUTEk h5 プリンターの Server Manager で用紙のプリントオプションが一部保存できませんでした。

• Job Editor > 検証 > コントロールバーで任意のメディアウェッジを選択すると、ターゲット許容範囲のプ
リセットがカスタムに変更されていました。

使用上の注意
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Fiery Command WorkStation Package v6.8.0.385 で修正される問題

Fiery XF

• ジョブのタイリングで個々のタイルのジョブサイズを計算する際に、のりしろや重なる部分が考慮されて
いませんでした。

Fiery Command WorkStation Package v6.8.0.366 で修正される問題

Fiery Command WorkStation

• Fiery Spot Pro では、環境設定ダイアログボックスで許容値を定義しても、スポットカラーの色域内と色域
外の∆E 表示が一貫していませんでした。

• 特殊カラーを定義して再度 Fiery Spot Pro を開くと、特殊カラーの分解値が維持されていませんでした。

• ジョブプロパティで面付けテンプレートを選択すると、新規ホットフォルダーの表紙ページ設定を定義で
きませんでした。

Fiery XF

• Color Tools で Seiko M64s プリンターのベースリニアリゼーションファイルを作成しようとすると、エラ
ーメッセージが表示されていました。

• Color Tools で、リストから異なるメディアオプションを選択してキャリブレーション中に印刷をクリック
すると、測定チャートのサイズが予定外に小さくなっていました。

Fiery Command WorkStation Package v6.8.0.333 で修正される問題

Fiery Command WorkStation

• Fiery ImageViewer で、ジョブの最初のページが印刷キューにあるときに後続ページで表示中のページ/フォ
ームの印刷オプションを選択すると、エラーメッセージが表示されていました。

• ブックレット用紙を Fiery Impose で、カバーページ用紙を Command WorkStation でそれぞれ異なる用紙カ
タログエントリで定義すると、ジョブの最初のシートのカバーページ設定が誤って印刷されていました。
ただし、これ以外のシートはブックレット用紙の設定で印刷できていました。

• 画像シフトオプションでは、0.29 ミリメートル（またはこれに相当するインチおよびポイント）より大き
い数値を指定できませんでした。

• Command WorkStation で表示言語がドイツ語のとき、かつジョブが次のいずれかである場合、キャリブレ
ーションセットを再実行できませんでした。

• カスタム用紙サイズ

• カスタム用紙サイズで APPE が有効になっている

Fiery XF

• macOS 13 で Command WorkStation からキャリブレーションを実施しようとすると（Color Tools > キャリブ
レーション作成）左側のパネルコントロールが表示されていなかったため、キャリブレーションを実施で
きませんでした。

• Job Editor > プリンター > フォーマットでカスタム用紙サイズを定義すると、ジョブプレビューにプリン
ターのハードウェアマージンが表示されていませんでした。

使用上の注意
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Fiery Command WorkStation Package v6.8.0.277 で修正される問題

Fiery Command WorkStation

• Command WorkStation と Fiery Hot Folders 搭載の macOS 13 でジョブのプロパティ > レイアウト > 面付け >
面付けテンプレートを編集を選択すると、ウィンドウが突然閉じてしまい、変更内容が保存されませんで
した。

• macOS 13 で Fiery Software Manager がすでに起動している場合、アプリおよびリソースから Fiery Software
Manager を起動することができませんでした。

• macOS 13 でスポットカラー最適化レポートを HTML ファイルで保存し、これを Safari で開くと EFI およ
び Fiery のロゴが表示されませんでした。

• Fiery Impose でユーザー定義の仕上げサイズテンプレートを全角文字で保存し、これをジョブのプロパテ
ィから任意のジョブに適用すると、ユーザー定義の仕上げサイズ値ではなく、クロップボックスに合わせ
るの仕上げサイズに定義した値が選択されていました。

• Fiery Impose で表紙と本文に異なる印刷メディア設定を指定しても、Fiery Preview では表紙と本文のメディ
ア設定が同じであると表示されていました。

• ジョブのプロパティの用紙タブをクリックし、用紙種類の混合までスクロールしたときに、そのジョブに
対する用紙オプションが一部表示されませんでした。

Fiery XF

• Server Manager と Job Editor で仕上げデバイスを Zund に設定したときに使用できるカット方法は
DumDum のみでした。

• 仕上げタブ内でネストした複数ページジョブに対し、バーコード位置を上部と下部にすると、下のバーコ
ードの一部が用紙レイアウト外に配置され、ファイルが印刷されませんでした。

Fiery Command WorkStation Package v6.8.0.217 で修正される問題

Fiery Command WorkStation

• Fiery server のキャリブレーション中にパッチレイアウトウィンドウで次へをクリックすると、Fiery
Calibrator が同じパッチレイアウトを再度表示し、測定チャートが印刷されませんでした。この問題は、
Fiery server と Fiery Command WorkStation の言語をフランス語に設定すると発生していました。

• Fiery ImageViewer で、モノクロジョブのときにカラー調整ウィンドウで曲線を編集し、それをプリセット
として保存しようとすると、エラーメッセージが表示されていました。

Fiery XF

• 輪郭カットウィンドウでカスタムカット方法を削除すると、すべてのカスタムカット方法がリストから削
除されていました。

• Esko カッティングテーブルを選択すると、カスタムカット方法を定義できませんでした。

• キヤノン PRO シリーズプリンターでカスタム用紙サイズを定義すると、フチなし印刷を実行できませんで
した。

使用上の注意
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Fiery Command WorkStation Package v6.8.0.184 で修正された問題

Fiery Command WorkStation

• Calibrator で再キャリブレーションが完了した後に、サポートされているプリンターではキャリブレーシ
ョン後にカラーホーミングデータを作成しますにチェック印が入っていました。

Fiery XF

• Fiery XF サーバーに接続されている Color Editor を使用してスポットカラーライブラリを作成すると、カ
ラー値が保存されていませんでした。また、同じライブラリを再度インポートした場合にも CMYKRB、
CMYKOB、および CMYKRV の各カスタムスポットカラーの値が保存されていませんでした。

Fiery Command WorkStation Package v6.8.0.165 で修正した問題

Fiery Command WorkStation

• ACD オプションが有効になっていない Fiery server にキャリブレーションを実施すると、Fiery Calibrator が
ACD データ生成用の WebTools を開いていました。

• 新しい Fiery Hot Folder を作成し、定義 」を選択してジョブ設定を指定すると、ジョブのプロパティウィン
ドウが開きませんでした。

• Fiery Preview のシート表示ウィンドウで、プレビューを表示するのに通常よりも時間がかかる面付け PDF
ジョブがありました。

• Windows コンピューターで、Fiery オプション管理ウィンドウではなく、Fiery Impose デモウィンドウにサ
ポート終了についてのメッセージが表示されていました。

• ジョブのプロパティ > 仕上げで 1000 ページのジョブのときに、スリップシート印刷オプションを 100 部
ごとに有効にした場合、スリップシートが 1 部ごとに挿入されていました。

• EFI アップデートサーバーがオフラインのときに、Fiery Command WorkStation を開いて Fiery servers に接
続しようとすると、ジョブキューがロードするのに数分かかっていました。

Fiery XF

• Server Manager で、カスタムとしてターゲット許容範囲のプリセットを選択すると、デルタ E フォーマッ
トの値が誤って dE 2000 として表示されていましたが Job Editor のデルタ E フォーマット値は dE CIE76
として正しく表示されていました。

アップグレード
このインストーラーは、既存の Fiery Command WorkStation Package を Fiery Command WorkStation および Fiery
Hot Folders を含む最新のパッケージにアップグレードします。オプションで、Fiery Software Manager を使用し
て Fiery Remote Scan をインストールすることもできます。

技術仕様の詳細は、www.efi.com/cws を参照してください。

使用上の注意
Fiery Command WorkStation Package、バージョン 6.8
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システム 要件のアップデート

対応バージョン

Fiery Command WorkStation バージョン 6.8 は、Fiery server にインストールされている Fiery システムソフトウ
ェア FS150/FS150 Pro 以降をサポートしています。

Fiery Command WorkStation は、以下のオペレーティングシステムをサポートしています。

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11（64 ビット）

• Windows 10（64 ビット）

• Windows Server 2022（64 ビット）

• Windows Server 2019（64 ビット）

• Windows Server 2016（64 ビット）

メモ：Fiery Command WorkStation は M1 チップを搭載した macOS コンピューターの Rosetta サポートを提供し
ています。詳細は https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-sur-compatibility/
を参照してください。

既知の問題

macOS 13

macOS 13 での Adobe Acrobat

macOS 13 では Adobe Acrobat が完全にサポートされていないため、次のような問題が発生します。

• M1 および M2 プロセッサーの macOS 13 で Adobe Acrobat を起動することはできません。

• Intel のプロセッサーでは、すでにサインインしている場合でも、Adobe Acrobat にサインインするウィ
ンドウが表示されます。サインインのウィンドウを閉じてください。Acrobat は正常に機能します。

Fiery XF サーバーでキャリブレーションが実施できない

macOS 13 の Command WorkStation からキャリブレーションを実施しようとすると（Color Tools > キャリ
ブレーション作成）左側のパネルコントロールが表示されないため、キャリブレーションを実施できませ
ん。

使用上の注意
Fiery Command WorkStation Package、バージョン 6.8
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macOS 10.15 以降

フルディスクアクセス

macOS 10.15 以降のセキュリティ管理が変更されたため、Fiery アプリケーションが正しく機能するには、
現在は追加の手順を実行する必要があります。
Fiery アプリケーションでアップデートの管理、Impose テンプレートやホットフォルダーなどのファイル
にアクセスできるように、macOS でフルディスクアクセスセキュリティ機能を変更する必要があります。
Fiery Command WorkStation などの Fiery アプリケーションで、フルディスクアクセスを有効にします。

1 Fiery アプリケーションをすべて終了します。

2 システム 環境設定 > セキュリティとプライバシー > プライバシー > フルディスクアクセスに移動しま
す。

3 左下隅のロックアイコンをクリックし、パスワードを入力します。

4 アプリケーションリストで、 com.efi.InstallerHelperToolの横にあるチェックボックスを選択します。

5 +ボタンをクリックします。

6 アプリケーションフォルダーで、Fiery Software Manager および Fiery Software Uninstaller を選択してか
ら、開くをクリックします。

これらのアプリケーションでは、コンピューター上で Fiery アプリケーションを維持し、アップデート
するために、フルディスクアクセスが必要です。

7 アプリケーションフォルダーで、Fiery Command WorkStation アプリケーションを選択して、開くをク
リックします。

8 Fiery Hot Folders または Fiery Remote Scan を使用する場合は、各アプリケーションを選択し、開くをク
リックします。

Fiery Hot Folders が、書類、デスクトップ、ダウンロードフォルダーが使用されていることを検出する
と、フルディスクアクセスを要求するメッセージが表示されます。このメッセージは、アクセスが許
可された後も表示されたままになります。このメッセージを無視して作業を続行できます。

PS から PDF に変換

Fiery Impose、Fiery Compose または Fiery JobMaster と一緒に macOS 10.14.5 以降を使用している場合、Fiery
Command WorkStation の Acrobat Distiller へのアクセスを許可するように求められることがあります。この権
限は、PS ファイルを PDF に変換するために必要です。アクセス許可を付与しないと、正常に変換されず、
macOS の自動化セキュリティ機能を変更する必要があります。

1 Fiery アプリケーションをすべて終了します。

2 Acrobat Distiller を終了します。

3 システム環境設定 セキュリティ&プライバシー > プライバシー > 自動化 > に移動します。

4 左下隅のロックアイコンをクリックし、パスワードを入力します。

5 アプリリストで Fiery Command WorkStation.app を探します。

6 Acrobat Distiller.app オプションを選択します。
この操作により、Fiery Command WorkStation は Acrobat Distiller にアクセスできます。

使用上の注意
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PostScript を PDF に変換するための Adobe Acrobat Distiller の環境設定

Fiery Impose、Fiery Compose、Fiery JobMaster で PostScript（PS）ファイルを PDF に変換するには、クライアン
トコンピューター上に Acrobat Distiller が必要です。

Acrobat Distiller のセキュリティ設定が強化されているため、次のような信頼性のあるソースからの PS ファイ
ルの変換が行われていることを確認する必要があります。 Acrobat Distiller > ファイル > 環境設定 > 環境設定
– Acrobat Distiller セキュリティで Acrobat Distiller 経由で開かれたすべてのファイルを信頼するを選択しま
す。

メモ：Acrobat Distiller 経由で開かれたすべてのファイルを信頼するが選択されていない場合は、PDF に変換
するすべての PS ファイルが、信頼できるソースからのファイルであることを確認するよう促すメッセージが
表示されます。これは、 Microsoft Officeフィルターが選択されていて、出力ファイルの種類が PDF として指
定され、joboptions ファイルが Distiller プロファイルとして選択されている場合には、Hot Folders にも適用さ
れます。

Spot Pro

特殊カラー

特殊カラーはプロファイリングされず、 適用先機能はデバイスの CMYK 値にしか使用できません。

スポットカラー値の概数

スポットカラーを定義して Spot Pro 再起動すると、一部カラーの値が入力した元の値と若干異なることが
あります。これは、Spot Pro が入力した数値を概数にしたことによりますが、目で見てわかるようなカラ
ーの違いはありません。

Ｍ 3 測定モード

M3 モードは、単一測定デバイスではサポートされていません。

使用上の注意
Fiery Command WorkStation Package、バージョン 6.8
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고객 릴리스 정보
Fiery Command WorkStation Package, 버전 6.8

본 문서에는 이번 릴리스에 관한 중요 정보가 포함되어 있습니다. 설치를 계속하기 전에 이 정보를 모든 사용
자에게 제공하십시오.

본 릴리스에 대한 정보

이 릴리스에 포함되어 있는 어플리케이션은 다음과 같습니다.

• Fiery Command WorkStation Package v6.8.0.615

• Fiery Command WorkStation Windows v6.8.0.54용

• Fiery Command WorkStation Mac v6.8.0.55용

• Fiery Hot Folders v4.3.1.05

• Windows용 Fiery Software Manager v6.8.0.11

• Mac v6.8.0.12용 Fiery Software Manager

새로운 기능

새로운 기능

버전 6.8의 초기 릴리스에서 추가된 새로운 기능에 대한 자세한 내용은 http://fiery.efi.com/CWS/Whats-
New를 참조하십시오.

래스터 곡선 편집 효과 미리 보기

모든 외부 Fiery servers에서 작업 속성을 사용하여 작업에 래스터 곡선 편집을 적용하는 경우 결과는
처리된 작업의 Fiery Preview 응용 프로그램에 표시됩니다.

내장 Fiery servers의 경우, Fiery ColorRight Package 또는 Fiery Productivity Package가 활성화되
어 있으면 작업의 래스터 곡선 편집 내용이 처리된 작업의 Fiery Preview 응용 프로그램에 표시됩니다.

별색 최적화 보고서

이제 Fiery Spot Pro에서 별색 최적화 보고서를 HTML 파일로 저장할 수 있습니다.

http://fiery.efi.com/CWS/Whats-New
http://fiery.efi.com/CWS/Whats-New


Fiery System 이미지 백업 알림

백업이 실패하고Fiery Command WorkStation 의알림 에 표시될 경우 Fiery System 이미지 백업이 알
려줍니다.

• 설정 관리 > Fiery 시스템 복원에서 백업을 다시 예약할 수 있습니다.

• 알림을 숨기려면 더 보기 아이콘(3개의 점)을 클릭하고 숨기기를 선택합니다.

새로운 내용 창 닫기 버튼

최신 버전의 Fiery Command WorkStation을 처음 설치하고 열면 새로운 내용 창이 나타납니다. 이제 디
스플레이 해상도가 지원되는 해상도보다 낮으면 새로운 내용 창 맨 아래의 닫기 버튼을 사용할 수 있습니
다.

지원되는 최소 디스플레이 해상도:

• 1280 x 1024(컷 시트)

• 1600 x 900(광폭 및 초광폭)

해결된 문제

Fiery Command WorkStation Package v6.8.0.615에서 해결된 문제

Fiery Command WorkStation

• Fiery Command WorkStation Package는 이제 GB18030 표준을 준수하는 중국어 글꼴을 지원합니다.

Fiery Command WorkStation Package v6.8.0.541에서 문제 해결

Fiery Command WorkStation

• Fiery Hot Folders에서 폴더로 제출하는 경우 모든 파일 병합 옵션으로 두 개의 PDF 파일을 병합하면 출
력 PDF 파일이 예상대로 나타나지 않습니다.

• Fiery server을(를) 보정하는 동안 코팅지 - 광택 보정을 선택하면 종이 무게 불일치 오류 메시지가 나타
납니다.

• 보류 대기열에서 VDP 작업에 대한 작업 속성에서 마스터 문서를 생성하고 미리 보기 마스터를 클릭하면
빈 페이지가 추가됩니다.

고객 릴리스 정보
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Fiery Command WorkStation Package v6.8.0.514에서 문제 해결

Fiery Command WorkStation

• 시스템 소프트웨어 FS200 /200 Pro 또는 FS300/300 Pro가 있는 Fiery server에 대해 리소스 > Spot
Pro을 클릭하면 별색 목록과 별색 값이 표시되지 않았습니다.

Fiery XF

• Fiery XF 서버를 v7.3에서 v7.3.3으로 업그레이드할 때 Fiery 프로필 업데이터로 매체 프로필을 업데이
트할 수 없습니다.

Fiery Command WorkStation Package v6.8.0.466에서 문제 해결

Fiery Command WorkStation

• 스페인어 시스템에서는 Delete 키를 눌러 보류 대기열에서 선택한 작업을 삭제할 수 없습니다.

• 가상 프린터 라이선스가 설치되지 않은 Fiery 내장형 서버의 작업 프리셋 탭에 가상 프린터로 게시 옵션
이 나타납니다.

• Fiery Color Profiler Suite에 있는 프린터 일치 옵션이 있는 여러 프린터에 대해 자동화된 인라인 센서를
사용하여 새 공통 보정을 생성할 수 없었습니다.

Fiery Command WorkStation Package v6.8.0.439에서 문제 해결

Fiery Command WorkStation

• 간지용 용지 정의 창에서 작업에 대해 선택한 용지 카탈로그 항목을 저장할 수 없습니다.

• 일부 일본어 시스템에서 보정 작업의 사본 수가 올바르지 않았습니다.

Fiery XF

• 작업 편집기에서 절단 표시가 있는 PDF 작업에 대해 표시되는 페이지 크기가 잘못되었습니다.

Fiery Command WorkStation Package v6.8.0.406에서 문제 해결

Fiery Command WorkStation

• 자동 색상 보정 불일치 옵션으로는 프린터를 보정할 수 없습니다.

• ImageViewer > 색상 조정에서 처리된 작업을 수정한 후 곡선 지점 삭제를 시도하면 선택한 페이지가 삭
제됩니다. 되돌리기를 클릭하면 페이지가 복원되었습니다. 그러나 편집 프로세스 다시 시작하지 않고는
편집 작업을 계속할 수 없었습니다.

Fiery XF

• VUTEk h5 프린터의 Server Manager에서 용지에 대한 일부 인쇄 옵션을 저장 수 없었습니다.

• Job Editor > 확인 > 컨트롤 바에서 아무 용지 웨지나 선택하면 기준 공차 프리셋이 사용자 지정으로 변
경됩니다.

고객 릴리스 정보

Fiery Command WorkStation Package, 버전 6.8

86



Fiery Command WorkStation Package v6.8.0.385에서 문제 해결

Fiery XF

• 작업을 타일로 표시할 때 개별 타일의 크기 계산 시 접착 및 겹침 영역이 고려되지 않았습니다.

Fiery Command WorkStation Package v6.8.0.366에서 문제 해결

Fiery Command WorkStation

• Fiery Spot Pro에서 환경 설정 대화 상자에 허용 오차를 정의했더라도 색 영역 내 및 색 영역 외 ∆E 표시
가 별색에 대해 일정하지 않았습니다.

• 특수 색상을 정의하고 Fiery Spot Pro을(를) 다시 열면 특수 색상 분리 값이 유지되지 않았습니다.

• 작업 속성에서 임포징 템플릿을 선택한 경우 새 핫 폴더의 표지 페이지 설정을 정의할 수 없었습니다.

Fiery XF

• Color Tools에서 Seiko M64s 프린터용 기본 선형화 파일을 생성할 때 오류 메시지가 표시되었습니다.

• Color Tools의 목록에서 다른 용지 옵션을 선택하고 재보정 중에 인쇄를 클릭하면 측정 차트 크기가 예기
치 않게 감소했습니다.

Fiery Command WorkStation Package v6.8.0.333에서 문제 해결

Fiery Command WorkStation

• Fiery ImageViewer에서 해당 작업의 첫 번째 페이지가 인쇄 대기열에 있는 동안 후속 페이지에 대해 현
재 인쇄 옵션을 선택하면 오류 메시지가 나타납니다.

• 다른 용지 카탈로그 항목을 사용하여 Fiery Impose의 소책자 매체와 Command WorkStation의 표지 페
이지 매체를 정의한 경우, 작업의 첫 시트가 잘못된 표지 페이지 설정을 사용하여 인쇄되었습니다. 그러나
나머지 시트는 소책자 매체 설정을 사용하여 인쇄되었습니다.

• 이미지 이동 옵션에서 0.29mm 또는 인치 단위의 해당 값과 포인트 단위의 해당 값을 초과하는 측정 단위
를 지정할 수 없었습니다.

• 표시 언어가 독일어인 Command WorkStation에서 작업이 다음 중 하나를 사용하는 경우 보정 세트를 재
보정할 수 없습니다.

• 사용자 지정 종이 크기

• 사용자 지정 종이 크기 및 APPE 활성화됨

Fiery XF

• macOS 13의 Command WorkStation에서 보정을 시도한 경우(Color Tools > 보정 생성), 왼쪽 패널 컨
트롤이 표시되지 않기 때문에 보정을 사용할 수 없었습니다.

• Job Editor > 프린터 > 형식에서 사용자 지정 매체 크기를 정의한 경우, 프린터 하드웨어 여백이 작업 미
리 보기에 표시되지 않았습니다.

고객 릴리스 정보
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Fiery Command WorkStation Package v6.8.0.277에서 문제 해결

Fiery Command WorkStation

• Command WorkStation 및 Fiery Hot Folders가 설치된 macOS 13에서 작업 속성 > 레이아웃 > 임포징
> 임포징 템플릿 편집을 선택하면 창이 예기치 않게 닫히기 때문에 변경 내용을 저장할 수 없습니다.

• macOS 13에서 Fiery Software Manager가 이미 실행 중인 경우 앱과 리소스에서 Fiery Software
Manager를 시작할 수 없습니다.

• macOS 13에서 별색 최적화 보고서 HTML 파일 저장한 경우 Safari에서 보고서를 열면 EFI 및 Fiery 로
고가 표시되지 않습니다.

• Fiery Impose에서 더블 바이트 문자가 포함된 사용자 정의 마감 크기 템플릿을 저장하여 작업 속성에서
작업을 적용하면 사용자 정의 마감 크기 값 대신 자르기 상자 기준 마감 크기에 정의된 값이 선택됩니다.

• Fiery Preview에서 Fiery Impose의 표지 및 본문 페이지에 대해 다른 용지 설정을 지정했더라도 표지와
본문 페이지에 동일한 용지 설정이 표시됩니다.

• 작업 속성에서 용지 탭을 클릭하고 혼합 용지로 스크롤하면 일부 용지 옵션이 작업에 대해 표시되지 않습
니다.

Fiery XF

• Server Manager 및 Job Editor에서 Zund 마감 장치를 설정할 경우 사용 가능한 유일한 잘라내기 방법은
DumDum입니다.

• 마감 탭에서 중첩된 다중 페이지 작업 대해 상단 및 하단 바코드 위치를 선택하면 하단의 바코드 일부가
용지 레이아웃 밖에 표시되고 파일이 인쇄되지 않습니다.

Fiery Command WorkStation Package v6.8.0.217에서 문제 해결

Fiery Command WorkStation

• Fiery server를 재보정할 때 패치 레이아웃 창에서 다음을 클릭하면 Fiery Calibrator에 동일한 패치 레이
아웃이 다시 표시되고 측정 차트가 인쇄되지 않았습니다. 이 문제는 언어를 Fiery server 및 Fiery
Command WorkStation 프랑스어로 설정할 때 발생합니다.

• Fiery ImageViewer에서 단색 작업에 대한 색상 조정 창의 곡선을 편집한 후 프리셋으로 저장하려고 하
면 오류 메시지가 표시됩니다.

Fiery XF

• 등위선 절단 창에서 사용자 지정 잘라내기 방법을 삭제하면 사용자 지정 잘라내기 방법이 모두 목록에서
삭제되었습니다.

• Esko 자르기 표를 선택하면 사용자 지정 잘라내기 방법을 정의할 수 없었습니다.

• 사용자 지정 매체 크기를 정의할 때 Canon PRO 시리즈 프린터에 대해 경계선 없이 인쇄를 수행할 수 없
었습니다.
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Fiery Command WorkStation Package v6.8.0.184에서 문제 해결

Fiery Command WorkStation

• Calibrator에서 보정을 완료한 후 보정 후 ADC 데이터 생성 옵션이 지원되는 프린터에서 선택되었습니다.

Fiery XF

• Fiery XF 서버에 연결된 색상 편집기를 사용하여 별색 라이브러리를 생성하면 색상 값이 저장되지 않았
습니다. 또한 동일한 라이브러리를 다시 가져온 경우 CMYKRB, CMYKOB, CMYKRV 사용자 지정 별색
의 값이 유지되지 않았습니다.

Fiery Command WorkStation Package v6.8.0.165에서 문제 해결

Fiery Command WorkStation

• ACD 옵션이 활성화되지 않은 Fiery server에 대해 보정을 생성할 때 Fiery Calibrator는 ACD 데이터 생
성을 위해 여전히 WebTools를 열었습니다.

• 새 Fiery Hot Folder를 생성하고 정의를 선택하여 작업 설정을 지정할 때 작업 속성 창이 열리지 않았습
니다.

• 임포징된 일부 PDF 작업에 대한 Fiery 미리 보기의 시트 보기 창에 미리 보기를 표시하는 데 평소보다 더
오래 걸렸습니다.

• Windows 컴퓨터에서 지원 중단에 대한 메시지가 Fiery 옵션 관리 창이 아닌 Fiery Impose 데모 창에 표
시됩니다.

• 작업 속성 > 마감에서 1,000 페이지 작업 시 매 100장마다 간지 인쇄 옵션을 활성화했을 떄 매 장마다 간
지가 삽입되었습니다.

• EFI 업데이트 서버가 오프라인 상태에 있는 동안 Fiery Command WorkStation 열기를 시도하고 Fiery
servers에 연결할 때 작업 대기열을 로드하는 데 몇 분이 걸렸습니다.

Fiery XF

• Server Manager에서 기준 공차 프리셋을 사용자 지정으로 선택하면 델타 E 포맷값이 올바르지 않은 dE
2000으로 나타납니다. 그러나 Job Editor에서는 Delta E 포맷 값이 올바르게 dE CIE76으로 표시되었습
니다.

업그레이드

이 설치 관리자는 기존의 Fiery Command WorkStation Package를 Fiery Command WorkStation 및
Fiery Hot Folders가 포함된 최신 패키지로 업그레이드합니다. 옵션으로, Fiery Software Manager을(를)
사용하여 Fiery Remote Scan을 설치할 수 있습니다.

기술 사양에 대한 자세한 내용은 www.efi.com/cws를 참조하십시오.
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시스템 요구 사항 업데이트

지원되는 버전

Fiery Command WorkStation 버전 6.8은 Fiery server에 설치된 Fiery 시스템 소프트웨어 FS150/FS150
Pro 이상의 버전을 지원합니다.

Fiery Command WorkStation에서 지원하는 컴퓨터 운영 체제:

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11, 64비트

• Windows 10, 64비트

• Windows Server 2022, 64비트

• Windows Server 2019, 64비트

• Windows Server 2016, 64비트

참고: Fiery Command WorkStation은 M1 칩이 있는 macOS 컴퓨터에 대한 Rosetta 지원을 제공합니다. 자
세한 내용은 https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-sur-
compatibility/를 참조해 주세요.

알려진 문제

macOS 13

macOS 13에서 Adobe Acrobat

Adobe는 아직 macOS 13에서 Adobe Acrobat을 전폭적으로 지원하지 않기 때문에 다음과 같은 문제가
발생하게 됩니다.

• M1 및 M2 프로세서의 macOS 13에서 Adobe Acrobat을 시작할 수 없습니다.

• Intel 프로세서에서 이미 로그인한 경우에도 Adobe Acrobat에 로그인 창이 표시됩니다. 로그인 창을
해제하고 Acrobat 기능이 정상적으로 작동합니다.

Fiery XF 서버에서 보정을 사용할 수 없음

macOS 13의 Command WorkStation에서 보정하는 경우(Color Tools > 보정 생성), 왼쪽 패널 컨트롤이
표시되지 않기 때문에 보정에 사용할 수 없습니다.
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macOS 10.15 이상

전체 디스크 액세스로 이동합니다

macOS 10.15 및 이후 버전에서 보안을 관리하는 방식의 변화로 인해 이제 Fiery 어플리케이션이 제대
로 작동하기 위해서는 추가 단계가 필요합니다.
Fiery 어플리케이션이 업데이트를 관리하고 Impose 템플릿 및 핫 폴더와 같은 파일에 액세스할 수 있도
록 macOS에서 전체 디스크 액세스 보안 기능을 변경해야 합니다. Fiery Command WorkStation과 같은
Fiery 어플리케이션에 대한 전체 디스크 액세스를 활성화합니다.

1 Fiery 어플리케이션을 모두 닫습니다.

2 시스템 환경 설정 > 보안 & 개인 정보 보호 > 개인 정보 보호 > 전체 디스크 액세스로 이동합니다.

3 왼쪽 하단 모서리에 있는 잠금 아이콘을 클릭하고 사용자 암호를 입력합니다.

4 앱 목록에서 com.efi.InstallerHelperTool옆의 확인란을 선택합니다.

5 + 버튼을 클릭합니다.

6 어플리케이션 폴더에서 Fiery Software Manager와 Fiery Software Uninstaller를 선택하고 열기를
클릭합니다.

이러한 어플리케이션은 컴퓨터에서 Fiery 어플리케이션을 유지하고 업데이트하기 위한 전체 디스크
액세스가 필요합니다.

7 어플리케이션 폴더에서 Fiery Command WorkStation 어플리케이션을 선택하고 열기를 클릭합니다.

8 Fiery Hot Folders 또는 Fiery Remote Scan을 사용하는 경우 각 어플리케이션를 선택하고 열기를
클릭합니다.

문서, 데스크탑 및 다운로드 폴더가 사용되는 것을 Fiery Hot Folders에서 감지하면 전체 디스크 액
세스를 요청하는 메시지가 표시됩니다. 이 메시지는 액세스 권한이 부여된 후에도 계속 표시됩니다.
이 메시지를 해제하고 작업을 계속할 수 있습니다.

PS - PDF 변환

Fiery Impose 또는 Fiery Compose 또는 Fiery JobMaster와 함께 macOS 10.14.5 이상을 사용하는 경우,
Fiery Command WorkStation이 Acrobat Distiller에 액세스할 수 있도록 허용하라는 메시지를 받을 수 있
습니다. 이 권한은 PS 파일을 PDF로 변환하는 데 필요합니다. 권한을 부여하지 않으면 변환이 성공하지 못하
며 macOS에서 자동화 보안 기능을 변경해야 합니다.

1 Fiery 어플리케이션을 모두 닫습니다.

2 Acrobat Distiller를 닫습니다.

3 그런 다음, 시스템 환경 설정 > 보안 & 개인 정보 > 개인정보 보호 > 자동화로 이동합니다.

4 왼쪽 하단 모서리에 있는 잠금 아이콘을 클릭하고 사용자 암호를 입력합니다.

5 앱 목록에서 Fiery Command WorkStation.app을 찾습니다.

6 Acrobat Distiller.app 옵션을 선택합니다.
이로써 Fiery Command WorkStation이 Acrobat Distiller에 액세스할 수 있습니다.
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PostScript에서 PDF로 변환을 위한 Adobe Acrobat Distiller에서의 환경 설정 지정

Fiery Impose, Fiery Compose 및 Fiery JobMaster은 클라이언트 컴퓨터에서 PostScript(PS) 파일을 PDF
로 변환하기 위해서는 Acrobat Distiller가 필요합니다.

Acrobat Distiller의 강화된 보안 설정으로 인해 변환할 PS 파일의 출처가 신뢰할 만한 곳인지를 확인해야 합
니다. Acrobat Distiller > 파일 > 환경 설정 > 환경 설정 - Acrobat Distiller보안 아래의 Acrobat Distiller를 통
해 열린 모든 파일 신뢰를 선택합니다.

참고: Acrobat Distiller를 통해 열린 모든 파일 신뢰를 선택하지 않으면 PDF로 변환할 모든 PS 파일에 대해
출처가 신뢰할 수 있는 곳인지 확인하라는 메시지가 표시됩니다. 이는 Microsoft Office 필터를 선택하고, 출
력 파일 형식이 PDF로 지정되고, joboptions 파일이 Distiller 프로필로 선택된 경우에도 Hot Folders에 적용
됩니다.

Spot Pro

특수 색상

특수 색상은 프로파일되지 않으며 적용 대상 기능은 장치 CMYK 값으로만 제한됩니다.

별색 값 반올림

별색를 정의하고 Spot Pro를 다시 시작하면 일부 색상의 값이 원래 입력한 값과 약간 다를 수 있습니다.
이는 Spot Pro가 숫자를 반올림했기 때문이며 눈에 띄는 색상 변화가 없어야 합니다.

M3 측정 모드

M3 모드는 단일 측정 장치에서는 지원되지 않습니다.
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客戶版本資訊
Fiery Command WorkStation Package，6.8 版

本文件包含有關此版本的重要資訊。在繼續安裝之前，請務必將這項資訊提供給所有使用者。

關於本版本
本版本包含以下應用程式：

• Fiery Command WorkStation Package v6.8.0.615

• Fiery Command WorkStation 適用於 Windows 的 v6.8.0.54

• Fiery Command WorkStation 適用於 Mac 的 v6.8.0.55

• Fiery Hot Folders v4.3.1.05

• Windows 版 Fiery Software Manager v6.8.0.11

• Mac 版 Fiery Software Manager v6.8.0.12

全新功能

最新消息

如需 6.8 版的初始版本中所新增功能的詳細資訊，請造訪 http://fiery.efi.com/CWS/Whats-New。

預覽點陣曲線編輯效果

對於所有外部 Fiery servers，當您使用工作屬性將點陣曲線編輯套用到工作時，已處理工作的結果會顯
示在 Fiery Preview 應用程式中。

對於嵌入式 Fiery servers，僅當已啟用 Fiery ColorRight Package 或 Fiery Productivity Package
時，點陣曲線編輯的工作才會將已處理工作顯示在 Fiery Preview 應用程式中。

特別色最佳化報告

在 Fiery Spot Pro 中，您現在可以將特別色最佳化報告儲存為 HTML 檔。

http://fiery.efi.com/CWS/Whats-New


Fiery 系統影像備份通知

Fiery 系統影像的備份將在備份失敗時通知您，並在 Fiery Command WorkStation 中的通知下列出。

• 您可以在管理設定 > Fiery 系統還原中重新安排備份。

• 要隱藏通知，請按一下「更多」圖示 (三個點)，然後選取隱藏。

最新消息視窗的關閉按鈕

當您第一次安裝並開啟 Fiery Command WorkStation 最新版本時，將顯示最新消息視窗。您現在可以使用

最新消息視窗底部的關閉按鈕，即使顯示解析度小於支援的解析度。

顯示解析度支援的最小值：

• 1280 x 1024 (單頁紙)

• 1600 x 900 (寬幅和超寬幅)

修復問題

Fiery Command WorkStation Package V6.8.0.615 中已修復的問題

Fiery Command WorkStation

• Fiery Command WorkStation Package 現在支援符合 GB18030 標準的中文字體。

Fiery Command WorkStation Package V6.8.0.541 中已修復的問題

Fiery Command WorkStation

• 如果您在 Fiery Hot Folders 中以 若提交為資料夾則合併所有檔案 選項合併了兩個 PDF 檔，則輸出的
PDF 檔不會如預期般顯示。

• 如果您在校正 Fiery server 時選取 塗料紙 - 光面校正，將顯示紙張重量不匹配的錯誤訊息。

• 如果您在保留佇列中的 VDP 工作的工作屬性 中建立主文頁文件並按一下 預覽主文頁後，則將新增一張空
白頁。

客戶版本資訊
Fiery Command WorkStation Package，6.8 版

94



Fiery Command WorkStation Package V6.8.0.514 中已修復的問題

Fiery Command WorkStation

• 當您對使用系統軟體 FS200/200 Pro 或 FS300/300 Pro 的 Fiery server，按一下資源 > Spot Pro 時，
不會顯示特別色清單和特別色值。

Fiery XF

• 已將 Fiery XF 伺服器從 v7.3 升級至 v7.3.3 時，無法使用 Fiery 設定檔更新程式來更新底材設定檔。

Fiery Command WorkStation Package V6.8.0.466 中已修復的問題

Fiery Command WorkStation

• 在西班牙文系統上，您無法透過按 刪除 鍵從保留佇列刪除所選的工作。

• 對於未安裝虛擬印表機授權的 Fiery 嵌入式伺服器，發佈為虛擬印表機選項顯示於工作預設值標籤上。

• 無法使用 Fiery Color Profiler Suite 中的印表機比對選項為多台印表機使用自動內嵌感應器建立新的通
用校正。

Fiery Command WorkStation Package V6.8.0.439 中已修復的問題

Fiery Command WorkStation

• 您無法在 定義隔頁紙底材 視窗中儲存工作所選的紙張型錄項目。

• 在日文語言的系統上，校正工作的份數不正確。

Fiery XF

• 在 Job Editor 中，帶有剪切標記的 PDF 工作顯示的頁面尺寸不正確。

Fiery Command WorkStation Package V6.8.0.406 中已修復的問題

Fiery Command WorkStation

• 無法使用 自動糾正色彩不匹配 選項校正印表機。

• 當在 ImageViewer > 色彩調整中修改已處理的工作，而您嘗試刪除一個曲線點時，所選頁面會被刪除。如

果按一下 還原，頁面將還原。然而，如果不重新啟動編輯程序，則無法繼續編輯。

Fiery XF

• 您無法在 VUTEk h5 印表機的 Server Manager 中儲存某些用於紙張的列印選項。

• 當您在 Job Editor > 驗證 > 控制列中選取任意的 Media Wedge 時，目標容差預設值變更為自訂。

客戶版本資訊
Fiery Command WorkStation Package，6.8 版

95



Fiery Command WorkStation Package V6.8.0.385 中已修復的問題

Fiery XF

• 當工作為分割頁面時，在計算個別分割頁面的工作大小不會考慮到上膠和重疊的區域。

Fiery Command WorkStation Package V6.8.0.366 中已修復的問題

Fiery Command WorkStation

• 在 Fiery Spot Pro 中，即使您在 喜好設定 對話方塊中定義了容差值，色域圖內和色域圖外對特別色的
∆E 指示不一致。

• 定義專屬色和重新打開 Fiery Spot Pro 時，不會保留專屬色分色值。

• 在 工作屬性 中選取 Impose 範本時，無法為新的監視資料夾定義封面頁設定。

Fiery XF

• 在 Color Tools 中，當您嘗試建立 Seiko M64s 印表機的基本線性化檔案時，會顯示一則錯誤訊息。

• 在 Color Tools 中，當您從清單中選取不同的 紙張 選項並在重新校正期間按下 列印 時，量測卡的尺寸會
意外縮小。

Fiery Command WorkStation Package V6.8.0.333 中已修復的問題

Fiery Command WorkStation

• 在 Fiery ImageViewer 中，當您的工作第一頁在「列印佇列」中為後續頁面選取 目前 的列印選項，則會
出現一則錯誤訊息。

• 當您使用不同的紙張型錄項目定義 Fiery Impose 中的手冊底材和 Command WorkStation 中的封面頁底材
時，工作的第一印張使用不正確的封面頁設定列印。然而，其餘印張均用手冊底材設定列印。

• 您無法在影像偏移選項中指定超過 0.29 公釐或其同等值的量測單位 (英寸和點)。

• 在 Command WorkStation 將顯示語言設為德文時，如果工作使用以下任一項，則無法重新校正校正集：

• 自訂紙張大小

• 自訂紙張大小和 APPE 已啟用

Fiery XF

• 如果您嘗試在 macOS 13 上的 Command WorkStation 中進行校正時 (Color Tools > 建立校正)，左邊的面
板控制不可見，因此無法使用校正。

• 當您使用 Job Editor > 印表機 > 格式定義自訂底材尺寸時，印表機硬體邊距不會顯示在工作預覽中。

客戶版本資訊
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Fiery Command WorkStation Package V6.8.0.277 中已修復的問題

Fiery Command WorkStation

• 在 macOS 13 使用 Command WorkStation 和 Fiery Hot Folders，當您選取工作屬性 > 版面配置 >

Impose > 編輯 Impose 範本時，由於視窗意外關閉，變更無法儲存。

• 在 macOS 13 上，如果 Fiery Software Manager 已在執行中，則無法從應用程式和資源中啟動 Fiery
Software Manager。

• 在 macOS 13 上，當您將特別色最佳化報告儲存為 HTML 檔案並在 Safari 中開啟報告時，不會看到 EFI
和 Fiery 標誌。

• 當您在 Fiery Impose 中儲存帶有全形字元的使用者定義加工尺寸範本並在工作屬性中將其套用至工作時，

根據裁切方塊加工尺寸定義的值將被選取，而不是使用者定義加工尺寸的值。

• 在 Fiery Preview 中，即使已在 Fiery Impose 中為封面和內文頁指定了不同的底材設定，封面和內文頁
還是會顯示相同的底材設定。

• 當您按一下工作屬性中的底材標籤並向下捲動到混合紙張時，未顯示工作的某些底材選項。

Fiery XF

• 在 Server Manager 和 Job Editor 中設定 Zund 加工裝置時，唯一可用的裁切方法是 DumDum。

• 當您在裝訂作業標籤中為合併列印的多頁工作選取上方和下方條碼位置時，底部的部分條碼會出現在底材版
面配置之外，且檔案不會列印。

Fiery Command WorkStation Package V6.8.0.217 中已修復的問題

Fiery Command WorkStation

• 重新校正 Fiery server 期間，按一下色標配置視窗中的下一步，Fiery Calibrator 會再次顯示相同的色標
配置，且未列印量測卡。將 Fiery server 和 Fiery Command WorkStation 的語言設定為法文時會出現此
問題。

• 在 Fiery ImageViewer 中，當您在色彩調整窗格中編輯單色工作的曲線並嘗試將其儲存為預設時，會出現
一則錯誤訊息。

Fiery XF

• 在輪廓裁切視窗中刪除某個自訂裁切方法時，所有自訂裁切方法均會從清單中刪除。

• 當您選取 Esko 裁剪台時，無法定義自訂裁切方法。

• 定義自訂底材尺寸後，無法在 Canon PRO 系列印表機上執行無邊框列印。
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Fiery Command WorkStation Package V6.8.0.184 中已修復的問題

Fiery Command WorkStation

• 當 Calibrator 中重新校正完成後，在校正後產生 ACD 資料選項會為支援的印表機選取。

Fiery XF

• 當您使用 Color Editor 連接至 Fiery XF 伺服器建立特別色色彩庫時，色彩值沒有儲存。此外，如果您再
次匯入同一個色彩庫，CMYKRB、CMYKOB 和 CMYKRV 自訂特別色的色彩值也沒有保留。

Fiery Command WorkStation Package V6.8.0.165 中已修復的問題

Fiery Command WorkStation

• 當您為未啟用 ACD 選項的 Fiery server 建立校正時，Fiery Calibrator 仍會開啟 WebTools 為 ACD 產
生資料。

• 當您建立新的 Fiery Hot Folder 並選擇定義以指定工作設定時，工作屬性視窗不會開啟。

• 對於部分落版 PDF 工作，在 Fiery 預覽的紙張檢視窗格中顯示的預覽時間比平常久。

• 在 Windows 電腦上，Fiery Impose 示範視窗中未出現管理 Fiery 選項視窗，而是停止支援訊息。

• 在工作屬性 > 裝訂作業中，對於一個 1000 頁的工作，如果您為其中的每 100 份啟用隔頁紙列印選項，則
隔頁紙會插入在所有單頁前。

• 當您嘗試在 EFI 更新伺服器離線時開啟 Fiery Command WorkStation 和連線至 Fiery servers 時，需要
幾分鐘載入工作佇列。

Fiery XF

• 當您在 Server Manager 中將目標容差預設值選為自訂時，Delta E 格式值顯示為不正確的 dE 2000。但

是， 在 Job Editor 中 Delta E 格式值無誤地顯示為 dE CIE76。

升級
此安裝程式會將任何現有的 Fiery Command WorkStation Package 升級至包含 Fiery Command WorkStation
與 Fiery Hot Folders 的最新套件。您可以選擇使用 Fiery Software Manager 來安裝 Fiery Remote Scan。

如需有關技術規格的更多資訊，請參閱 www.efi.com/cws。

系統需求更新

支援的版本

Fiery Command WorkStation 版本 6.8 支援安裝於 Fiery server 上的 Fiery 系統軟體 FS150/FS150 Pro 與
更新版本。

Fiery Command WorkStation 可支援以下電腦作業系統：

• macOS 14

• macOS 13

客戶版本資訊
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• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11 (64 位元)

• Windows 10 (64 位元)

• Windows Server 2022 (64 位元)

• Windows Server 2019 (64 位元)

• Windows Server 2016 (64 位元)

附註：Fiery Command WorkStation 為配備 M1 晶片的 MacOS 電腦提供 Rosetta 支援。如需更多資訊，請造
訪 https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-sur-
compatibility/。

已知問題

macOS 13

macOS 13 上的 Adobe Acrobat

由於 Adobe 尚未在 macOS 13 上提供 Adobe Acrobat 的完整支援，因此您將遇到以下問題：

• 您無法在使用 M1 和 M2 處理器的 macOS 13 上啟動 Adobe Acrobat。

• 在 Intel 處理器上，即使您已經登錄，Adobe Acrobat 仍將顯示登錄視窗。關閉登錄視窗，即可正常
使用 Acrobat 功能。

Fiery XF 伺服器上校正不可用

如果您嘗試在 macOS 13 上的 Command WorkStation 中進行校正 (Color Tools > 建立校正)，左邊的面板
控制不可見，因此無法使用校正。

macOS 10.15 及更新版本

完全取用磁碟

由於 macOS 10.15 及更新版本管理安全性的方式改變，現在需要進行額外的步驟，Fiery 應用程式才能正
常運作。

您需要對 macOS 中的完全取用磁碟安全性功能進行變更，Fiery 應用程式才能管理更新並存取 Impose 範

本與監視資料夾等檔案。為 Fiery Command WorkStation 等 Fiery 應用程式啟用完全取用磁碟。

1 關閉所有 Fiery 應用程式。

2 前往系統偏好設定 > 安全性與隱私權 > 隱私權 > 完全取用磁碟。

3 按一下左下角的「鎖頭」圖示，然後輸入密碼。
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4 在應用程式清單中，選取 com.efi.InstallerHelperTool 旁邊的核取方塊。

5 按一下 + 按鈕。

6 在「應用程式」資料夾中，選取 Fiery Software Manager 與 Fiery Software Uninstaller，然後按

一下打開。

這些應用程式需要能完全取用磁碟，才能維護和更新電腦上的 Fiery 應用程式。

7 在「應用程式」資料夾中，選取 Fiery Command WorkStation 應用程式，然後按一下打開。

8 如果您使用 Fiery Hot Folders 或 Fiery Remote Scan，請選取每個應用程式，然後按一下 打開。

當 Fiery Hot Folders 偵測到「文件」、「桌面」及「下載項目」資料夾處於使用中時，會發出要求
完全取用磁碟的訊息。在授予取用權限後，此訊息仍會顯示。您可以關閉該訊息並繼續工作。

PS 至 PDF 轉換

當您使用 macOS 10.14.5 和更新版本搭配 Fiery Impose、Fiery Compose 或 Fiery JobMaster 時，系統可能
會提示您允許 Fiery Command WorkStation 存取 Acrobat Distiller。這是將 PS 檔案轉換為 PDF 的必要權
限。如果不授予權限，將無法成功轉換，而您需要變更 macOS 中的自動化安全性功能。

1 關閉所有 Fiery 應用程式。

2 關閉 Acrobat Distiller。

3 跳至 系統偏好設定 > 安全性與隱私權 > 隱私權 > 自動化。

4 按一下左下角的「鎖定」圖示，然後輸入密碼。

5 在應用程式清單中，找到 Fiery Command WorkStation.app。

6 選取 Acrobat Distiller.app 選項。
這樣即可允許 Fiery Command WorkStation 存取 Acrobat Distiller。

在 Adobe Acrobat Distiller 中設置 PostScript PDF 轉換的喜好設定

Fiery Impose、Fiery Compose 和 Fiery JobMaster 要求 Acrobat Distiller 將客戶電腦上的 PostScript
（PS）檔轉換為 PDF。

由於 Acrobat Distiller 中增強的安全設定，您必須確認要轉換的 PS 檔來自於可信賴的來源： Acrobat
Distiller > 檔案 > 喜好設定 > 喜好設定 - Acrobat Distiller，請選擇 安全性 下的 信任通過 Acrobat Distiller
打開的所有檔案。

附註：如果不選擇信任通過 Acrobat Distiller 打開的所有檔案，系統會提示您確認檔案來自每個 PS 檔的可信

來源以轉換為 PDF。如果選擇了 Microsoft Office 篩選器，Hot Folders 則會將輸出檔案類型指定為 PDF，並

選擇 joboptions 檔作為 Distiller 設定檔。

Spot Pro

專屬色

專屬色未產生設定檔，且套用於功能僅限於裝置 CMYK 值。
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特別色值進位

定義特別色和重新啟動 Spot Pro 之後，某些色彩值可能與輸入的原始值略有不同。這是因為 Spot Pro
執行的數值會進位，並且顏色不應該有明顯的變化。

M3 量測模式

單一量測裝置不支援 M3 模式。
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Примечания к выпуску для заказчика
Fiery Command WorkStation Package версии 6.8

Данный документ содержит важную информацию об этом выпуске. Обязательно сообщите эту информацию
всем пользователям перед началом установки.

Об этом выпуске

В данный выпуск входят следующие приложения:

• Fiery Command WorkStation Package v6.8.0.615

• Fiery Command WorkStation v6.8.0.54 для Windows

• Fiery Command WorkStation v6.8.0.55 для Mac

• Fiery Hot Folders v4.3.1.05

• Fiery Software Manager v6.8.0.11 для Windows

• Fiery Software Manager v6.8.0.12 для Mac

Новые функции

Новые возможности

Для получения дополнительной информации о новых функциях, добавленных в первоначальный выпуск
версии 6.8, перейдите по адресу http://fiery.efi.com/CWS/Whats-New.

Предварительный просмотр эффектов редактирования растровых кривых

Для всех внешних серверов Fiery servers, когда вы используете Параметры задания для применения
изменений растровой кривой к заданию, результаты отображаются в приложении Fiery Preview для
обработанных заданий.
Для встроенных серверов Fiery servers изменения растровых кривых в задании отображаются в
приложении Fiery Preview для обработанных заданий только в том случае, если включен пакет Fiery
ColorRight Package или Fiery Productivity Package.

http://fiery.efi.com/CWS/Whats-New


Отчет об оптимизации плашечных цветов

Теперь в Fiery Spot Pro можно сохранить отчет об оптимизации плашечных цветов в файле HTML.

Уведомления о резервном копировании образа системы Fiery

В случае сбоя резервного копирования образа системы Fiery вы получите соответствующее уведомление,
которое также появится в разделе Уведомления в Fiery Command WorkStation.

• Для изменения графика резервного копирования выберите Управление настройками >
Восстановление системы Fiery.

• Чтобы скрыть уведомление, нажмите значок «Больше» (три точки) и выберите Скрыть.

Кнопка «Закрыть» в окне Новые возможности

Окно Новые возможности отображается при первом запуске установленной последней версии Fiery
Command WorkStation. Теперь можно использовать кнопку Закрыть в нижней части окна Новые
возможности даже в том случае, если разрешение дисплея меньше поддерживаемого разрешения.
Минимальные поддерживаемые разрешения дисплея:

• 1280 x 1024 (листовые)

• 1600 x 900 (широкие и сверхширокие)

Исправленные ошибки

Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.615

Fiery Command WorkStation

• Fiery Command WorkStation Package теперь поддерживает китайские шрифты в соответствии со
стандартом GB18030.

Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.541

Fiery Command WorkStation

• При объединении двух файлов PDF с помощью параметра Объединять все файлы, если они отправлены в
виде папки в Fiery Hot Folders выходной файл PDF отображался неправильно.

• При выборе калибровки С покрытием - Глянцевая во время калибровки сервера Fiery serverотображалось
сообщение об ошибке несовпадения плотности бумаги.

• Если при создании мастер-документа в разделе Параметры задания для задания VDP в очереди
задержанных заданий нажать Просмотр мастер-документа, добавлялась дополнительная пустая страница.

Примечания к выпуску для заказчика
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Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.514

Fiery Command WorkStation

• После нажатия Ресурсы > Spot Pro для сервера Fiery server с системным программным обеспечением
FS200/200 Pro или FS300/300 Pro список плашечных цветов и значения плашечных цвет не отображались.

Fiery XF

• При обновлении сервера Fiery XF с версии 7.3 до версии 7.3.3 не удавалось обновить профили материала
для печати с помощью Fiery Profiles Updater.

Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.466

Fiery Command WorkStation

• В системе с испанским языком невозможно было удалить выбранное задание из очереди отложенных
заданий, нажав клавишу Удалить.

• Функция Опубликовать в виде виртуального принтера отображалась на вкладке Шаблоны задания для
встроенного сервера Fiery, на котором не была установлена лицензия на виртуальный принтер.

• Невозможно было создать новую общую калибровку с использованием автоматизированного
встроенного датчика для нескольких принтеров с помощью параметра Сопоставление принтеров в Fiery
Color Profiler Suite.

Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.439

Fiery Command WorkStation

• Невозможно сохранить выбранный элемент каталога бумаги для задания в окне Задайте материал для
печати прокладочных листов.

• В некоторых системах с японским языком количество копий задания калибровки было неверным.

Fiery XF

• В Job Editor отображался неправильный формат страницы для задания PDF с метками обрезки.

Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.406

Fiery Command WorkStation

• Не удавалось выполнить калибровку принтера с использованием параметра Автоматическая
корректировка несовпадения цветов.

• Если после изменения обработанного задания в разделе ImageViewer > Регулировка цвета попытаться
удалить точку кривой, выбранная страница удалялась. Для восстановления страницы необходимо было
нажать Восстановить. Однако редактирование невозможно было продолжить без перезапуска процесса
редактирования.
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Fiery XF

• Невозможно было сохранить некоторые параметры печати, заданные для материала для печати в Server
Manager при использовании принтеров VUTEk h5.

• При выборе любого материала Media Wedge в разделе Job Editor > Verify > Контрольные шкалы шаблон
заданных допусков заменялся на Пользовательский.

Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.385

Fiery XF

• При мозаичном размещении задания области перекрытия и склеивания не учитывались при вычислении
размера задания для отдельного элемента мозаики.

Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.366

Fiery Command WorkStation

• В Fiery Spot Pro значения ∆E в пределах гаммы и вне гаммы не совпадали для плашечных цветов, даже
если был задан допуск в диалоговом окне Предпочтения.

• Если после определения специального цвета повторно открыть Fiery Spot Pro, значения цветоделения
специального цвета не сохранялись.

• При выборе шаблона Impose в окне Параметры задания не удавалось определить настройки страницы
обложки для новой папки быстрого доступа.

Fiery XF

• В Color Tools при попытке создать базовый файл линеаризации для принтера Seiko M64s отображалось
сообщение об ошибке.

• В Color Tools при выборе других параметров в списке Материал для печати и нажатии кнопки Печать во
время повторной калибровки размер шкалы измерений неожиданно уменьшался.

Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.333

Fiery Command WorkStation

• В Fiery ImageViewer при выборе параметра печати Текущий для следующей страницы, в то время как
первая страница задания находилась в очереди печати, отображалось сообщение об ошибке.

• Если для определения материала для печати брошюры в Fiery Impose и материала для печати страницы
обложки в Command WorkStation использовались разные элементы каталога бумаги, первый лист
задания печатался с неправильными настройками страницы обложки. Однако остальные листы
печатались с использованием настроек материала для печати, выбранного для брошюры.

• Невозможно было указать единицу измерения в параметре сдвига изображения помимо величины 0,29
мм или эквивалентного значения в дюймах и точках.
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• В Command WorkStation с немецким языком интерфейса не удавалось выполнить повторную калибровку
для набора калибровки, если в задании использовался один из следующих вариантов.

• пользовательский формат бумаги;

• пользовательский формат бумаги и включенный параметр APPE.

Fiery XF

• На компьютере под управлением macOS 13 при попытке калибровки из Command WorkStation (Color
Tools > Создать калибровку) элементы управления на левой панели не отображались, поэтому калибровка
не могла быть использована.

• При определении пользовательского формата материала для печати в Job Editor > Принтер > Формат
заданные в оборудовании принтера поля не отображались в предварительном просмотре задания.

Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.277

Fiery Command WorkStation

• На компьютере под управлением macOS 13 с установленным ПО Command WorkStation и Fiery Hot
Folders при выборе Параметры задания > Компоновка > Impose > Редактировать шаблон Impose
невозможно было сохранить изменения, поскольку окно неожиданно закрывалось.

• На компьютере под управлением macOS 13 с запущенным ПО Fiery Software Manager невозможно было
запустить приложение Fiery Software Manager с вкладки "Приложения и ресурсы".

• На компьютере под управлением macOS 13 при сохранении отчета об оптимизации плашечных цветов в
виде HTML-файла и открытии этого отчета в Safari логотипы EFI и Fiery не отображались.

• Если в Fiery Impose для сохранения шаблона формата после заключительной обработки был выбран
параметр Пользовательский и указано имя с двухбайтовыми символами, то после применения этого
шаблона к заданию в окне Параметры задания использовались значения, определенные для формата
после заключительной обработки На основе области кадрирования, вместо значений формата после
заключительной обработки Пользовательский.

• В Fiery Preview при отображении страниц обложки и содержимого использовались одни и те же
настройки материала для печати, даже если в Fiery Impose для этих страниц были заданы разные
настройки.

• После выбора вкладки Материал для печати в окне Параметры задания и прокрутки вниз до пункта
Смешанные материалы для печати некоторые параметры материала для печати текущего задания не
отображались.

Fiery XF

• При настройке устройства заключительной обработки Zund в Server Manager и Job Editor единственным
доступным методом обрезки был DumDum.

• При выборе положения штрихкода Верхний и нижний края для вложенного многостраничного задания на
вкладке Заключительная обработка часть штрихкода в нижней части отображалась за пределами
компоновки материала для печати, и файл не печатался.
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Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.217

Fiery Command WorkStation

• При нажатии Далее в окне Расположение зон во время повторной калибровки Fiery serverFiery Calibrator
снова отображалось то же самое Расположение зон и шкала измерений не печаталась. Эта проблема
возникала при выборе французского языка для сервера Fiery server и Fiery Command WorkStation.

• В Fiery ImageViewer при редактировании кривой на панели Регулировка цвета для монохромного задания
и попытке сохранить ее в качестве набора настроек отображалось сообщение об ошибке.

Fiery XF

• При удалении пользовательского метода обрезки в окне Обрезка по контуру все пользовательские
методы обрезки удалялись из списка.

• При выборе таблицы обрезки Esko невозможно было определить пользовательский метод обрезки.

• При выборе пользовательского формата материала для печати невозможно было выполнить печать без
полей на принтерах Canon серии PRO.

Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.184

Fiery Command WorkStation

• После завершения повторной калибровки в приложении Calibrator был выбран параметр Создать данные
ACD после калибровки для поддерживаемых принтеров.

Fiery XF

• При создании библиотеки плашечных цветов с помощью приложения Color Editor, подключенного к
серверу Fiery XF, значения цветов не сохранялись. Кроме того, при повторном импорте той же
библиотеки не сохранялись значения для пользовательских плашечных цветов CMYKRB, CMYKOB и
CMYKRV.

Проблемы, исправленные в Fiery Command WorkStation Package v6.8.0.165

Fiery Command WorkStation

• При создании калибровки для сервера Fiery server, для которого не был включен параметр ACD, Fiery
Calibrator по-прежнему открывает WebTools для генерации данных ACD.

• Если при создании новой папки быстрого доступа Fiery выбрать параметр Задать, чтобы указать
настройки задания, окно Параметры задания не открывается.

• Для отображения некоторых заданий PDF со спуском полос в режиме предварительного просмотра на
панели Представление листа в Fiery Preview требуется больше времени чем обычно.

• На компьютере под управлением Windows сообщение о прекращении поддержки появляется в окне
Демоверсия Fiery Impose вместо окна Управление параметрами Fiery.
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• Если в окне Параметры задания > Заключительная обработка для 1000-страничного задания включен
параметр печати Прокладочный лист для каждых 100 копий, прокладочный лист вставляется перед
каждой копией.

• При попытке открыть Fiery Command WorkStation и подключиться к серверу Fiery servers в то время,
когда сервер обновлений EFI отключен, для загрузки очереди заданий потребуется несколько минут.

Fiery XF

• Если в Server Manager для параметра Шаблоны заданных допусков выбрано значение Пользовательский,
значение формата dE отображается как "dE 2000", что неверно. Однако в Job Editor значение формата dE
отображается правильно как "dE CIE76".

Обновление

Эта программа установки обновит все существующие пакеты Fiery Command WorkStation Package до
новейшей версии пакета, содержащего Fiery Command WorkStation и Fiery Hot Folders. При необходимости
можно установить Fiery Remote Scan с помощью Fiery Software Manager.
Дополнительную информацию о технических характеристиках см. по адресу www.efi.com/cws.

Обновление системных требований

Поддерживаемые версии

Fiery Command WorkStation версии 6.8 поддерживает системное программное обеспечение Fiery FS150/FS150
Pro (и более поздние версии), установленное на сервере Fiery server.
Fiery Command WorkStation поддерживает указанные операционные системы.

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11 (64-разрядная)

• Windows 10 (64-разрядная)

• Windows Server 2022 (64-разрядная)

• Windows Server 2019 (64-разрядная)

• Windows Server 2016 (64-разрядная)

Примечание: Fiery Command WorkStation обеспечивает поддержку Rosetta для компьютеров macOS с чипом
M1. Дополнительные сведения см. по адресу https://www.efi.com/marketing/fiery-servers-and-software/
campaigns/macos-big-sur-compatibility/.
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Известные проблемы

macOS 13

Adobe Acrobat в macOS 13

Поскольку компания Adobe пока не предлагает полную поддержку Adobe Acrobat в macOS 13, вы можете
столкнуться со следующими проблемами.

• Невозможно запустить Adobe Acrobat в macOS 13 на компьютерах с процессорами M1 и M2.

• На компьютерах с процессорами Intel приложение Adobe Acrobat отображает окно входа, даже если
вы уже выполнили вход в систему. Закройте окно входа в систему, Acrobat продолжит работу в
обычном режиме.

Калибровка недоступна на сервере Fiery XF

На компьютере под управлением macOS 13 при попытке калибровки из Command WorkStation (Color
Tools > Создать калибровку) элементы управления на левой панели не отображаются, поэтому
калибровку использовать невозможно.

macOS 10.15 и более поздних версий

Полный доступ к диску

В результате изменений, внесенных в управление безопасностью macOS 10.15 или более поздней версии,
для правильной работы приложений Fiery необходимо выполнить дополнительные действия.
Чтобы приложения Fiery могли управлять обновлениями и получать доступ к таким файлам, как
шаблоны Impose и Hot Folders, в macOS необходимо внести изменения в функцию безопасности Полный
доступ к диску. Включите Полный доступ к диску для приложений Fiery, таких как Fiery Command
WorkStation.

1 Закройте все приложения Fiery.

2 Выберите Системные настройки > Безопасность и конфиденциальность > Конфиденциальность >
Полный доступ к диску.

3 Нажмите значок замка в нижнем левом углу и введите пароль.

4 В списке приложений установите флажок рядом с com.efi.InstallerHelperTool.

5 Нажмите кнопку +.

6 В папке "Программы" выберите Fiery Software Manager и Fiery Software Uninstaller, а затем нажмите
Открыть.
Для обслуживания и обновления приложений Fiery этим приложениям требуется полный доступ к
диску.

7 В папке "Программы" выберите приложение Fiery Command WorkStation и нажмите Открыть.
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8 Если используется Fiery Hot Folders или Fiery Remote Scan, выберите каждое приложение и нажмите
Открыть.
Когда Fiery Hot Folders обнаруживает, что используются папки "Документы", "Рабочий стол" или
"Загрузки", будет показано сообщение с запросом на полный доступ к диску. Это сообщение
отображается даже после предоставления доступа. Можно закрыть это сообщение и продолжить
работу.

Преобразование PS в PDF

Если используется macOS 10.14.5 или более поздней версии с Fiery Impose, Fiery Compose или Fiery
JobMaster, может быть показан запрос на предоставление доступа Fiery Command WorkStation к Acrobat
Distiller. Это разрешение необходимо для преобразования файлов PS в PDF. Если разрешение не будет
предоставлено, преобразования не будут выполняться и потребуется изменить настройку безопасности
функции автоматизации в macOS.

1 Закройте все приложения Fiery.

2 Закройте Acrobat Distiller.

3 Перейдите в Системные настройки > Безопасность и конфиденциальность > Конфиденциальность >
Автоматизация.

4 Нажмите значок замка в нижнем левом углу и введите пароль.

5 В списке приложений найдите Fiery Command WorkStation.app.

6 Выберите параметр Acrobat Distiller.app.
Это позволит Fiery Command WorkStation получить доступ к Acrobat Distiller.

Настройка предпочтений в Adobe Acrobat Distiller для преобразования PostScript в
PDF

В Fiery Impose, Fiery Compose и Fiery JobMaster для преобразования файлов PostScript (PS) в PDF на
клиентском компьютере требуется Acrobat Distiller.
Поскольку в Acrobat Distiller используются расширенные настройки безопасности, необходимо подтвердить,
что преобразуемый файл PS получен из надежного источника: Acrobat Distiller > Файл > Предпочтения >
Предпочтения — Acrobat Distiller, в разделе Защита выберите Все открытые в Acrobat Distiller файлы надежные.

Примечание: Если настройка Все открытые в Acrobat Distiller файлы надежные отключена, то для каждого
файла PS, преобразуемого в PDF, будет запрашиваться подтверждение надежности его источника. Это также
относится и к Hot Folders, если активен фильтр Microsoft Office, в списке Тип выходного файла выбран формат
PDF, а в качестве профиля Distiller используется файл joboptions.

Spot Pro

Специальные цвета

Специальные цвета не профилируются, а функция Применить к ограничена значениями CMYK на
устройстве.
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Округление значений плашечных цветов

После определения плашечного цвета и перезапуска Spot Pro значения некоторых цветов могут немного
отличаться от введенных исходных значений. Это связано с числовым округлением, выполненным Spot
Pro, и не должно приводить к заметным изменениям цвета.

Режим измерения M3

Режим M3 не поддерживается для устройств с одним измерением.
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Informacje o wersji dla klientów
Fiery Command WorkStation Package, wersja 6.8

Ten dokument zawiera ważne informacje dotyczące tej wersji. Informacje te należy koniecznie przekazać wszystkim
użytkownikom przed kontynuowaniem instalacji.

Informacje dotyczące tej wersji

W tej wersji dostępne są następujące aplikacje:

• Fiery Command WorkStation Package w wersji 6.8.0.615

• Fiery Command WorkStation w wersji 6.8.0.54 dla systemu Windows

• Fiery Command WorkStation w wersji 6.8.0.55 dla komputerów Mac

• Fiery Hot Folders w wersji 4.3.1.05

• Fiery Software Manager w wersji 6.8.0.11 dla systemu Windows

• Fiery Software Manager w wersji 6.8.0.12 dla komputerów Mac

Nowe funkcje

Co nowego?

Aby uzyskać informacje na temat nowych funkcji dodanych w początkowym wydaniu wersji 6.8, odwiedź witrynę 
http://fiery.efi.com/CWS/Whats-New.

Wyświetlanie podglądu efektów edycji krzywej rastra

W przypadku wszystkich zewnętrznych serwerów Fiery servers i użyciu funkcji Właściwości zadania do
zastosowania edycji krzywej rastra do zadania wyniki dla przetworzonych zadań wyświetlane są w aplikacji Fiery
Preview.
W przypadku serwerów wbudowanych Fiery servers zmiany krzywej rastra dla przetworzonych zadań
wyświetlane są w aplikacji Fiery Preview tylko wtedy, gdy włączony jest pakiet Fiery ColorRight Package lub
Fiery Productivity Package.

http://fiery.efi.com/CWS/Whats-New


Raport dotyczący optymalizacji kolorów dodatkowych

W programie Fiery Spot Pro można teraz zapisać raport dotyczący optymalizacji kolorów dodatkowych jako plik
HTML.

Powiadomienia kopii zapasowej obrazu systemu Fiery

Kopia zapasowa obrazu systemu Fiery powiadomi użytkownika, gdy tworzenie kopii zapasowej zakończy się
niepowodzeniem i zostanie ona wymieniona w obszarze Powiadomienia programu Fiery Command
WorkStation.

• Można zmienić harmonogram tworzenia kopii zapasowej w obszarze Zarządzaj ustawieniami >
Przywracanie systemu Fiery.

• Aby ukryć powiadomienie, kliknij ikonę więcej (trzy kropki) i wybierz opcję Ukryj.

Przycisk Zamknij w oknie Co nowego

Okno Co nowego pojawia się po zainstalowaniu i otwarciu najnowszej wersji programu Fiery Command
WorkStation po raz pierwszy. Teraz można użyć przycisku Zamknij w dolnej części okna Co nowego, nawet jeśli
rozdzielczość wyświetlania jest mniejsza niż obsługiwana.
Minimalne obsługiwane rozdzielczości wyświetlacza:

• 1280 x 1024 (arkusz)

• 1600 x 900 (szeroki i superwielkoformatowy)

Rozwiązane problemy

Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.615

Fiery Command WorkStation

• Pakiet Fiery Command WorkStation Package obsługuje obecnie czcionki chińskie zgodnie ze standardem
GB18030.

Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.541

Fiery Command WorkStation

• Po scaleniu dwóch plików PDF z opcją Scalaj wszystkie pliki przesłane jako folder w Fiery Hot Folders, plik
wydruku PDF nie wyświetlał się zgodnie z oczekiwaniami.

• Po wybraniu kalibracji powlekany - błyszczący podczas kalibracji serwera Fiery server pojawia się komunikat o
błędzie niezgodności gramatury papieru.

• Po utworzeniu wzorca dokumentu we właściwościach zadania dla zadania VDP w kolejce Wstrzymane i
kliknięciu opcji Podgląd wzorca dodawana była dodatkowa pusta strona.
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Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.514

Fiery Command WorkStation

• Po kliknięciu przycisku Zasoby > Spot Pro dla serwera Fiery server z oprogramowaniem systemowym FS200/200
Pro lub FS300/300 Pro lista kolorów dodatkowych i wartości kolorów dodatkowych nie były wyświetlane.

Fiery XF

• Nie można było zaktualizować profili nośnika za pomocą programu Narzędzie do aktualizacji profili Fiery po
uaktualnieniu serwera Fiery XF z wersji 7.3 do 7.3.3.

Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.466

Fiery Command WorkStation

• W systemie w języku hiszpańskim nie można było usunąć wybranego zadania z kolejki wstrzymanej poprzez
naciśnięcie klawisza Delete.

• Opcja Publikuj jako drukarkę wirtualną była wyświetlana w zakładce Ustawienia wstępne zadania w przypadku
wbudowanego serwera Fiery, na którym nie zainstalowano licencji dla drukarki wirtualnej.

• Nie można było utworzyć nowej wspólnej kalibracji przy użyciu zautomatyzowanego czujnika wbudowanego w
przypadku kilku drukarek z opcją Dopasowanie drukarki w programie Fiery Color Profiler Suite.

Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.439

Fiery Command WorkStation

• Nie można było zapisać wybranego wpisu z wykazu papieru dla zadania w oknie Definiuj nośnik dla przekładki.

• W niektórych systemach w języku japońskim liczba kopii zadania kalibracji była nieprawidłowa.

Fiery XF

• W Job Editor rozmiar strony wyświetlany dla zadania PDF ze znacznikami cięcia był nieprawidłowy.

Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.406

Fiery Command WorkStation

• Nie można było skalibrować maszyny drukarskiej za pomocą opcji automatycznej korekcji niezgodności
kolorów.

• Podczas próby usunięcia punktu krzywej po zmodyfikowaniu przetworzonego zadania w aplikacji
ImageViewer > Dostosowanie kolorówwybrana strona była usuwana. Strona została przywrócona po kliknięciu
przycisku Przywróć. Nie można było jednak kontynuować edycji bez ponownego uruchomienia procesu edycji.
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Fiery XF

• Nie można było zapisać niektórych opcji drukowania nośnika w narzędziu Server Manager w przypadku maszyn
drukarskich VUTEk h5.

• Po wybraniu dowolnego paska nośników w obszarze Job Editor > Zweryfikuj > Paski kontrolnedocelowa
tolerancja ustawienia wstępnego została zmieniona na Niestandardowe.

Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.385

Fiery XF

• Podczas kafelkowania zadania, klej i nakładające się obszary nie były uwzględniane przy obliczaniu rozmiaru
zadania dla pojedynczego kafelka.

Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.366

Fiery Command WorkStation

• W przypadku Fiery Spot Pro wskaźniki ∆E w gamie i poza gamą nie były jednakowe dla kolorów dodatkowych,
nawet po zdefiniowaniu tolerancji w oknie dialogowym Preferencje.

• Po zdefiniowaniu koloru specjalnego i ponownym otwarciu Fiery Spot Pro wartości separacji koloru specjalnego
nie były zachowywane.

• W przypadku wybrania szablonu Impose we właściwościach zadania nie można było zdefiniować ustawień
strony okładki dla nowego folderu podręcznego.

Fiery XF

• W przypadku narzędzia Color Tools podczas próby utworzenia podstawowego pliku linearyzacji dla maszyny
drukarskiej Seiko M64s wyświetlany był komunikat o błędzie.

• W przypadku narzędzia Color Tools, gdy wybrano inne opcje nośników z listy i kliknięto przycisk Drukuj podczas
ponownej kalibracji, wymiar tablicy pomiarowej nieoczekiwanie się zmniejszał.

Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.333

Fiery Command WorkStation

• W Fiery ImageViewer, po wybraniu opcji drukowania Bieżąca dla kolejnej strony, gdy pierwsza strona zadania
znajdowała się w kolejce drukowania, pojawił się komunikat o błędzie.

• W przypadku użycia różnych wpisów Paper Catalog do zdefiniowania nośnika broszury w Fiery Impose i
nośnika strony okładki w Command WorkStation, pierwszy arkusz zadania został wydrukowany z
nieprawidłowymi ustawieniami strony okładki. Jednak pozostałe arkusze zostały wydrukowane z ustawieniami
nośnika broszury.

• Nie można było określić jednostki miary w opcji przesunięcia obrazu poza 0,29 milimetra lub jej wartości
równoważnej w calach i punktach.
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• W Command WorkStation z językiem wyświetlania jako niemiecki nie można było ponownie skalibrować
zestawu kalibracji, jeśli w zadaniu użyto jednego z następujących elementów:

• niestandardowy rozmiar papieru

• niestandardowy rozmiar papieru i włączone APPE

Fiery XF

• W przypadku próby przeprowadzenia kalibracji z poziomu programu Command WorkStation w systemie
macOS 13 (Color Tools > Utwórz kalibrację) elementy sterujące w panelu po lewej stronie nie były widoczne,
dlatego nie można było użyć kalibracji.

• Po zdefiniowaniu rozmiaru niestandardowego nośnika w menu Job Editor > Drukarka > Formatmarginesy
sprzętowe maszyny drukarskiej nie były wyświetlane w podglądzie zadania.

Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.277

Fiery Command WorkStation

• W systemie macOS 13 z zainstalowanym programem Command WorkStation i aplikacją Fiery Hot Folders po
wybraniu opcji Właściwości zadania > Układ > Impose > Edytuj szablon Impose nie można było zapisać zmian,
ponieważ następowało nieoczekiwane zamknięcie okna.

• W systemie macOS 13 nie można było uruchomić aplikacji Fiery Software Manager z poziomu widoku Aplikacje
i zasoby, jeśli aplikacja Fiery Software Manager była już uruchomiona.

• W systemie macOS 13 po zapisaniu raportu dotyczącego optymalizacji kolorów dodatkowych jako pliku HTML
logo EFI i Fiery nie były wyświetlane po otwarciu raportu w przeglądarce Safari.

• Po zapisaniu zdefiniowanego przez użytkownika szablonu rozmiaru wykończenia zawierającego znaki
dwubajtowe w rozwiązaniu Fiery Impose i zastosowaniu go do zadania z poziomu Właściwości zadania zamiast
wartości rozmiaru wykończenia zdefiniowanych przez użytkownika zaznaczane były wartości zdefiniowane dla
opcji rozmiaru wykończenia Zależnie od pola kadrowania.

• W aplikacji Fiery Preview dla okładki i stron tekstu głównego wyświetlane były te same ustawienia nośnika,
nawet jeśli w rozwiązaniu Fiery Impose określono różne ustawienia nośnika dla okładki i stron tekstu głównego.

• Po kliknięciu karty Nośniki w widoku Właściwości zadania i przewinięciu w dół do pozycji Różne nośniki niektóre
opcje nośników nie były wyświetlane dla zadania.

Fiery XF

• Po skonfigurowaniu urządzenia wykańczania Zund w aplikacjach Server Manager i Job Editor jedyną dostępną
metodą cięcia była metoda DumDum.

• W przypadku zagnieżdżonego zadania wielostronicowego po wybraniu położenia Góra i dół dla kodu
kreskowego na karcie Wykończenie część kodu kreskowego u dołu wyświetlana była poza układem nośnika, a
plik nie był drukowany.
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Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.217

Fiery Command WorkStation

• Po kliknięciu przycisku Dalej w oknie Układ pól kontrolnych podczas ponownej kalibracji Fiery server, w
programie Fiery Calibrator był ponownie wyświetlany ten sam Układ pól kontrolnych, a tablica pomiarowa nie
była drukowana. Ten problem występował po ustawieniu języka Fiery server i Fiery Command WorkStation na
język francuski.

• W Fiery ImageViewer w przypadku zmodyfikowania krzywej w okienku Dostosowanie kolorów dla zadania
druku monochromatycznego i próby zapisania go jako ustawienia wstępnego pojawiał się komunikat o błędzie.

Fiery XF

• Po usunięciu niestandardowej metody cięcia w oknie Wycinanie konturu wszystkie niestandardowe metody
cięcia były usuwane z listy.

• Po wybraniu stołu do cięcia Esko nie można było zdefiniować niestandardowej metody cięcia.

• Nie można było wykonać drukowania bez obramowania w przypadku maszyn drukarskich z serii Canon PRO w
przypadku zdefiniowania niestandardowego rozmiaru nośnika.

Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.184

Fiery Command WorkStation

• Po utworzeniu kalibracji w programie Calibrator opcja Wygeneruj dane ACD po kalibracji była zaznaczona dla
obsługiwanych maszyn drukarskich.

Fiery XF

• Po utworzeniu biblioteki kolorów dodatkowych przy użyciu narzędzia Color Editor połączonym z serwerem Fiery
XF wartości kolorów nie były zapisywane. Ponadto w przypadku ponownego importowania tej samej biblioteki
wartości nie były zachowywane dla niestandardowych kolorów dodatkowych CMYKRB, CMYKOB i CMYKRV.

Problemy rozwiązane w Fiery Command WorkStation Package w wersji 6.8.0.165

Fiery Command WorkStation

• Po utworzeniu kalibracji dla Fiery server, dla którego nie włączono opcji ACD, program Fiery Calibrator nadal
otwiera narzędzie WebTools do generowania danych ACD.

• Po utworzeniu nowego folderu Fiery Hot Folder i wybraniu opcji Zdefiniuj... w celu określenia ustawień zadania
okno Właściwości zadania nie zostało otwarte.

• Wyświetlenie podglądu w okienku Widok arkusza programu Fiery Preview w przypadku niektórych zadań PDF z
impozycją trwało dłużej niż zwykle.

• Na komputerze z systemem Windows komunikat o wycofaniu wsparcia pojawił się w oknie Fiery Impose w wersji
demonstracyjnej zamiast w oknie Zarządzaj opcjami Fiery.
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• W przypadku zadania o wielkości 1000 stron, w oknie Właściwości zadania > Wykończenie, jeśli włączono opcję
drukowania Przekładki dla każdej 100 kopii, przekładka została wstawiona przed każdą jedną kopią.

• Podczas próby otwarcia programu Fiery Command WorkStation i nawiązania połączenia z serwerami Fiery
servers, podczas gdy serwer aktualizacji EFI znajdował się w trybie offline, kolejki zadań wczytywały się kilka
minut.

Fiery XF

• Po wybraniu Ustawienia wstępnego docelowych wartości tolerancji jako Niestandardowe w programie Server
Manager, wartość formuły różnicy barw (delta E) pojawiła się jako dE 2000, która była nieprawidłowa. Jednak w
programie Job Editor wartość formuły różnicy barw (delta E) została prawidłowo wyświetlona jako dE CIE76.

Uaktualnianie

Za pomocą tego instalatora można uaktualnić dowolny istniejący pakiet Fiery Command WorkStation Package do
najnowszej wersji zawierającej aplikacje Fiery Command WorkStation oraz Fiery Hot Folders. Można także
zainstalować program Fiery Remote Scan przy użyciu narzędzia Fiery Software Manager.
Więcej informacji na temat specyfikacji technicznych można znaleźć na stronie www.efi.com/cws.

Aktualizacje wymagań systemowych

Obsługiwane wersje

Program Fiery Command WorkStation w wersji 6.8 obsługuje oprogramowanie systemowe Fiery FS150/FS150 Pro
lub nowsze zainstalowane na serwerze Fiery server.
Aplikacja Fiery Command WorkStation obsługuje następujące systemy operacyjne:

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11 (wersja 64-bitowa)

• Windows 10, wersja 64-bitowa

• Windows Server 2022, wersja 64-bitowa

• Windows Server 2019, wersja 64-bitowa

• Windows Server 2016, wersja 64-bitowa

Uwaga: Program Fiery Command WorkStation oferuje obsługę oprogramowania Rosetta dla komputerów macOS z
układem M1. Więcej informacji na stronie https://www.efi.com/marketing/fiery-servers-and-software/campaigns/
macos-big-sur-compatibility/.
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Znane problemy

macOS 13

Adobe Acrobat w systemie macOS 13

Ponieważ firma Adobe nie zapewnia jeszcze pełnej obsługi oprogramowania Adobe Acrobat w systemie macOS
13, pojawiają się następujące problemy:

• Programu Adobe Acrobat nie można uruchomić z poziomu systemu macOS 13 na komputerach z
procesorami M1 i M2.

• W przypadku komputerów z procesorami firmy Intel program Adobe Acrobat wyświetla okno logowania,
nawet jeśli użytkownik jest już zalogowany. Po zamknięciu okna logowania program Acrobat działa
prawidłowo.

Kalibracja niedostępna w przypadku serwera Fiery XF

W przypadku próby przeprowadzenia kalibracji z poziomu programu Command WorkStation w systemie
macOS 13 (Color Tools > Utwórz kalibrację) elementy sterujące w panelu po lewej stronie nie są widoczne,
dlatego nie można użyć kalibracji.

macOS w wersji 10.15 i nowszych

Pełny dostęp do dysku

Ze względu na zmiany w sposobie zarządzania zabezpieczeniami w systemie macOS 10.15 lub nowszym istnieją
teraz dodatkowe kroki wymagane do poprawnego działania aplikacji Fiery.
Konieczne jest dokonanie zmian w funkcji zabezpieczenia Pełny dostępu do dysku w systemie macOS, aby
aplikacje Fiery zarządzały aktualizacjami i uzyskiwały dostęp do plików, takich jak szablony Impose i foldery
podręczne. Włącz pełny dostęp do dysku dla aplikacji Fiery, w tym Fiery Command WorkStation.

1 Zamknij wszystkie aplikacje Fiery.

2 Przejdź do menu Preferencje systemowe > Bezpieczeństwo i prywatność > Prywatność > Pełny dostęp do
dysku.

3 Kliknij ikonę kłódki w lewym dolnym rogu i wprowadź swoje hasło.

4 Na liście aplikacji zaznacz pole wyboru obok opcji com.efi.InstallerHelperTool.

5 Kliknij przycisk +.

6 W folderze Aplikacje wybierz Fiery Software Manager i Fiery Software Uninstaller, a następnie kliknij
Otwórz.
Aplikacje te wymagają pełnego dostępu do dysku w celu utrzymania i zaktualizowania aplikacji Fiery na
komputerze.

7 W folderze Aplikacje wybierz aplikację Fiery Command WorkStation i kliknij Otwórz.
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8 Jeżeli korzystasz z Fiery Hot Folders lub Fiery Remote Scan, wybierz każdą aplikację i kliknij Otwórz.
Jeśli Fiery Hot Folders wykryje, że używane są foldery Dokumenty, Pulpit i Pobrane, zostanie wyświetlony
komunikat z prośbą o pełny dostęp do dysku. Ten komunikat jest nadal wyświetlany nawet po przydzieleniu
dostępu. Można zignorować ten komunikat i kontynuować pracę.

Konwersja plików PS do PDF

W przypadku korzystania z systemu macOS 10.14.5 lub nowszego z oprogramowaniem Fiery Impose, Fiery
Compose lub Fiery JobMaster, może zostać wyświetlony monit o zezwolenie aplikacji Fiery Command WorkStation
na dostęp do programu Acrobat Distiller. To zezwolenie jest niezbędne do konwersji plików PS do formatu PDF. Jeśli
nie udzieli się tego zezwolenia, konwersje nie powiodą się i będzie konieczna zmiana funkcji zabezpieczającej
Automatyzacja w systemie macOS.

1 Zamknij wszystkie aplikacje Fiery.

2 Zamknij program Acrobat Distiller.

3 Przejdź do Preferencje systemowe > Bezpieczeństwo i prywatność > Prywatność > Automatyzacja.

4 Kliknij ikonę kłódki w lewym dolnym rogu i wprowadź swoje hasło.

5 Na liście Aplikacje znajdź Fiery Command WorkStation.app.

6 Wybierz opcję Acrobat Distiller.app.
Dzięki temu oprogramowanie Fiery Command WorkStation będzie miało dostęp do programu Acrobat Distiller.

Konfigurowanie preferencji w programie Adobe Acrobat Distiller w celu konwersji formatu
PostScript do PDF

Aplikacje Fiery Impose, Fiery Compose i Fiery JobMaster wymagają programu Acrobat Distiller do konwertowania
plików PostScript (PS) na pliki PDF na komputerze klienckim.
Ze względu na rozszerzone ustawienia zabezpieczeń w programie Acrobat Distiller należy potwierdzić, że plik PS do
konwersji pochodzi z zaufanego źródła. W sekcji: Acrobat Distiller > Plik > Preferencje > Preferencje — Acrobat
Distillerwybierz opcję Zaufaj wszystkim plikom otwartym za pośrednictwem programu Acrobat Distiller w obszarze
Zabezpieczenia.

Uwaga: Jeśli nie wybrano opcji Ufaj wszystkim plikom otwieranym za pośrednictwem programu Acrobat Distiller,
monit o potwierdzenie, że plik pochodzi z zaufanego źródła będzie wyświetlany dla każdego pliku PS, który ma
zostać skonwertowany do formatu PDF. Dotyczy to również aplikacji Hot Folders, gdy wybrany jest filtr Microsoft
Office, Typ pliku wydruku określono jako PDF, a plik joboptions wybrano jako profil Distiller.

Spot Pro

Kolory specjalne

Kolory specjalne nie są profilowane, a funkcja Zastosuj do jest ograniczona tylko do tylko wartości CMYK
urządzenia.
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Zaokrąglanie wartości kolorów dodatkowych

Po zdefiniowaniu koloru dodatkowego i ponownym uruchomieniu Spot Pro wartości niektórych kolorów mogą
różnić się nieznacznie od wprowadzonych wartości oryginalnych. Jest to spowodowane zaokrągleniem
liczbowym, którego dokonuje program Spot Pro. Nie spowoduje to widocznych zmian w kolorach.

Tryb pomiaru M3

Tryb M3 nie jest obsługiwany w przypadku urządzeń z pojedynczym pomiarem.

Informacje o wersji dla klientów

Fiery Command WorkStation Package, wersja 6.8

121



Müşteri Sürüm Notları
Fiery Command WorkStation Package, sürüm 6.8

Bu belgede bu sürüm hakkında önemli bilgiler bulunmaktadır. Yükleme işlemine devam etmeden önce tüm
kullanıcılara bu bilgileri sağladığınızdan emin olun.

Sürüm içeriği

Aşağıdaki uygulamalar bu sürüme dahil edilmiştir:

• Fiery Command WorkStation Package v6.8.0.615

• Windows v6.8.0.54 için Fiery Command WorkStation

• Mac v6.8.0.55 için Fiery Command WorkStation

• Fiery Hot Folders v4.3.1.05

• Windows v6.8.0.11 için Fiery Software Manager

• Mac v6.8.0.12 için Fiery Software Manager

Yeni özellikler

Yenilikler

6.8 ögesinin ilk sürümüne eklenmiş olan yeni özellikler hakkında bilgi için http://fiery.efi.com/CWS/Whats-New
adresini ziyaret edin.

Tarama eğrisi düzenleme efektlerini önizleme

Tüm harici Fiery servers için, bir işe tarama eğrisi düzenleme uygulamak için İş özellikleri seçeneğini
kullandığınızda işlenmiş işler için sonuçlar Fiery Preview uygulamasında görüntüleniyor.
Tümleşik Fiery servers için, bir işe yapılan tarama eğrisi düzenlemeleri, yalnızca Fiery ColorRight Package veya
Fiery Productivity Package etkinleştirildiğinde işlenmiş işler için Fiery Preview uygulamasında görüntüleniyor.

Nokta rengi optimizasyonu raporu

Fiery Spot Pro ögesinde artık nokta rengi optimizasyon raporunu HTML dosyası olarak kaydedebilirsiniz.

http://fiery.efi.com/CWS/Whats-New


Fiery System Görüntü yedekleme bildirimleri

Fiery System görüntüsünün yedeğinin, bir yedekleme başarısız olduğunda ve Fiery Command WorkStation
ögesinde Bildirimler altında listelendiğinde bilgisi görünecektir.

• Ayarları Yönet > Fiery sistem Geri Yüklemesi'ndenyedeklemeyi yeniden zamanlayabilirsiniz.

• Bildirimi gizlemek için Daha fazla simgesine (üç nokta) tıklayın ve Gizle'yi seçin.

Yenilikler penceresi için kapat düğmesi

Fiery Command WorkStation en son sürümünü ilk kez yükleyip açtığınızda Yenilikler penceresi görüntülenir.
Artık ekran çözünürlüğü desteklenen çözünürlükten az olsa bile Yenilikler penceresinin altındaki Kapat
düğmesini kullanabilirsiniz.
Desteklenen minimum ekran çözünürlükleri:

• 1280 x 1024 (tabaka kağıt)

• 1600 x 900 (geniş ve süper geniş)

Düzeltilen sorunlar

Fiery Command WorkStation Package v6.8.0.615 sürümünde düzeltilen sorunlar

Fiery Command WorkStation

• Fiery Command WorkStation Package artık GB18030 standardına uygun olarak Çince yazı tiplerini destekler.

Fiery Command WorkStation Package v6.8.0.541 ile giderilen sorunlar

Fiery Command WorkStation

• Fiery Hot Folders ögesinde Klasör seçenek olarak gönderildiyse tüm dosyaları birleştir öğesiyle iki PDF dosyasını
birleştirdiğinizde çıktı PDF dosya beklendiği gibi görünmüyordu.

• Bir Fiery serverögesini kalibre ederken Kaplı-parlak kalibrasyonu seçtiğinizde bir kağıt ağırlığı uyumsuzluğu hata
mesajı belirdi.

• Tutma kuyruğundaki bir VDP iş için İş özellikleri'nde bir ana kopya belge oluşturduğunuzda ve Ana kopyayı
önizle seçeneğine tıkladığınızda, ek bir boş sayfa eklendi.
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Fiery Command WorkStation Package v6.8.0.514'te giderilen sorunlar

Fiery Command WorkStation

• FS200/200 Pro veya FS300/300 Pro sistem yazılımına sahip bir Fiery server içerisinde Kaynaklar ve > Spot Pro
seçeneklerine tıkladığınızda nokta renkleri listesi ve nokta rengi değerleri görünmüyordu.

Fiery XF

• Bir Fiery XF sunucusunu v7.3'ten v7.3.3'e yükselttiğinizde ortam profillerini Fiery Profil Güncelleyici ile
güncelleyemiyordunuz.

Fiery Command WorkStation Package v6.8.0.466 ile giderilen sorunlar

Fiery Command WorkStation

• İspanyolca dilindeki bir sistemde, Sil tuşuna basarak tutuldu kuyruğundan seçilen bir işi silemezsiniz.

• Sanal yazıcı lisansının yüklenmediği bir Fiery tümleşik sunucunun İş ön ayarları sekmesinde Sanal yazıcı olarak
yayınla seçeneği belirir.

• Fiery Color Profiler Suite'te bir otomatik satır içi sensör kullanarak Yazıcı eşleştirme seçeneği ile birden fazla
yazıcı için yeni bir ortak kalibrasyon oluşturamadınız.

Fiery Command WorkStation Package v6.8.0.439 ile giderilen sorunlar

Fiery Command WorkStation

• Kaydırma yaprağı için ortamı tanımla penceresinde bir iş için seçilen kağıt kataloğu girişi kaydedilemiyordu.

• Bazı Japonca sistemlerde, kalibrasyon işinin kopya sayısı yanlıştı.

Fiery XF

• Job Editor ögesinde kesme işaretlerine sahip PDF işi için görüntülenen sayfa boyutu hatalıydı.

Fiery Command WorkStation Package v6.8.0.406 ile giderilen sorunlar

Fiery Command WorkStation

• Renk Uyuşmazlığını Otomatik Düzelt seçeneği ile bir yazıcıyı kalibre edemediniz.

• ImageViewer > Renk Ayarlama'da işlenmiş bir işi değiştirdikten sonra bir eğri noktasını silmeye çalıştığınızda,
seçilen sayfa silindi. Geri dön'e tıkladıysanız sayfa geri yüklendi. Ancak, düzenleme işlemini yeniden başlatmadan
düzenlemeye devam edemezsiniz.

Fiery XF

• VUTEk h5 yazıcılar için Server Manager'da ortam için bazı yazdırma seçeneklerini kaydedemediniz.

• Job Editor  > Doğrula > Kontrol Çubukları'nda herhangi bir Ortam Wedge seçtiğinizde, hedef tolerans ön ayarı
Özel olarak değişti.

Müşteri Sürüm Notları

Fiery Command WorkStation Package, sürüm 6.8

124



Fiery Command WorkStation Package v6.8.0.385 ile giderilen sorunlar

Fiery XF

• Bir iş döşemek, tutkal ve çakışan alanlar, tek bir karo için iş boyutunun hesaplanmasında dikkate alınmadı.

Fiery Command WorkStation Package v6.8.0.366 ile giderilen sorunlar

Fiery Command WorkStation

• Tercihler iletişim kutusunda toleransı tanımlasanız bile Fiery Spot Pro'da nokta renkleri için skala içindeki ve
skala dışındaki ∆E endikasyonları tutarlı değildi.

• Bir tercih edilen renk tanımlayıp Fiery Spot Pro ögesini yeniden açtığınızda tercih edilen renk ayrım değerleri
korunmadı.

• İş özellikleri'nde bir Impose şablonu seçtiğinizde yeni bir çalışma klasörü için kapak sayfası ayarları
tanımlayamazsınız.

Fiery XF

• Color Tools'da, Seiko M64s yazıcı için bir temel doğrusallaştırma dosya oluşturmaya çalışırken bir hata mesajı
görüntülendi.

• Color Tools'da, listeden farklı Alt malzeme seçenekleri seçtiğinizde ve yeniden kalibrasyon sırasında Yazdır'a
tıkladığınızda ölçüm grafiği boyutu beklenmedik şekilde azaltıldı.

Fiery Command WorkStation Package v6.8.0.333'te düzeltilen sorunlar

Fiery Command WorkStation

• Fiery ImageViewer ögesinde, işin ilk sayfası Yazdırma kuyruğundayken bir sonraki sayfa için Geçerli yazdırma
seçeneğini belirlediğinizde bir hata mesajı görüntülendi.

• Fiery Impose ögesinde kitapçık alt malzemesini ve Command WorkStation ögesinde kapak sayfası alt
malzemesini tanımlamak için farklı kağıt kataloğu girişleri kullandığınızda, işin ilk yaprağı yanlış kapak sayfası
ayarlarıyla yazdırıldı. Ancak, yaprakların geri kalanı kitapçık ortam ayarlarıyla yazdırıldı.

• Görüntü kaydırma seçeneğinde ölçüm birimini 0,29 milimetrenin veya inç ve punto cinsinden karşılı olan
değerin üstünde belirtemezsiniz.

• Görüntüleme dili Almanca olan Command WorkStation ögesinde, iş aşağıdakilerden birini kullanıyorsa bir
kalibrasyon setini yeniden kalibre edemezsiniz:

• özel kağıt boyutu

• özel kağıt boyutu ve etkin APPE

Fiery XF

• macOS 13'te Command WorkStation ögesinden kalibre etmeye çalıştığınızda (Color Tools > Kalibrasyon oluştur)
sol panel kontrolleri görülemediği için kalibrasyon kullanılamıyordu.

• Job Editor > Yazıcı > Biçim üzerinde özel ortam boyutu tanımladığınızda, yazıcı donanımı kenar boşlukları iş
önizlemesinde görüntülenmedi.
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Fiery Command WorkStation Package v6.8.0.277 ile giderilen sorunlar

Fiery Command WorkStation

• Command WorkStation ve Fiery Hot Folders ögeleri bulunan macOS 13 cihazlarında İş Özellikleri > Düzen >
Impose > Impose şablonlarını düzenle yolunu izlediğinizde pencere beklenmedik bir şekilde kapandığı için
değişiklikler kaydedilemiyordu.

• macOS 13'te, Fiery Software Manager zaten çalışıyorsa Uygulamalar ve kaynaklar bölümünden Fiery Software
Manager ögesi başlatılamıyordu.

• macOS 13'te nokta rengi optimizasyon raporunu HTML dosyası olarak kaydettiğinizde, raporu Safari'de
açtıysanız EFI ve Fiery logoları mevcut değildi.

• Fiery Impose ögesinde çift bayt karakterler içeren bir Kullanıcı Tanımlı son boyut şablonu kaydettiğinizde ve bunu
İş Özellikleri bölümünden bir işe uyguladığınızda, Kullanıcı Tanımlı son boyut değerleri yerine Kırpma Kutusuna
Göre seçeneği için tanımlanmış son boyut değerleri seçilmiş oluyordu.

• Fiery Preview ögesinde, Fiery Impose üzerinde kapak ve gövde sayfaları için farklı ortam ayarları belirlemiş
olmanıza rağmen kapak ve gövde sayfalarında aynı ortam ayarları görüntüleniyordu.

• İş Özellikleri bölümünde Ortam sekmesine tıklayıp Karma ortam kısmına kaydırdığınızda iş için bazı ortam
seçenekleri görüntülenmiyordu.

Fiery XF

• Server Manager ve Job Editor'da bir Zund sonlandırma cihazı kurulumu yaptığınızda kullanılabilen tek kesim
yöntemi DumDum'du.

• Sonlandırma sekmesinden iç içe yerleştirilmiş çok sayfalı bir iş için Üst ve Alt barkod konumunu seçtiğinizde
aşağıda yer alan barkod ortam düzeninin dışında yer alıyordu ve dosya yazdırılamıyordu.

Fiery Command WorkStation Package v6.8.0.217 ile giderilen sorunlar

Fiery Command WorkStation

• Fiery server ögesi yeniden kalibre edilirken Düzeltme eki düzeni penceresinde İleri seçeneğine tıkladığınızda
Fiery Calibrator tekrar aynı Düzeltme eki düzenini gösteriyordu ve ölçüm grafiğini yazdırmıyordu. Bu sorun, Fiery
server ve Fiery Command WorkStation için dil seçeneğini Fransızca olarak belirlediğinizde ortaya çıkıyordu.

• Fiery ImageViewer ögesinde, tek renkli bir iş için Renk ayarlama bölmesinde eğriyi düzenlediğinizde ve ön ayar
olarak kaydetmeye çalıştığınızda bir hata mesajı karşınıza çıkıyordu.

Fiery XF

• Kontur kesme penceresindeki özel bir kesme yöntemini sildiğinizde, tüm özel kesme yöntemleri listeden
siliniyordu.

• Esko kesme tablosunu seçtiğinizde özel bir kesme yöntemi tanımlayamıyordunuz.

• Özel bir ortam boyutu tanımladığınızda Canon PRO serisi yazıcılarda kenarlıksız yazdırma işlemi
gerçekleştiremiyordunuz.

Müşteri Sürüm Notları

Fiery Command WorkStation Package, sürüm 6.8

126



Fiery Command WorkStation Package v6.8.0.184 ile giderilen sorunlar

Fiery Command WorkStation

• Kalibratör'de, yeniden kalibrasyon tamamlandıktan sonra, desteklenen yazıcılar için Kalibrasyondan sonra ACD
Verisi Oluştur seçeneği işaretlendi.

Fiery XF

• Fiery XF sunucusuna bağlı Color Editor'ı kullanarak nokta rengi kitaplığı oluşturduğunuzda, renk değerleri
kaydedilmedi. Buna ek olarak, aynı kitaplığı tekrar içe aktardıysanız, CMYKRB, CMYKOB ve CMYKRV özel
nokta renkleri için değerler korunmadı.

Fiery Command WorkStation Package v6.8.0.165 ile giderilen sorunlar

Fiery Command WorkStation

• ACD seçeneğinin etkinleştirilmediği bir Fiery server için kalibrasyon oluşturduğunuzda Fiery Calibrator ACD
veri oluşturma işlemi için yine de WebTools öğesini açıyordu.

• Yeni bir Fiery Hot Folder oluşturduğunuzda ve iş ayarlarını belirtmek için Tanımla'yı seçtiğinizde İş Özellikleri
penceresi açılmıyordu.

• Yüklenen bazı PDF işleri için Fiery Preview Yaprak Görünümü bölmesinde önizlemenin görüntülenmesi
normalden uzun sürüyordu.

• Bir Windows bilgisayarda Fiery Impose Demo penceresinde Fiery seçeneklerini yönet penceresi yerine
durdurulmuş olan destekle ilgili bir mesaj görünüyordu.

• İş Özellikleri > Sonlandırma'da 1000 sayfalık bir işte her 100 kopya için Kaydırma yaprağı yazdırma seçeneğini
etkinleştirdiğinizde her bir tekli kopyadan önce kaydırma yaprağı yerleştiriliyordu.

• EFI güncellemeleri sunucusu çevrimdışıyken Fiery Command WorkStation öğesini açıp Fiery servers ile
bağlamaya çalıştığınızda iş akışlarının yüklenmesi birkaç dakika sürüyordu.

Fiery XF

• Server Manager'da Hedef toleransların ön ayarı ayarını Özel olarak seçtiğinizde Delta E biçimi değeri, yanlış
şekilde dE 2000 olarak görünüyordu. Ancak Job Editor içinde Delta E biçimi değeri doğru şekilde dE CIE76
olarak görünüyordu.

Yükseltme

Bu yükleyici tüm mevcut Fiery Command WorkStation Package ögesini Fiery Command WorkStation ve Fiery Hot
Folders içeren son pakete yükseltecektir. İsteğe bağlı olarak, Fiery Software Manager ögesini kullanarak Fiery Remote
Scan'i yükleyebilirsiniz.
Teknik özellikler hakkında daha fazla bilgi için www.efi.com/cws adresini ziyaret edin.

Müşteri Sürüm Notları

Fiery Command WorkStation Package, sürüm 6.8

127

http://www.efi.com/cws


Sistem gereksinimleri güncellemeleri

Desteklenen sürümler

Fiery Command WorkStation sürüm 6.8, Fiery server üzerinde yüklü Fiery sistem yazılımı FS150/FS150 Pro yazılımı
ve daha üst sürümleri destekler.
Fiery Command WorkStation ögesi, bilgisayarınız için şu işletim sistemlerini destekler:

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11 (64 bit)

• Windows 10, 64-bit

• Windows Sunucu 2022 (64-bit)

• Windows Sunucu 2019, 64-bit

• Windows Sunucu 2016, 64-bit

Not: Fiery Command WorkStation, M1 çipli macOS bilgisayarlar için Rosetta desteği sunar. Daha fazla bilgi için
şurayı ziyaret edin: https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-sur-
compatibility/

Bilinen sorunlar

macOS 13

macOS 13'te Adobe Acrobat

Adobe, macOS 13'te Adobe Acrobat için henüz tam destek sunmadığından aşağıdaki sorunlarla karşılaşırsınız:

• M1 ve M2 işlemcilerde macOS 13'ten Adobe Acrobat başlatılamıyor.

• Intel işlemcilerde, önceden oturum açmış olsanız dahi Adobe Acrobat oturum açma penceresini görüntüler.
Oturum açma penceresini kapatın ve Acrobat normal olarak çalışmaya devam edecektir.

Fiery XF sunucusunda kalibrasyon kullanılamıyordu

macOS 13'te Command WorkStation üzerinde kalibre etmeye çalıştığınızda (Color Tools > Kalibrasyon oluştur)
sol panel kontrolleri görülemediği için kalibrasyon kullanılamıyor.

Müşteri Sürüm Notları

Fiery Command WorkStation Package, sürüm 6.8

128

https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-sur-compatibility/
https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-sur-compatibility/


macOS 10.15 ve üstü

Tam disk erişimi

macOS 10.15'in veya sonraki sürümlerin güvenliği yönetme şeklindeki değişiklikler nedeniyle Fiery
uygulamalarının düzgün çalışabilmesi için gerekli ek adımlar ortaya çıktı.
Fiery uygulamaların güncellemeleri yönetmesi ve Impose şablonları ve çalışma klasörleri gibi dosyalara erişmesi
için macOS'deki Tam disk erişimi güvenlik özelliği üzerinde değişiklik yapmanız gerekir. Fiery Command
WorkStation gibi Fiery uygulamaları için Tam disk erişimi'ni etkinleştirin.

1 Tüm Fiery uygulamalarını kapatın.

2 Sistem tercihleri > Güvenlik ve gizlilik > Gizlilik > Tam disk erişimi'ne gidin.

3 Sol alt köşedeki Kilitle simgesine tıklayın ve şifrenizi girin.

4 Uygulamalar listesinde com.efi.InstallerHelperTool ögesinin yanındaki onay kutusunu işaretleyin.

5 + düğmesine tıklayın.

6 Uygulamalar klasöründe Fiery Software Manager ve Fiery Software Uninstaller seçimini yapın ve Aç'a
tıklayın.
Bu uygulamalar, bilgisayarınızdaki Fiery uygulamalarını korumak ve güncellemek için tam disk erişimi
gerektirir.

7 Uygulamalar klasöründe Fiery Command WorkStation ögesini seçin ve Aç'a tıklayın.

8 Fiery Hot Folders veya Fiery Remote Scan kullanıyorsanız her uygulamayı seçin ve Aç'a tıklayın.
Fiery Hot Folders, Belgeler, Masaüstü ve İndirilenler klasörlerinin kullanıldığını algılarsa tam disk erişimi
isteyen bir mesaj verir. Bu mesaj erişim izni verildikten sonra bile görüntülenir. Bu mesajı kapatabilir ve
çalışmaya devam edebilirsiniz.

PSʼden PDFʼye dönüştürme

macOS 10.14.5 veya sonraki sürümlerle birlikte Fiery Impose, Fiery Compose veya Fiery JobMaster kullanıyorsanız
Fiery Command WorkStation ögesine Acrobat Distiller erişimi izni vermeniz istenebilir. Bu izin, PS dosyalarının
PDF'ye dönüştürülmesi için gereklidir. İzin vermezseniz dönüştürmeler başarılı olmaz ve macOS'taki Otomasyon
güvenlik özelliğini değiştirmeniz gerekir.

1 Tüm Fiery uygulamalarını kapatın.

2 Acrobat Distiller'ı kapatın.

3 Şu bölüme gidin: Sistem Tercihleri > Güvenlik ve gizlilik > Gizlilik > Otomasyon.

4 Sol alt köşedeki Kilitle simgesine tıklayın ve şifrenizi girin.

5 Uygulamalar listesinde Fiery Command WorkStation.app'ı bulun.

6 Acrobat Distiller.app seçeneğini seçin.
Bu Fiery Command WorkStation ögesine Acrobat Distiller erişimi sağlar.
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PostScript'ten PDF'ye dönüştürme için Adobe Acrobat Distillerʼdeki Tercihleri ayarlama

Fiery Impose, Fiery Compose ve Fiery JobMaster, istemci bilgisayarda PostScript (PS) dosyalarını PDF'ye
dönüştürmek için Adobe Distiller gerektirir.
Acrobat Distiller'daki iyileştirilmiş güvenlik ayarları nedeniyle dönüştürülecek PS dosyasının güvenilir bir kaynaktan
geldiğini onaylamanız gerekir: Acrobat Distiller > Dosya > Tercihler > Tercihler - Acrobat Distiller, Güvenlik altında
Acrobat Distiller tarafından açılan tüm dosyalara güven seçeneğini seçin.

Not: Acrobat Distiller tarafından açılan tüm dosyalara güven seçeneği seçili değilse PDF'ye dönüştürülecek her PS
dosyası için güvenilir bir kaynaktan geldiğini onaylamanız istenir. Bu durum Microsoft Office filtresi seçildiğinde,
Çıktı dosyası türü olarak PDFseçildiğinde ve Distiller profili olarak joboptions dosyası seçildiğinde Hot Folders için de
geçerlidir.

Spot Pro

Tercih edilen renkler

Özel renkler profili gösterilmez ve Uygula özelliği yalnızca cihaz CMYK değerleriyle sınırlıdır.

Nokta rengi değeri yuvarlama

Bir nokta rengi tanımlayıp Spot Pro'yu yeniden çalıştırdıktan sonra bazı renklerin değerleri girdiğiniz orijinal
değerlerden biraz farklı olabilir. Bunun nedeni, Spot Pro'nun gerçekleştirdiği sayısal yuvarlama işlemidir ve
renkte fark edilebilir bir görünür değişiklik olmaması gerekir.

M3 ölçüm modu

M3 modu, tek ölçüm cihazları için desteklenmiyor.
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Poznámky k verzi pro zákazníky
Fiery Command WorkStation Package, verze 6.8

Tento dokument obsahuje důležité informace o této verzi produktu. Než budete pokračovat v instalaci, nezapomeňte
tyto informace poskytnout všem uživatelům.

Informace o této verzi

Tato verze obsahuje následující aplikace:

• Fiery Command WorkStation Package v6.8.0.615

• Fiery Command WorkStation pro systém Windows v6.8.0.54

• Fiery Command WorkStation pro Mac v6.8.0.55

• Fiery Hot Folders v4.3.1.05

• Fiery Software Manager pro Windows v6.8.0.11

• Fiery Software Manager pro Mac v6.8.0.12

Nové funkce

Co je nového?

Informace o nových funkcích, které byly přidány v počátečním vydání verze 6.8, najdete na http://
fiery.efi.com/CWS/whats-new.

Náhled efektů úprav rastrové křivky

Použijete-li na úlohu u jakéhokoli externího serveru Fiery servers možnost Vlastnosti úlohy k úpravám rastrové
křivky, výsledky pro zpracované úlohy se zobrazí v nástroji Fiery Preview.
V případě vložených serverů Fiery servers se úpravy rastrové křivky v úloze zobrazí v aplikaci Fiery Preview pro
zpracované úlohy pouze v případě, že je povolena možnost Fiery ColorRight Package nebo Fiery Productivity
Package.

Sestava optimalizace přímých barev

V aplikaci Fiery Spot Pro můžete nyní uložit sestavu optimalizace přímých barev jako HTML soubor.

http://fiery.efi.com/CWS/Whats-New
http://fiery.efi.com/CWS/Whats-New


Upozornění na zálohu Bitové kopie systému Fiery

Záloha Bitové kopie systému Fiery vás upozorní, když se záloha nezdaří a je uvedena v části Upozornění v
aplikaci Fiery Command WorkStation.

• V okně Správa nastavení > Obnovení systému Fierymůžete změnit plán zálohování.

• Chcete-li oznámení skrýt, klikněte na ikonu Další (tři tečky) a vyberte možnost Skrýt.

Tlačítko Zavřít pro okno Novinky

Při instalaci a prvním otevření nejnovější verze Fiery Command WorkStation se zobrazí okno Novinky. Nyní
můžete použít tlačítko Zavřít ve spodní části okna Novinky, i když je rozlišení obrazovky menší než podporované
rozlišení.
Minimální podporovaná rozlišení obrazovky:

• 1280 x 1024 (volné listy)

• 1600 x 900 (širokoformátový a super širokoformátový)

Opravené problémy

Potíže opravené v Fiery Command WorkStation Package v6.8.0.615

Fiery Command WorkStation

• Fiery Command WorkStation Package nyní podporuje čínská písma v souladu se standardem GB18030.

Problémy opravené v Fiery Command WorkStation Package v6.8.0.541

Fiery Command WorkStation

• Při sloučení dvou souborů PDF s možností Sloučit všechny soubory, jsou-li odeslány jako složka v Fiery Hot
Folders, výstupní soubor PDF se neobjevoval podle očekávání.

• Pokud jste při kalibraci produktu Fiery server vybrali možnost Potažený - lesklý, zobrazila se chybová zpráva o
neshodě gramáže papíru.

• Pokud jste vytvořili předlohový dokument v části Vlastnosti úlohy pro úlohu VDP ve frontě pozastavených úloh a
klikli na možnost Zobrazit náhled předlohy, byla přidána další prázdná stránka.
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Problémy opravené v Fiery Command WorkStation Package v6.8.0.514

Fiery Command WorkStation

• Po kliknutí na možnost Prostředky > Spot Pro pro Fiery server v systémovém softwaru FS200/200 Pro nebo
FS300/300 Pro se nezobrazil seznam přímých barev a hodnoty přímých barev.

Fiery XF

• Při upgradu serveru Fiery XF z v7.3 na v7.3.3 nebylo možné aktualizovat profily médií pomocí nástroje Fiery
Profiles Updater.

Problémy opravené v Fiery Command WorkStation Package v6.8.0.466

Fiery Command WorkStation

• V systému ve španělštině nebylo možné odstranit vybranou úlohu z fronty podržených úloh stisknutím klávesy
Delete.

• Možnost Publikovat jako virtuální tiskárna se na kartě Předvolby úlohy zobrazila u vestavěného serveru Fiery, na
kterém nebyla nainstalována licence virtuální tiskárny.

• V sadě Fiery Color Profiler Suite jste nemohli vytvořit novou společnou kalibraci pomocí automatizovaného
zabudovaného snímače pro více tiskáren s možností Shoda tiskárny.

Problémy opravené v Fiery Command WorkStation Package v6.8.0.439

Fiery Command WorkStation

• Vybranou položku katalogu papíru pro úlohu v okně Definovat médium pro prokladový arch nelze uložit.

• V některých systémech v japonštině byl počet kopií úlohy kalibrace chybný.

Fiery XF

• V nástroji Job Editor byla velikost stránky zobrazená pro úlohu PDF se značkami pro ořez chybná.

Problémy opravené v Fiery Command WorkStation Package v6.8.0.406

Fiery Command WorkStation

• Tiskárnu nebylo možné kalibrovat s možností Automatická oprava neshody barev.

• Pokud jste se po úpravě zpracované úlohy v nástroji ImageViewer > Úprava barevpokusili odstranit bod křivky,
vybraná stránka byla odstraněna. Pokud jste kliknuli na tlačítko Vrátit zpět, stránka byla obnovena. V úpravách
však nebylo možné pokračovat bez restartování procesu úprav.

Fiery XF

• Některé možnosti tisku pro média nelze uložit do Správce serveru pro tiskárny VUTEk H5.

• Pokud jste v části Editor úloh > Ověřit > Kontrolní proužky vybrali libovolný kontrolní proužek média, cílová
předvolba tolerance se změnila na Vlastní.
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Problémy opravené v Fiery Command WorkStation Package v6.8.0.385

Fiery XF

• Když jste úlohu rozdělili do dlaždic, do výpočtu velikosti úlohy pro jednotlivé dlaždice nebyly zohledněny oblasti
překrytí a přichycení.

Problémy opravené v Fiery Command WorkStation Package v6.8.0.366

Fiery Command WorkStation

• V aplikaci Fiery Spot Pro nebyla označení v gamutu a mimo gamut ∆E konzistentní pro přímé barvy, i když jste
definovali toleranci v dialogovém okně Předvolby.

• Když jste definovali speciální barvu a znovu otevřeli aplikaci Fiery Spot Pro, hodnoty speciální separace barev
nebyly zachovány.

• Když jste v části Vlastnosti úlohy vybrali šablonu Impose, nebylo možné pro novou sledovanou složku definovat
nastavení stránky obálky.

Fiery XF

• V části Color Tools se při pokusu o vytvoření základního souboru linearizace pro tiskárnu Seiko M64s zobrazila
chybová zpráva.

• Když jste v nástroji Color Tools v seznamu vybrali různé možnosti Médií a během rekalibrace klikli na tlačítko
Tisknout, rozměr diagramu měření se neočekávaně zmenšil.

Problémy opravené v Fiery Command WorkStation Package v6.8.0.333

Fiery Command WorkStation

• V nástroji Fiery ImageViewer se zvolenou možností tisku Aktuální pro další stránku, když byla v tiskové frontě
první stránka úlohy, se zobrazila chybová zpráva.

• Pokud jste použili různé položky katalogu papíru pro definici média brožury v nástroji Fiery Impose a média
titulní strany v aplikaci Command WorkStation, byl první list úlohy vytištěn s nesprávným nastavením titulní
strany. Ostatní archy se však vytiskly s nastavením média brožura.

• V možnosti posunu obrazu nebylo možné zadat jednotku měření větší než 0,29 milimetru nebo ekvivalentní
hodnotu v palcích a bodech.

• V případě, že je v aplikaci Command WorkStation nastavena němčina, nebylo možné provést rekalibraci
kalibrační sady, pokud úloha používala některou z následujících možností:

• vlastní velikost papíru

• povolena vlastní velikost papíru a APPE

Fiery XF

• Při pokusu o kalibraci z aplikace Command WorkStation v systému macOS 13 (Nástroje barev > Vytvořit
kalibraci) nebyly viditelné ovládací prvky na levém panelu, takže kalibraci nebylo možné použít.

• Když jste definovali vlastní velikost média v části Editor úloh > Tiskárna > Formát, nezobrazovaly se v náhledu
úlohy okraje hardwaru tiskárny.
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Problémy opravené v Fiery Command WorkStation Package v6.8.0.277

Fiery Command WorkStation

• Pokud jste v systému macOS 13 s Command WorkStation a Fiery Hot Folders vybrali možnost Vlastnosti úlohy >
Rozvržení > Impose > Upravit šablonu Impose, nebylo možné změny uložit, protože se okno neočekávaně
zavřelo.

• V systému macOS 13 nebylo možné spustit nástroj Fiery Software Manager z Aplikací a prostředků, pokud byl
Fiery Software Manager již spuštěn.

• Když jste v systému macOS 13 uložili sestavu optimalizace přímých barev jako soubor HTML, loga EFI a Fiery
nebyla k dispozici, pokud jste sestavu otevřeli v prohlížeči Safari.

• Pokud jste uložili šablonu velikosti dokončování Definováno uživatelem s dvoubajtovými znaky Fiery Impose a
použili ji na úlohu z části Vlastnosti úlohy, byly místo hodnot velikosti dokončování Definované uživatelem
vybrány hodnoty definované pro velikost dokončování Podle rámečku oříznutí.

• V nástroji Fiery Preview stránky obálky i těla zobrazovaly stejné nastavení média, i když jste pro stránky obálky a
těla v nástroji Fiery Impose nastavili jiná nastavení média stránek obálky a těla.

• Když jste v části Vlastnosti úlohy klikli na kartu Média a přejeli dolů k možnosti Smíšená média, některé
možnosti média se pro úlohu nezobrazily.

Fiery XF

• Po nastavení zařízení dokončování Zund v části Správce serveru a Editor úloh, byla jediná dostupná metoda
ořezu DumDum.

• Pokud jste pro vnořenou vícestránkovou úlohu s více stránkami na kartě Dokončování vybrali umístění čárového
kódu Nahoře a dole, část čárového kódu ve spodní části se zobrazila mimo rozložení média a soubor se nevytiskl.

Problémy opravené v Fiery Command WorkStation Package v6.8.0.217

Fiery Command WorkStation

• Když jste během rekalibrace Fiery server kliknuli v okně Rozložení políček na tlačítko Další, Fiery Calibrator
znovu zobrazil stejné Rozložení políček a diagram měření nebyl vytištěn. K tomuto problému došlo, když jste na
serveru Fiery server a v aplikaci Fiery Command WorkStation nastavili jazyk na francouzštinu.

• Když jste v nástroji Fiery ImageViewer v podokně Úprava barev upravili křivku pro černobílou úlohu a pokusili se
ji uložit jako předvolbu, zobrazila se chybová zpráva.

Fiery XF

• Když jste v okně Řezání kontur odstranili metodu vlastního ořezu, byly ze seznamu odstraněny všechny metody
vlastního ořezu.

• Pokud jste vybrali řezací stůl Esko, nebylo možné definovat metodu vlastního ořezu.

• Při definování vlastní velikosti média nebylo možné pro tiskárny řady Canon PRO provést tisk bez okrajů.
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Problémy opravené v Fiery Command WorkStation Package v6.8.0.184

Fiery Command WorkStation

• Po dokončení kalibrace v nástroji Kalibrátor byla možnost Generovat data ACD po kalibraci zaškrtnuta pro
podporované tiskárny.

Fiery XF

• Pokud jste vytvořili knihovnu přímých barev pomocí nástroje Color Editor připojeného serveru Fiery XF,
hodnoty barev se neuložily. Pokud jste znovu importovali stejnou knihovnu, nebyly zachovány hodnoty pro
vlastní přímé barvy CMYKRB, CMYKOB a CMYKRV.

Problémy opravené v Fiery Command WorkStation Package v6.8.0.165

Fiery Command WorkStation

• Pokud jste vytvořili kalibraci pro Fiery server, pro kterou nebyla povolena možnost ACD, Fiery Calibrator přesto
otevře WebTools pro generování dat ACD.

• Pokud jste otevřeli novou Fiery sledovanou složku a vybrali možnost Definovat k zadání nastavení úlohy, okno
Vlastnosti úlohy se neotevřelo.

• Zobrazení náhledu v podokně Zobrazení archu nástroje Fiery Preview u některých vyřazených úloh PDF trvalo
déle, než je obvyklé.

• Na počítači se systémem Windows se zpráva o zrušené podpoře zobrazila v okně Demoverze Fiery Impose místo
okna Správa možností Fiery.

• Pokud jste v části Vlastnosti úlohy > Dokončování povolili možnosti tisku Prokladový arch pro každých 100 kopií
u 1000stránkové úlohy, prokladový arch se vložil před každou kopii.

• Když jste se pokusili otevřít Fiery Command WorkStation a připojit k Fiery servers, když byl server aktualizací
EFI offline, načtení fronty úloh trvalo několik minut.

Fiery XF

• Pokud jste v nástroji Správce serverů vybrali předvolbu Cíl tolerance jako Vlastní, zobrazovala se hodnota
formátu Delta E jako dE 2000, která byla chybná. V nástroji Job Editor se však hodnota formátu Delta E správně
zobrazila jako dE CIE76.

Upgradování

Tento instalační program provede upgrade vašeho stávajícího balíčku Fiery Command WorkStation Package na
nejnovější verzi, která obsahuje aplikaci Fiery Command WorkStation a Fiery Hot Folders. Aplikaci Fiery Remote
Scan můžete také volitelně nainstalovat pomocí Fiery Software Manager.
Další informace o technických specifikacích naleznete na adrese www.efi.com/cws.
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Aktualizace systémových požadavků

Podporované verze

Aplikace Fiery Command WorkStation verze 6.8 podporuje systémový software Fiery FS150/FS150 Pro a novější
nainstalovaný na serveru Fiery server.
Aplikace Fiery Command WorkStation podporuje tyto operační systémy ve vašem počítači:

• macOS 14

• macOS 13

• macOS 12

• macOS 11

• macOS 10.15

• macOS 10.14

• Windows 11 (64bitový systém)

• Windows 10 (64bitový systém)

• Windows Server 2022 (64bitový systém)

• Windows Server 2019, (64bitový systém)

• Windows Server 2016, (64bitový systém)

Poznámka: Fiery Command WorkStation nabízí podporu Rosetta pro počítače macOS s čipem M1. Další informace
viz https://www.efi.com/marketing/fiery-servers-and-software/campaigns/macos-big-sur-compatibility/.

Známé potíže

macOS 13

Adobe Acrobat v systému macOS 13

Jelikož společnost Adobe dosud nenabízí plnou podporu aplikace Adobe Acrobat v systému macOS 13, setkáte
se s těmito problémy:

• Aplikaci Adobe Acrobat nelze spustit ze systému macOS 13 na procesorech M1 a M2.

• U procesorů Intel se zobrazí okno přihlášení v aplikaci Adobe Acrobat, i když jste již přihlášeni. Zavřete
okno přihlášení a aplikace Acrobat funguje normálně.

Na serveru Fiery XF není k dispozici kalibrace

Pokud se pokusíte provést kalibraci z aplikace Command WorkStation v systému macOS 13 (Color Tools >
Vytvořit kalibraci), ovládací prvky levého panelu nebudou viditelné, takže kalibraci nebude možné použít.
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macOS 10.15 a novější

Úplný přístup k disku

V důsledku změn způsobu, jakým systém macOS 10.15 nebo novější spravuje zabezpečení, je nyní nutné provést
další kroky ke zprovoznění aplikací Fiery.
Chcete-li, aby aplikace Fiery spravovaly aktualizace a přístup k souborům, například k šablonám Impose nebo
sledovaným složkám, musíte v systému macOS provést změny funkce zabezpečení Úplný přístup k disku .
Povolte Úplný přístup k disku pro aplikace Fiery, jako je například Fiery Command WorkStation.

1 Zavřete všechny aplikace Fiery.

2 Přejděte do části Předvolby systému > Zabezpečení a ochrana soukromí > Ochrana soukromí > Plný přístup
na disk.

3 V levém dolním rohu klikněte na ikonu zámku a zadejte své heslo.

4 V seznamu aplikací zaškrtněte políčko vedle com.efi.InstallerHelperTool.

5 Klikněte na tlačítko +.

6 Přejděte do složky Aplikace, vyberte Fiery Software Manager a Fiery Software Uninstaller a klikněte na
Otevřít.
Tyto aplikace vyžadují úplný přístup k disku, aby bylo možné v počítači spravovat a aktualizovat aplikace
Fiery.

7 Ve složce Aplikace vyberte Fiery Command WorkStation a klikněte na Otevřít.

8 Používáte-li Fiery Hot Folders nebo Fiery Remote Scan, vyberte každou aplikaci a klikněte na tlačítko Otevřít.
Když Fiery Hot Folders zjistí, že se používají složky Dokumenty, Plocha a Stažené soubory, vygeneruje zprávu
požadující úplný přístup k disku. Tato zpráva se stále zobrazuje i po udělení přístupu. Tuto zprávu můžete
zrušit a pokračovat v práci.

Převod z formátu PS do PDF

Pokud s Fiery Impose, Fiery Composenebo Fiery JobMaster používáte systém macOS 10.14.5 a novější, může vás
systém požádat o povolení pro aplikaci Fiery Command WorkStation k získání přístupu k nástroji Acrobat Distiller.
Toto oprávnění je nezbytné pro převod souborů PS do formátu PDF. Neudělíte-li oprávnění, převody nebudou
úspěšné a bude nutné změnit funkci zabezpečení automatizace v systému macOS.

1 Zavřete všechny aplikace Fiery.

2 Zavřete aplikaci Acrobat Distiller.

3 Přejděte do části Předvolby systému > Zabezpečení a ochrana soukromí > Ochrana soukromí > Automatizace.

4 V levém dolním rohu klikněte na ikonu zámku a zadejte své heslo.

5 V seznamu aplikací vyhledejte položku Fiery Command Workstation.app.

6 Vyberte možnost Acrobat Distiller.app.
Tím umožníte aplikaci Fiery Command WorkStation získat přístup k nástroji Acrobat Distiller.
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Nastavení předvoleb v aplikaci Adobe Acrobat Distiller pro převod z PostScriptu do PDF

Nástroje Fiery Impose, Fiery Compose a Fiery JobMaster vyžadují, aby aplikace Acrobat Distiller převedla soubory
PostScript (PS) do formátu PDF v klientském počítači.
Z důvodu rozšířeného nastavení zabezpečení v aplikaci Acrobat Distiller je nutné potvrdit, že soubor PS, který má
být převeden, pochází z důvěryhodného zdroje v: Acrobat Distiller > Soubor > Předvolby > Předvolby – Acrobat
Distillervyberte možnost Důvěřovat všem souborům otevřeným prostřednictvím aplikace Acrobat Distiller pod
položkou Zabezpečení.

Poznámka: Není-li vybrána možnost Důvěřovat všem souborům otevřeným prostřednictvím aplikace Acrobat
Distiller, budete vyzváni, abyste potvrdili, že soubor pochází z důvěryhodného zdroje u všech souborů PS, které mají
být převedeny do formátu PDF. To platí také pro složky Hot Folders když je vybrán filtr Microsoft Office, Výstupní typ
souboru je určen jako PDF a jako Profil aplikace Distiller je vybrán soubor joboptions.

Spot Pro

Speciální barvy

Speciální barvy nejsou profilovány a funkce Použít na je omezena pouze na CMYK hodnoty zařízení.

Zaokrouhlování hodnoty přímé barvy

Po definování přímé barvy a restartování nástroje Spot Pro se hodnoty některých barev mohou mírně lišit od
zadaných hodnot. Je to způsobeno číselným zaokrouhlováním, které provádí nástroj Spot Pro, a nemělo by dojít
k výrazné změně barvy.

Režim měření M3

Režim M3 není podporován u zařízení s jedním měřením.
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